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ABSTRACT 

A Usability Study of the 

"Tksee " Software .Exploration Tool 

Francisco Herrera 
Master in Computer Science 

University of Ottawa 

Spring 1999 

This research project explores effects of not having considered usability when assessing 
the functionality of a software system. Also, it expenments with the introduction of 
usability into latter stages of software projects in which developers are new to usability. 
A particular software project confronting that scenario is used to explore these issues. 
The selected project had created a program comprehension tool that had been given to a 
p u p  of users for some time. For that reason, this research aiso explores challenges 
posed to studying the usability of program comprehension tools. A usability study is 
designed in order to perform the research. Three techniques are applied in the study: 
(a) hertristic evaluation, (b) user and ras& analysis and (c) thinking aloud usability 
festing. Heunstic evaluation is used to Iook for usability deficiencies in the tool design. 
This is achieved by asking a group of evaluators to judge the tool according to a list of 
usability guidelines and principles. Thinking aloud usability testing is used both (a) to 
look for problems that users experience when learning and using the tool, and also (b) to 
explore how well users who had been given the tool were capable of using its 
functionality. Both are achieved by observing a group of uscrs performing some tasks 
typical of the tool's design intent. User and task analysis is used to find a nght group of 
users and a gwd set of tasks for the thinking aloud usability testing technique. It is also 
used to obtain information about how the users had employed the tool. The study was 
very productive in finding information about al1 the above issues within the particular 
software project. It revealed that none of the users was capable yet to correctiy use the 
tool functionality, and therefore it was impossible to mess  the tool functionality at that . 

moment. Not having considered usability had been one of the causes of this. Also, many 
issues were observed in relation to (a) having stmed considenng usability at a late stage 
in the tool lifecycle and (b) the software project's reaction to k i n g  exposcd to usability 
for the first time. Finally, certain particularities and difficulties were encountered with 
planning and studying the usability of the tool. 
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CHAPTER 1 

Introduction 

1.1 Antecedents 

One of the reasons for creating software systerns is to make it possible for people to 

achieve their goals more efficiently. Systems seek to do this by providing functionality 

which supports people in tasks for accomplishing those goals. However, producing 

systems that cm help people egectively and which arefully adopted by them is a complex 

process. Part of that process involves designing and implementing the system. Another 

part involves users learning, employing and finally adopting the system. Many times, a 

system must p a s  through these stages several times before it is really effkient and fully 

adopted. Good system design is key for a system seeking to help users effectively. 

Critical factors for creating systems with good design are: 

a) The system must provide functionality that enables users do what they need. That is, 

the system must have good utility. 

b) The system must be done in a way that facilitates usea leaming and efficiently 

exploiting its functionality. That is, the system must have good usability. 

When a new system is created, requirement analysis activities are performed in order to 

discover possible functionality that can help users in their goals. That is, developers look 

for whnt might be good for the system to provide to the users. Once having identified 

certain functionality, developers build the system and give it to the users. 

Nonetheless, it is comrnon that deveiopen want to confinn whether that hinctionality c m  

in fact help users to achieve their goals more efficiently or whether it should be 

improved. To do that, developers give the system to a group of users for some time so 



that they c m  use it when working on their goals. Then, later, developers explore if the 

systern has helped the usea to achieve their goals more efficiently or not. If not, 

developers asked these users for information about any noticed deficiencies in the 

functionality as well as suggestions for improving it. In the rest of the document, we will 

refer to this as 'developers assessing the ficnctionality of the system : 

Interest in assessing functionality becomes particularly strong in the case of system 

seeking to help users in complex problems where it is unknown precisely how a system 

could help and what functionality it should provide. Typically, these art problems in 

which not even experts in the domain are able to suggest possible functionality for a 

system. In these cases, the truly efficiency of this type of functionality remains unknown 

until users employ the system for working on their goals. 

Throughout this document, we will use the term ttexperimentalfiuzctionality" to refer to 

functionality for which it is still unknown whether it can help users effectively and which 

deveIopers want to assess. 

1.2 Motivation and Objectives 

Nowadays, a common situation in software projects is that a system is developed without 

considering its usability. Activities are undertaken to discover and implement certain 

functionality for the system, but nothing is done to ensure that users will be able to easily 

learn and efficiently employ that functionality. In these conditions, the system is given to 

a group of users for some time, and later, developers want to assess the functionality. 

That is, they want to see if the functionality has helped those users to achjeve their goals 

more efficientiy, as described in section 1.1. Here, it is important to notice that behind the . 

idea of assessing the functiondity, deve~o~ers assume that the users will correctiy use the 

system when working on their goals. In other words, that users will leam to correctly 

employ the functiondity during the time the system is given to them. 



This scenario rnotivated us to perform this research. We wanted to: 

1) Explore effects of not having considered usability when assessing the functionality 

of a system. 

We were interested in explonng effects in relation to (a) the usability of the system and 

(b) how users leam and employ the functionality during the time the system is given to 

them. 

Another common situation is that people in those projects are not aware of usability. 

Thcy dont know why it is important and how it can be considercd when developing a 

system. Thus, we also wanted to: 

2) Expriment with the introduction of user centered design and usability into the 

Iatter stages of software projects in which developers are new to these concepts. 

To pursue the research, we selected a particular software project confronting the above 

scenario. The project we chose had developed a program comprehension tool providing 

experimental functionality. Based on this, we also wanted to: 

3) Explore particular challenges posed to studying the usability of program 

cornprehension tools. 

In summary, the objective of the research was to look for tvidence relating to these issues 

within such particular software project developing a program comprehension tool. 



1.3 Contributions 

The results and conclusions of this research should be of general interest to several 

sources. They should be of interest to: 

Software projects that want to assess the functionality of a system in which 

usability has never been considered. Particularly to projects developing systems 

providing experimental functionality. 

Anybody intending to study the usability of a program comprehension tool. 

Anybody intending to perform usability studies of software systems in general. 

Anybody intending to introduce usability into the latter stages of software projects 

in which developers are new to usability. 

Finally, to anybody interested in punuing research opportunities discovered here. 

Another secondary but important contribution should be to the usability of the program 

comprehension tool that we experimented with. The results of this research should heIp 

developers to improve the usability of the tool, which in tum should help the software 

project to assess and improve its experimental functionality. We want to mention that it 

was not the intent of this research to actudIy make any improvements to the tool, rather 

to explore the process that might lead to those improvements. 



CHAPTER II 

Review of Related Literature 

Ai1 the issues we wanted to explore were related with usability of software systems. As 

mentioned in Chapter 1, we pursued the research by exprimenting with a particular 

software project. Hence, the literature search focused on two m a s :  (a) usability of 

software systems, and (b) details about the particular software project that was selected. 

2.1 Usability of Software Systems 

As mentioned earlier, the notion of usability is related to the way the functionality of a 

system is provided to the users. Usability in software systems has been traditionally 

considered within the scope of the user interface, and most times it is only addressed in 

detail by literature about user interface development. It has typically not been considered 

a central issue in software engineering. However. the success of a software system lies 

arnong other things in providing what users need in such a way that users can leam it and 

efficiently use it. In other words. creating a system with good utility and good usability. 

Many different approaches for creating software systems in different fields of cornputer 

science currently exist, such as: The Spiral Model for Somare Development and 

Enhancement Boehm 198 81, The Unified SofSware Developmen t Process [Jacobson, 

Booch, Rumbaugh 19981. me Usabiliry Engineering Model [Nielsen 1993a], The 

UsabiCity Engineering Lifecycle wayhew 19993. etc. Al1 discuss and address to a 

different extent the issues of utility (e.g. functiondity) and usability of software systems. 

Some approaches address in detaiI the issue of utility but miss at fully addressing 

usability. The sarne is true vice-versa. Unfortunately, no complete approach fully 

addressing both issues currently exists. 



Traditional approaches in the Sofiwnre Engineering field describe development of 

functional and non-functional requirements for cmating a system. They focus on 

capturing aspects of the utility of the system in such requirements and might mention 

capturing usability aspects of the system in the non-functional requirements. They 

provide methodologies for implementing those requirements into the systern. However, 

these approaches can lead to creating a system with good utility but that does not 

necessarily lead to a system with good usability. They miss at providing some 

fundamental concepts and techniques that are well known in the Human-Compter 

Interaction field for ensuring that a system realizes good usability. For example. the 

untfied sofrware development process mentioned above descri bes a set of con tex tua1 task 

analysis activities to obtain information or 'use cares' from which the requirements for a 

system are derived. However, this approach does not explicitly refer to a 'work 

environment analysis'. This important part of a contextual task analysis points to aspects 

of the users' actual work environment that should drive user interface design decisions. 

Also, this method does not emphasize 'contextual observations of work', or even the need 

to tap into 'current user task organization ' and 'ruk sequence ' models in the design of 

the user interface. Consequentiy, while Ieading to create a system with good utility, this 

approach will not necessariIy lead to a system with good usability [Mayhew 19991. 

On the other hand, traditional approaches in the Humamcornputer Interaction field focus 

on realizing good usability in a system but do not provide an in depth methodology 

addressing the utility of the system. 

This phenornenon of incomplete approaches seems to be related to poor communication 

arnong groups of people supporting different approaches as well as different "cultures" or 

schools of thought. It is important to Say that approaches in different "culturrs" do not 

compte but rather potentially complement each other. Although no complete approach 

hilly addressing utility and usability currently exists, some efforts are k ing  undertaken 

[Rosson and Carroll 19951. 



Among al1 the approaches, probably those that address best the issue of usability are 

those following the notion of User Centered Design morman and Draper 19861, which 

has the concept of usability at its center. Arnong other things, these approaches address in 

detail the issue of studying and evaiuating the usability of sofiware systems. 

In this research, al1 the issues we wanted to explore involved studying the usability of a 

software system, therefore, an approach based on user centered design could provide 

concepts and techniques to achieve our objectives. 

2.1.1 User Centered Design 

The notion of user centered design invoIves a whole set of concepts and principles 

seeking to create products that are highly useful to the users. Much research has been 

done in the last decade within user centered design with respect to software systems. 

Gould and Lewis [I985] give a good description of the main pnnciples behind it: 

Establish an early focus on users and the tasks they perform to achieve their goals. 

Perform empirical measurement of the software's usability using simulations and 

prototypes. 

Perform cycles of iterative design, where a cycle consisting of design, usability 

evaluation and redesign should be repeated as many Urnes as necessary. 

Many authors describe different approaches for creating software systems following the 

principtes of user centered design [Hix, Har'rson 1993; NieIsen 1993a; Shneiderman 

1998; Mayhew 19991. Al1 embody the same principles although they differ in certain 

issues such as steps in the approach, notation, naming, etc. In order to be consistent, we 

decided to follow The UsrrbiZiry Engineering approach proposed by Nielsen [1993a]. In 

this approach, Nielsen describes a senes of activities that should be followed by people 

developing a system. These activities can be divided into three stages: 



1. A pre-design stage, which should provide essential concepts to bc used through al1 

the lifecycle of the software. This stage comprises the following activities: 

a) User and task analysis. 

b) Performing a cornpetitive analysis. 

c) Setting usability goals. 

2. A design stage, which guides the design of the user interface. This stage comprises 

the following activities: 

a) Performing parailel design. 

b) Including users in design. 

C) Coordinating the total interface of the system. 

d) Applying guidelines and heuristic d e s .  

e) Prototyping. 

f) Performing empincal testing. 

g) Performing iterative design. 

3. A post-design stage, in which feedback from the use of the system in the field is 

collected. 

User and task analysis mcans analyzing the intended user population of the system in 

order to Iearn about them as well as the tasks with which the software is intended to help. 

At a minimum, developers should visit the users at their work place. User differences and 

variability in tasks are the two factors with the biggest impact on usability. The concept 

of users should include al1 people that will be affected by the software system. User 

expenence is an important factor in user differences and that should be considered; 

Nielsen suggests that it differs in at least three dimensions, as Figure 2.1 shows: 



/ 

Extensive Corn puta ExpcrKnce 

FIGURE 2.1 Dimensions in which users' experience differ 

karning about the tasks should include observing the users' goals. needs, and how they 

approach tasks. Exceptional circumstances should be considerd too. Also, it is necessary 

to and yze if users' tasks could be irnproved by the use of the system. 

Task analysis centered around users gcnerates concrete statements of representative user 

tasks that provide good coverage of the functionaiity that the system should provide and 

that cm be used for usability testing later. This contrats with other traditional 

approaches, which attempt to derive an abstract fùnctional specification of the system 

[Glen 19951. Also, task analysis centered around users emphasizes human factors more 

than traditional analysis by attempting to identify where users waste time or are made 

uncornfortable. Early focus on users and tasks is one of the most important activities in 

order to reach high usability. 

Pe~onning a cornpetitive analysis refen to analyzing similar products according to . 

established usability guidelines in order to notice their strengths and weaknesses. Some 

user testing with other products can dso serve to sec how the functionality of the other 



software supports the user tasks. This can provide ideas for the new software. Lewis and 

Rieman (19931 list some points in favor of using other pruduct's ideas: 

a) It is not easy for developers to corne up with design ideas as good as those already 

implemented in high quality products. 

b) Using ideas from other known products can improve the learning of the intended 

software because they are more likely to be already known by users. 

c) It can Save design time. 

The intention is not to steai particular copyrighted ideas but d e r  to take general ideas 

and try to improve them. 

Sening usubiliiy goals refers to establishing concrete goals that the system ideally has to 

comply with before it is released. Many times a trade off exists beoueen different 

usability amibutes, therefore the goals must be based on the results of the user and task 

analysis. Ideally, the intended system should perform better in these goals than other 

similar products. Aiso, Nielsen suggests performing a financial impact analysis to 

estimate the cost-benefits bat will be provided by accomplishing these usability goals 

with the system. 

Peflorming parallel design means to create different design ideas and then merge them 

al1 into one. In parallel design, the goal is to generate as much divenity as possible, 

therefore developers should work independently until they have completed the first drafts 

of the ideas, then d l  ideas are mcrged together into one design that comprises the best 

from all. Nielsen daims that parallel design can save development time by explonng 

many ideas at the same time. 

Znclrtding users in design refers to have some users (a) criticizing developers' designs, . 

(b) capruring problems with current developers' concepts. and (c) contributing with other 

ideas. This step is usually good at capturing mismatches between users' actual tasks and 

developers mode1 of the tasks. Also, uscrs seem to bc very good at reacting to designs 



they donTt like o r  won't work in practice. However as Nielsen describes, "uscrs are not 

designers" therefore this step shouldn't consist of asking users what they want, it is much . 
better to show users paper mockups or some screen designs presenting the ideas. 

Coordinating the total interjiace of the systern means to review the design in order to 

provide consistency among al1 its parts. Consistency should apply to al1 parts of the 

current software project, including the user interface. documentation, training courses, 

etc. Developers should share and follow similar pnnciples. Also here, the application of 

standards can help in achieving consistency. 

Applying guidelines and heuristic mles has as its objective to implement well-known 

principles in the current system design in order to improve its usability. There are many 

well-known principles and guidelines that can provide improvements in the usability of a 

system. Standards, for instance, are one type of guideline. 

A key step for developing usable systems is the development of an early protoqpe or 

simulation of the user interface. Prototypes can range from paper sketches to working 

programs. Any prototype should be quick to develop, as well as quick and easy to 

modify; therefore a good tool for prototyping plays an important role. Some authors (Hix 

and Hartson 1993; Lewis and Rieman 19931 suggest that a tool for prototyping should: 

a) Be easy to learn and use. 

b) Posses good visual capabilities. 

C) AHOW easy extensions of current prototypes. 

d) Give full support for the type of interface king developed. 

e) Support modular coding practices. 

f) Provide support for tuming the prototype into the final prograrn. 

Different types of prototypes Vary according to the functionality they implement. A 

horizontal prototype is one where the complete user interface is presented but it has no 

underlying functionality. A venicol prototype includes indepth functionality of only 



certain parts of the interface. A scenario prototype fully implements selected paths in the 

user interface. A scenario prototype works well for user testing but it has the problem that 

users must stay within its paths. 

Once a system design has been decided, it is necessary to empirically test it in order to 

capture usability problems. Testing is usually done using prototypes, however systems 

already implemented should be also tested. Whitefield et al. [1991] provide a 

classification of the different testing possibilities: (a) whether or not the system has been 

implemented, and (b) whether or not real users are involved in the testing. 

Prototyping and testing are key activities in user centered design and have several 

purposes: 

a) Perfonning earIy usability evaluation of the final system. 

b) Explonng design ideas to get the best final choice. 

C) Making iterative refinements. 

d) Making easier the communication about the usability s t a tu  of the current 

design to the development team. 

One reason behind prototyping and testing is the concept that it is too difficult to design a 

complex system and get it correct the first time [Hix and Hartson 19931. Some of the 

reasons are (a) the current limitations in psychological theory that dont permit people yet 

to accurately predict users' behavior with the system. and (b) the difficulty for developers 

at the start of a project to have a complete understanding of the entire context in which a 

system wiil be useci on the field. 

Therefore, any development project should expect and plan for iterations where the 

system is refined or even redesigned. This leads to the concept of perfoxming iterative , 

design where the system goes through cycles of design and evaluation until it reaches 

pre-established goals. 



It is likely that many design decisions will be made during iterations. In order to maintain 

control and organization, Nielsen recommends maintaining a design rationale document. 

This document should contain the rationale behind decisions made about the system 

including the user interface. AJso the document (a) caphues the process followed 

throughout design, @) serves to cornmunicate design to other people, and (c) serves as a 

guide to future modifications of the system. A suggested format to capture design 

rationales is the "QOC" notation WcKerlie and MacLean 19931. QOC stands for 

Questions, Options, and Criteria Design questions are linked to design options, which in 

turn are linked to the criteria that caused particular options to be accepted or njected. 

Finally, once the system is released it is necessary to keep collecting information from its 

use in the field. This information should be used to plan for future versions of the system 

or for other products as well. 

In cases where resources or time are limited, Nielsen [1994c] suggests a Discaunr 

Usab ility Engineering approac h. In this approac h the techniques to perform are: 

a) User and task observation. 

b) Cheap prototyping and scenarios. 

c) Simplified thinking aioud usability testing where users verbalize their 

thoughts as they use the prototypes. 

d) Heunstic evaluation in which the prototypes are evaluated according to 

guidelines. 

User centered design contrasts with traditional development methodologies that fdlow 

the rvaterfall model in that (a) prototyping, (b) usability testing and (c) iterative design 

are performed. in the waterfall model on the other hand, development tries to go in a 

series of sequential stages where each stage is completed before the next one starts. . 

Therefore in this model, the system specification is completed before implementation 

starts. On the other hand. user centered design assumes that usability problems will 



appear in the first specification of the system and therefore a p r o t o w  is necessary to 

discover such problems. 

Hix and Hartson [1993] describe user centered design as following a "star life cycle" 

(Figure 2.2) in which usability evaluation is at center of the star and the points of the star 

represent other activities during the design p r e s s  like prototyping. for instance. The 

points in the star are not ordered and they can be repeated as necessary. 

FlGZTRE 2.2 Start lire cycle for software development 

In one study [Nielsen 1993b1, four case studies on iterative design were used. The 

interfaces passed through three to five iterations. with usability measured in the same way 

after each iteration. The study found average usability improvements of about 38% after 

every iteration. 

Another study [Boehm et al. 19841 tried to compare the prototyping approach with the 

tradi tional software specification approach. Seven teams developcd versions of the same 



software. Three teams used the prototyping approach and four the specification approach. 

The study found that better interfaces were developed by the prototyping approach. 

2.1.2 Usabiüty Evaluation 

As described above, usability testing is a key element in the user centered design 

approach of system development. Now, the= are two important issues to explore: 

(a) what exacdy usability is, and (b) how usability can be evaluated. 

Usability is a narrow concem compared with the more general concept of system 

acceptabili~, which Nielsen descnbes as "the question of whether the system is good 

enough to s a t i e  ail the needr und requirements of the users and other potenfial 

srnkeholders" Figure 2.3 below illustrates the factors of system acceptability and its 

relationship with usability as defined by Nielsen. 

Social 

System 
Acceptabiiity 

Utiüty 

FIGURE 2.3 System acceptability and usabüity 

In this model. utility is defined as the question of whether the hinctionality of the system 

can do what is needed, and usability, as the question of how well users cm exploit that 

functionality. Therefore usability applies to all aspects of the system with which a human 



might interact. The mode1 also describes usability as mainly composed by five urabiliry 

attributes: 

a) Learnability. 

b) Efficiency of Use. 

C) Memorability. 

d) Error Handling and Prevention. 

e) User Satisfaction. 

Learnability refers to how easy a system is to leam. In some sense, this is the most 

fundamental usability attribute since most systems have to be learned, and learning is the 

first experience that most usen have with a system. There are many ways in which 

learnability can be measured; however, the concept of learning a system should always 

be seen as users learning the system in order to achieve usefil work. 

Eficiency of use refers to how efficient and productive a system is for a user once he or 

she has learned to use it. Users may never finish learning a system, although their 

learning curves tend to flatten out after they have acquired some expertise, as Figure 2.4 

shows. Therefore, a typical way to measure efficiency of use is to decide on some 

definition of expertise, getting some users with such expertise and ask them to perform 

some tasks with the system. 

Memorability refers to how easy a system is to remember. Typically, memorability is 

associated with casual users. A casual user is somebody who has learned the system but 

has not used it for some period of time. Improvements in leamability usually produce 

improvements in memorability pielsen 1994aJ. 

E m r  handling and prevenrian refers to (a) the rate and number of enors that users make 

while using the system and (b) the ease with which users recover from those errors. 

Typically, an emr is defined as any action that does not accomplish the desired goal. 

However, not al1 incorrect actions should be considered as errors, since sometimes users 



recover almost immediately from them and there is not a big impact on user's 

performance. On the other hand other erron are more catastrophic because they make it 

more difficult for users CO recover from them. Both types of errors should be measured 

separately when considenng this atuibute. 

FIGURE 2.4 Learning curves of different systems 

User satisfaction refers to a measure of how pleasant to use the system is. A typical way 

to measure satisfaction is asking users about their opinion of the system, which is 

generally achieved through the use of questionnaires or interviews. However it is 

necessary to be cautious with usea' opinions because they are often closely related to the 

peak difficulty that users experience with the system, and aiso, people are often too polite 

in the responses. 

Much research has been done in the last decade about evaiuating usability and many 

different methodologies currently exist. The most cornmon of d l  has been usability 

testing involving users mielsen and Mack 1994 1. 

Typical goals when measuring usability are to provide quantitative measures of some 

usability attributes. For example, how long users take on average to complete a particular 

task or how many erron on average users make while performing certain tasks with the 



system. Quantitative measures are normally used to set usability goals for a system, and 

to evaluate system status to see if it has reached predetermined objectives. However, 

qualitative measurements are also taken sometimes to measure users' satisfaction, like in 

the case of asking users to rate a system. The types of measurements to be taken depend 

on what the desired goal is as well as in what status within the lifecycle the system is. 

2.1.2.1 Discount Usability Engineering 

There have been some cnticisms of classic usability testing methods wack  and Nielsen 

1994al. Some of those are that classic methods require professional usability experts and 

special laboratory equipment, also, obtaining large numbers of users so that the results 

can be statistically significant is very expensive, time consuming and difficuit. 

Furthemore, the costs may out weight the benefits in srnall projects. As we rnentioned 

before, alternative methodologies have been proposed, like those in the discount usability 

engineering approach proposed by Nielsen [1994c]. In this approach, the emphasis is to 

get qualitative information that can be comunicated to developers. This information 

identifies concrete usability problems with the system and helps in generating solutions to 

thern. 

Nielsen daims that the methods in this approach are easy to learn, inexpensive, fast to 

apply, don? require special equipment, and can be performed by software developers. He 

suggests that discount usability engineering c m  be used to supplement classical methods 

or when other more expensive techniques are not feasible. In fact, he says, in many 

practical situations the goal should be to identify usability problems and not necessarily 

to get quantitative measures about them. 

Many different usability evaluation techniques exist and they c m  be divided on the basis . 

of whether they use real users or not. Techniques that dont require users are usually 

referred as Usabili~ Inspection Mezhods [Nielsen and Mack 19941. In these techniques, 



evaluators are used to inspect the system, looking for usability problems that users might 

have. Evduators inspect the system based on guidelines and their own judgement. 

As we will discuss in Chapter III, two usability evaluation techniques were applied in the 

research. Both following Nielsen's discount usability engineering approach. A description 

of such techniques is provided below. 

2.1.2.2 Heuristic Evaluation 

The first technique used in this research is a usability inspection methodology cailed 

Heuristic Evaluation. In this technique, evaluators receive a list of guidelines and are 

asked to explore the system's interface to look for things that violate any of the guidelines 

or that they consider as problems based on their experience and intuition. Evaiuators are 

allowed to use any guidelines or principles they consider necessary. Each evaluator 

proceeds independenùy in his expioration and they are not allowed to comrnunicate with 

each other until al1 explorations have finished. An observer may watch the evaluator's 

exploration to record notes and answer questions they have about the system. 

Heunstic evaluation uses a short list of heuristic pidelines and few evaluators. A list of 

guidelines that has become very popular is the one developed by Nielsen [1992bJ. This 

list contains the following ten usability guidelines that represent what any system with 

good usability is expected to have: 

1. Simple and naturai dialogue. 

2. Speak users' language. 

3. Minimize users' memory load. 

4. Consistency. - 
5. Good feedback. 

6. CIearly marked exits. 

7. S hortcuts or accelerators. 



8. Good error messages. 

9. Good error prevention. 

10. G d  help and documentation. 

It has been observed in heuristic evaluations, that single evaluators miss most of the 

problems in their evaluation, although different evaluators find different problems. 

Therefore, better results are obtained by combining information from several evaluators. 

In a study, Nielsen [1993a] averaged results from six different projects that used heuristic 

evaluation. He found that single evaluators discovered 35% of all the problems detected 

and five evaluators discovered 75% of them. For many practical purposes, Nielsen 

recommends the use of three to five evaluators. 

Also, it has been seen that evaluators* expertise has some effect in the amount of 

problems detected. In another study mielsen 1992bJ. the same interface was subjected to 

heuristic evaluation by three different groups of evaluators: (a) novices, who had 

knowledge about cornputers but no usability expertise, @)single experts, who were 

usability specialists but not speciaiized in the domain of the interface, and (c) double 

experts, who had expertise in both usability and the domain of the interface being 

evaluated. The study found that novices detected 22% of the problems-in the interface, 

single experts 41% and double experts 60% of them. The study concluded that best 

results are obtained by using double experts as evaiuators. However, the study 

recommends the use of single experts for many practical purposes and use of double 

experts just when optimal performance is necessary. 

Supporters of heuristic evaluation claim that this technique is easy to leam, fast to apply 

and inexpensive. Some studies pesurvire 1994; Jeffnes et al. 19911 compared heuristic 

evaluation with other usability evaluation methods. They found that heunstic evaluation 

detects most of the usability problerns discovcred by the other techniques and it identifies . 

the most serious ones too. They dso confirmed that better results are obtained when 

evaluators have usability expertise. 



2.1.2.3 Thinking Moud Usability Testing 

The second technique used in this research is called Thinking Aloud Usability Testing. In 

this technique, a group of end users of the system or 'participants' is asked to verbalize 

their thoughts while performing some tasks with the system. The tasks must represent 

examples of the uses io which the system will be put in the field, and its solution must 

cover as much functionality of the system as possible. An observer may watch the 

participants to record notes, encourage them to keep talking and answer questions they 

have about the interface. However, the observer must be careh1 in not helping too much 

so that he doesnt alter participants' performance. The sessions might be recorded or 

videotaped for later anaiysis. 

The theory behinci speaking aloud whiIe performing the tasks is that verbal comments 

provide insights into the user's mental process, therefore making it easier to understand 

how these interpreî the system. In this way, it's possible to capture users* 

misinterpretations and problems with the system. However, care must be taken when 

listening to users, since data showing what they are doing when a problem is present has 

more validity than users'own theories about the problem. Thinking doud provides 

quaiitative information rather than quantitative information as in other classical usability 

techniques. 

Supporters of thinking aloud usability testing, claim that this technique is easy to learn. 

fast to apply, inexpensive and can be performed by non usability experts. Lewis [1982] 

describes some advantages of thinking aloud usability testing: 

Users'comments help to identify a problem as well as its causes. 

Users discuss problems as they occur when details are fresh in the user's memory. 

Minor problems that cause annoyance or confusion but dont affect task completion 

times are more likely to be detected by thinking aloud testing. 

User's comments help reveal user's subjective attitudes towards the interface. 



e) Thinking aloud testing c m  be used with incomplete prototypes or mockups. since 

it doesnt attempt to measure task completion times. 

Many authors pielsen 1993a; Hackos 1998; Mayhew 19991 point out that good ethical 

pnnciples must be followed in any study or technique involving users. For example, users 

must be properly informed about the study and their decisions and feelings must be 

respected. Also. adequate confidentiality must be kept on any information obtained about 

the users. 

2.1.3 Acceptance of User Centered Design in Software Projects 

Nowadays, many software projects face the necessity to develop highly useful systems. 

However, many of those are new to the notions of usability and user centered design. The 

success of user centered design greatly depends on the acceptance and commitment of the 

software development project to it. Several authors describe the idea of stages of 

acceptance and commitment to user centered design in software projects Dias & 

Mayhew 1994; Ehrlich & R o b  19941. They explain that software projects can be in one 

of the following stages: 

Stage 1. Skepticism 

This stage is typical of projects that have never been involved witb user centered 

design. At this stage developers believe that user centered design will only lengthen the 

development of the system. Normally, this type of project is very concerned just with 

the functiondity and features of the system and not in its usability. If user centered 

design activitics are started, developers dont see what type of benefits can be brought 

to the system and project- 



Stage 2. Curiosity 

As projects moved from skepticism, developers becorne curious about the benefits of 

user centered design. They recognize the problems with the system and might admit not 

having the skills for knowing what improvements should be donc. They are reluctant to 

give control over the design of the user interface and utility of the system to someone 

who is not implementing it. 

Stage 3. Acceptance 

At this stage, people in the project understand and rely on user centered design. They 

accept somebody in the project providing guidance in the design and evaluation of the 

system. They see usability as critical but the system might still be shipped containing 

usabili ty problems. 

Stage 4. Partnership 

The whole software project team is conunitted to user centered design. There is a great 

deal of communication arnong everybody developing the system, including developers 

and usability specialists. Good usability becomes a critical component that the system 

m u t  have. Irnprovements in the system functionality are always verified for usability. 

The same authors describe that the introduction of user centered design in software 

projects requires an evolutionary process in which the projects must gradually grow in 

their acceptance and cornmitment to user centered design. 

2.2 The Software Project and Program Comprehension Tool 

As stated earlier, we performed the research by exploring on a particular software project 

that had created a program comprehension tml. Such tool provided experimental 



functionality that developen wanted to assess. In this section. we present details about 

(a) the software project and the problem it addressed, (b) the program comprehension 

tool, and (c) the status of the tool and software project at the time of this research. 

2.2.1 The Software Project and Problem Addressed 

The maintenance of large software systems has become a tremendous problem. Large 

software systems containing several millions of lines of source code have to be repaired 

and upgraded. Sojhvare Engineers (SES) need to spend long periods of time exploring 

and trying to understand large bodies of source code in order to make the required 

changes. Also, it takes a long time for SES who are novices to the systems to be able to 

start making the changes. Thus, the creation of effective tools that cari help SES in 

maintenance activities is a major issue today. 

The Knowledge Based Reverse Engineering so@are project (KBRE) is a collaborative 

project between a large Telecommunications Company and the University of Ottawa, 

which has been looking for solutions to the mentioned problem. 

One major goal of the KBRE project has been the creation of software tools that can 

effectively help SES to perforrn maintenance activities on large software systems. Such 

tools should help SES to l e m  about large software systems more quickiy, and should 

also help SES that are experts in a system to make changes more easily. 

At the beginning of the KBRE project, the tas'rs and activities that SES perfonn when 

maintaining the systems were not well understood. It was unknown how or what tasks 

software tools could provide help with and what functionality should be necessary to 

implement in such tools. Not even SES expert in maintaining systems were able to 

accurately suggest possible functionality. This situation led people in the projsct to 

perform studies about SE work practices [Singer and Lethbridge 19971. The goal was to 

generate ideas of possible functionality that could enhance the work practices and that 



could be implemented into the tools. The rationale was that creating tools that meshed 

and enhanced existing khavior should help SES in maintaining the systems and should 

be more easily adopted. The lack of tool adoption has k e n  a major problem in the area of 

tool design for SES. 

Several types of data about SES work practices w e n  collected during these studies. 

including: 

a) A web questionnaire asking SES abut  their work 

b) Observation of the work of one SE at the Company during 14 weeks. 

c) Observations of eight SES at the Company dunng one hour of their work. 

d) Series of interviews with SES. 

e) Analysis of company-wide tool usage statistics. 

Many insights and ideas were obtained from these studies. One of these was that 

searching is an important and key component of the real, day-to-day work of SES. 

Therefore, improvements in searching should help SES to do their work better [Singer. 

Lethbridge et al. 19971. This made people in the KBRE project focus the efforts on 

designing tools with good search capabilities. 

Another observation was that SES spend a significant amount of time looking at the 

source code of the systems, which suggested the creation of tools with intelligent source 

code viewing capabilities. According to these studies, SES need to explore the software 

systems with the goal of determining where modifications have to be done. Also, there 

are two categories of SES performing this task (a) novice SES, who are not familiar with 

the system and m u t  learn about it. and (b) expert SES, who know the system very well 

but can not maintain a complete-enough mental mode1 of it. Novices are normally iess 

focused than experts and spend more time studying things that are not relevant to the 

problem. Al1 SES repeatedly search for items of interest in the source code and navigate 

relationships among them. They never try to understand the  system in its entirety but they 

are content to understand just enough to make the changes required. After working on a 



particular area they rnove to other parts of the system and forget details about the 

previous area, having to re-explore it again if they re-encounter it later. In conclusion, 

many SES spend a large proportion of their working time trying to understand the source 

code prior to making changes to it. People who performed these smdies cal1 this approach 

JUSZ in Time Comprehension [Singer and Lethbridge 19971. 

Another important result obtained from these snidies was a set of patterns that SES follow 

when they explore software systems (Figure 2.5). 

- - - -  

LOW LEVEL PATTERNS: 
1. See if csomething> is defined andor what it is (file/procedu~dfUnction/variable/ 

parameterldata-structureltype/ etc). 
2. Find information about the parameters of a certain procedure/function (typzs, whcre are 

these types defined). 
3. Place(s) where <something> (procedure/hnctionldata-stmcturdtype) is implemented. 
4. Place(s) where csomethinp is initialized (variable). 
5. Place(s) where <something> is calIed/used (procedurc/hinc tiod variable). 
6. What and where needs to be changed if csomethinp is changed (definition/ valudetc). 
7. Place(s) where to change csomething> specific (constant). 
8. Follow some flow of execution. 
9. See if <somethinp is used. 

10. See possible returning values. 
1 1. Trace conditions under csomethinp happens (function-result). 
12. Find problerns/activities where <something> has been involved (file/procedure/ function). 
13. Find an example of csomethinp (some sorting procedurd function. for example). 

HIGH LEVEL PATTERNS: 
14. What does <something> do? (function/procedurt/data-s~uc~fd variable). 
15. Find where a particular functionality is defined/implemented (call waiting is defined, for 

example). 
16. What are the parameters used by a certain procedure/function? (what do they mean). 
17. What is the size of <sornething>? (variablddata-structure). 
18. What is the format of a particular procedurehnction cal1 (how do you call this 

procedure/fUnction, for example). 
19. How do you change <something>? (format. for example). 
20. Understand what someone changed on a previous problem report. 
21. Draw data-flow diagram (for a particular variable). 
22. Draw control-flow diagram (for a particular segment of code). 
23. What procedurdfunction do you call to get a particulw type of information (string size, for 

FIGURE 2.5 Patterns that SES follow when exploring the systems 



The results from the studies were used to generate a set of requirements for software tools 

seeking to help with the Just in Time Comprehension approach. This set of requirements 

consisted of three functional and seven non-functional requirements, listed below: 

"FI. Provide search capabilities such that the user can search for, by exact name or 

by way of regular expression pattern-matching, any named item or group of 

named i t e m  that are semuntically signifrcant in the source code. The term 

semantically significont refers to exclude arbitrary sequences of characters in 

the source code text that have no rneaning to SES. " 

"F2. Provide cupabilities to display al2 relevant attBbirtes of the items retrieved in 

reqrtirement FI,  and al2 relatioaships a m g  the items." 

"F3. Provide capabilities to keep truck of separate searches and problem-solving 

sessions, and allow the navigation of a persistent history. " 

"NFI. Be able to automatically process a body of source code of very large size, i.e. 

consisring of at least several million lines of code. Many systems used by real 

industriul SES can be large in size. " 

"1VF2. Respond to most queries without perceptible delay. " 

"NF3. Process source code in a wu rie^ of programming langmges. " Studied SES use 

at least two languages. 

"NF4. Wherever possible, be able to interoperate with other software engineering 

tools. " Studied SES make use of other too1.s. 

WF5. Permit the independent development of user irtte vaces (clients)." 



"NF6. Be well integrated and incorporate al2 fiequently used facilities and advuntoges 

of tools that SES already commonly use." 

"NF7. Present the user with complete information, in a moMer that facilitates the juçt- 

in-time comprehension task" Fthbridge and Anquetil 19971. 

2.2.2 The Program Compreheasion Tool 

Based on the above results, the KBRE project created a Program Comprehension Tool 

implementing those requirements in its functionality [Lethbridge and Anquetil 19971. 

Since its creation. the following limitations to the tool were accepted: 

'21. The semer component of the zoo1 would rwa on only one particular pla@om " 

'Z.2. The tool would not handle object oriented source code. " 

"W. The tool would not deal with dynamic infomtion. Le. information about what 

occurs at nu2 time. " 

Figure 2.6 below, shows the version of the tool used at the start of this research. The main 

features that fulfill the requirements of searching and displaying relevant attributes 

(FI and F2) are implemented in the bottorn two panes. The bottom left pane presents a 

hierarchy of items that can be incrementalIy expanded by asking to show attributes of 

such items and related items, or that can be searched for information about a given item. 

Selecting an item in the hierarchy presents information about it in the bottom right pane, 

from which the user can select any item of text and request information about it. 
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FIGURE 2.6 Main window of the Program Comprehension Tool 

The main feamres that keep track of separate searches and allow a persistent history (F3) 

are in the top pane. Each element in this pane is a complete state of the bottom two panes. 

A hierarchy of these States is saved persistently, so that the user can work with the same 

explorations that he had frorn previous sessions. 

The non-functional requinmenfi are implemented within the architectural design of the 

s ystem (Figure 2.7). This architecture includes a fast database, an interchange 1 anguage 

for language-independent information about software, and a client-semer mechanism 

allowing the incorporation of existing tools. 



FIGURE 2.7 Architechire of the Program Comprehension Tool 

2.2.3 Status of the Program Comprehension Tool and Software Project 

As mentioned earlier, the finctionality of the tool arose from the study of SES work 

practices, and the nature of the problem it se& to help meant it was an exprrUnental 

functionnlity. Since its creation, the tool had been given to a group of SES at the 

Company so that they could use it during maintenance activities. At the time of this 

research, the tool had been available for 1.5 years to that group of SES, and developers 

wanted to assess its functionality. 

On the other hand, the tool had been developed without considenng its usability. It had 

not been evaluated and tested for usability. Also, the KBRE project had not consistentiy 

monitored many issues such as: 

Number of SES that had employai the tool. 

How those had learned and employ the functionality. 

Problems and difficulties when leaming the functionality. 

Problems and difficultiesfor eficiently exploiting the functionality. 

Level of expertise reached by them. 

Subjective satisfaction with the tool. 



In addition, people in the KBRE project didnt know much about user centered design. 

Some developers had a basic idea about user interface design, but basically nobody knew 

about usability and usability evaluation. 

In surnmary, the tool and KBRE project provided an excellent foundation in which we 

could perfonn the research. In the next chapters, we will describe the procedure followed 

to perform the research as well as the results and conclusions obtained from it. 



CHAPTER m 
Methodology 

According to the overall objective of the research (section 1.1). the goal was to look for 

evidence within the KBRE software project and its program comprehension tool about 

the issues in which we were interested. Looking for such evidence required perfonning 

an appropnate activity. This chapter presents a description of the rationale followed in 

planning that activity as well as a description of it. 

3.1 Ideas for planning the Research 

According to the fust research objective, we had to look for effects of not having 

considered the usability of the tool. A fiat interest was on effects in relation with the 

usability of the tool at the moment of this research. A second interest was on e k t s  in 

relation to how SES had learned and employed the functionality during the pst 1.5 years. 

As suggested in the Iiterature, we cold look for effects of the fmt type by studying the 

usability of the tool with some usability evaiuation techniques. In regards to Iooking for 

effects of the second type we could proceed as follows: 

1. Identify a group of SES who had used the tool during maintenance activities 

(category IV in Figure 3.1). 

2. Explore how those SES were capable of using the tool functiondity. We could do 

that by asking them to compIete some typicai tasks in the best way they knew. 



It is important to mention that the group of SES who had been given the tool consisteci of 

approximately twenty SES, therefore it would be feasible to perform these investigations. 
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FIGURE 3.1 Cfassification of users of the tool (SES) 
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According to the second research objective, we had to experiment with introducing 

usability into the KBRE project. Hence, the same study for exploring the usability of the 

tool suggested in the previous issue could serve for this. Nonetheless, we could broaden 

the expenmentation by doing a whole iteration of evaluation, redesign and re-evaluation 

of the tool applying different evaluation techniques. We might discover different things 

when the tool is evaluated, when it is redesigned and when the redesign is evaluated 

again. Also. the use of different techniques might reveal different things. 
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According to the third research objective, we had to look for particularities of studying 

the usability of the program comprehension twl. Again, the same shidy suggested in the 

previous issues could serve for this. But once more. we could broaden the search by using 



several types of usability evaluation techniques, such as one not involving u s e s  (e.g. 

usabiliw inspection method) and another one including users. We might discover 

different particularities when using different types of techniques. 

3.2 Study Plan 

Based on the above ideas, we decided to do a usability study of the tool including the 

following three techniques: 

a)  HeuriStic Evaluation 

6) User and Task Analysis 

C) Th inking A Ioud UsabiIity Testing. 

Heuristic evaluation and thinking aloud usability testing would serve to explore the 

usability of the tool. Also, thinking aloud usability testing would be used to explore how 

a group of SES who had used the tool during maintenance activities were capable of using 

the tool functionality. Because the idea in the research was to find qualitative information 

about the issues with which we were interested, both techniques would follow a discount 

usability engineering approach. Also, Our interest was in usability issues preventing SES 

from correctly using the functionality of the tool. therefore, the snidy would focus on 

searching for things about learning, eficiency of use and subjective satisfaction. 

Heunstic evaiuation would be the fint technique applied. It would detect minor problems 

in the tool that developers would try to fix as much as possible before the thinking doud 

usability testing. 

The user and task analysis would- be performed before the thinking aloud usability 

testing. This technique would serve to obtain a right group of SES (e.g. parîicipants) and 

a good set of tasks for the thinking aloud usability testing technique. Also, it would serve 



to gather information about how the tool had been used at the Company. Next, we 

provide specific details regarding the application of each one of these techniques. 

3.2.1 Heuristic Evaluation 

This technique had the objective of looking for usability deficiencies in the tool by 

applying usability guidelines and principles. It would follow the approach described in 

Chapter Il. That is, a group of evaluatoa would be asked to evduate the tool according to 

the Iist of usability guidelines proposed by Nielsen. Three evaluaton with some usability 

expertise would be used in order to get the best cost-benefit results. Each evaluator would 

proceed independently and might be accompanied by an observer. 

The results would be summarized in a report and comrnunicated to developers. Some 

sessions would be performed in which developers and the experimenter would review the 

problems together. Developers would work on solutions to the problems identified while 

the thinking aloud usability testing was prepared. 

3.2.2 User and Task Analysis 

This technique had the objectives of (a) identifying a right group of participants. 

(b) generating a good set tasks for the thinking aloud usability testing, and (c) gathering 

information about how the tool had been used at the Company. To achieve this, a series 

of interviews and obseniations would be performed with (a) people who had conducted 

the initial studies about SES work practices, @) developers of the tool and (c) people at 

the Company. 

Regarding the selection of participants, the following groups of SES would be identified: 



1) SES who had not used the tool in maintenance activities but knew about the 

company systems (category 111 in Figure 3.1). 

2) SES who had used the tool in maintenance activities and knew about the company 

systems (category N in Figure 3.1). 

From each one of  these groups, three to five SES would be invited to participate in the 

study. In the rest of the document, we will refer to those SES simply as  the novice and 

expert participants. Both groups of participants would be used to explore the usability of 

the tool. Novices would help at looking for deficiencies in learning the functionality and 

experts at looking for deficiencies about efficiently using the functionality. Both groups 

would be asked for information about their satisfaction with the tool. In addition, experts 

would serve to explore how well they were capable of using the tool hinctionality. 

In regards to the tasks, these would be real tasks of the type for which the tool was 

designed. The patterns that SES foilow when exploring software systems would be used 

to help develop the tasks. These patterns had been observed when the tool functionality 

was generated and could help at finding real sequences of using the features. Also, some 

tasks would be designed so that performing them optimally would involve the use of 

critical features that had not been aitered by the solutions to the problems found in the 

heuristic evduation (e.g. features that remained in the same place with same label). This 

was important in order to guarantee that the knowledge that expert participants had about 

those features were still valid in the test. In other words, to guarantee that if an expert 

didnt use one of those features during the test, it was because he really didnt know the 

feature and not because the feature had been altered. In summary, the tasks would comply 

with the following rules: 

a) Involve exploration of a real Company system. 

b) Be linked to a real S C & ~ ~ O  of a maintenance activity. 

C) Be possible to perform within a certain time lirnit. 

d) Its solution should cover the patterns as much as possible. 



e) Its solution should cover as much functionality of the tool as possible. 

f) Its solution should involve critical features not altered after the heuristic 

evaluation. 

3.2.3 Thinking Aloud Usability Testing 

This technique had the objective of Iooking for usability deficiencies experienced by a 

group of SES. A h ,  it would serve to explore how they had learned and used the tool. The 

participants and tasks obtained from the user and tasks analysis would be used for this 

technique. The technique would follow the approach described in Chapter II. That is, the 

participants would be asked to verbalize their thoughts while performing the tasks with 

the tooi. There would be one session for each participant. The tasks wodd be given one 

at a time during the sessions. An observer would watch the participants and would take 

notes during the sessions. The sessions would be videotaped for Iater andysis. Once the 

participants had finished the tasks or the time Iimit had expired, they would be asked to 

complete a short questionnaire and debriefed for some minutes. The sessions would be 

performed at the Company facilities using computer equipment similar to that which the 

participants nomally work with. 

Like in the heunstic evaluation, the resuIts would be sumrnarized in a report and 

communicated to developers. Also, some sessions would be performed in which 

developers and experimenter would review the problems together. Some video clips of 

participants experiencing the problems would be presented. 

Novice participants would receive a 15 to 20 minutes tutorial before the session. The 

tutonal would be given by a SE who was a rnember of the group responsible of 

supponing the tool within the Company. 

As recommended in this type of technique, a pilot study would be performed before the 

sessions witb the participants. Two users of the tool simjlar to the participants wouId be 



asked to perform the tasks. They would follow the sarne procedure as the participants 

except that these then would not complete the questionnaire and would not be debriefed. 

The pilot study would serve to capture possible problems with the tasks, investigate 

details to be careful of when perfomiing the sessions, and other practical issues about the 

application of the technique. 

Finally, as suggested in the literature, certain ethical considerations would be applied. 

The videotapes and information obtained about the participants would be kept 

confidentid. Only people performing the study would have access to that information. 

Also, just small clips showing specific problems would be watched during the sessions 

with developers. These considerations would be informed in advanced to the participants, 

who would be asked for their consent. 



CHAPTER IV 

Results 

The following chapter presents the results of our research obtained through the usability 

study performed to the program comprehension tool. We discuss usability deficiencies 

found in the tool and how those were related to not having considered usability during its 

development. We also discuss how usability had affected the way SES had learned and 

used the functionality of the tool. We describe particular challenges encountered with 

studying the usability of the tool md finally, we describe issues detected with introducjng 

usability into the KBRE project. 

As mentioned in Chapter ID, the study involved applying three different methodologies. 

Thus, we present the results chronologically, with sections about each one of the 

techniques. At the end of the chapter there is a section with other results that were 

independent of the techniques. 

4.1 Heuristic Evaluation 

4.1.1 Procedure Overview 

The first part of the study consisted of applying heuristic evaluation following the 

procedure described in Chapter III. That is, three evaluators with knowledge about 

designing user interfaces were used. Al1 of them had some knowledge in usability 

evaluation although they were not usability experts; they had perforrned just a few 

heuristic evaluations before. Evaluator-I and 2 had backgrounds in Computer Science 

and experience in exploring software systems (the domain of the tool). Evaluator-3 had a 

background in Psychology and somc knowledge about programming languages, howcver 

he didnt have much experience in exploring software systems. On the other hand, 



evduator-1 was a developer of the tbol and therefore he was hilly familiar with it. 

Evaluator-2 and 3 were unfamiliar with the tool and leamed about it one week before the 

study. 

The heuristic evaluation was performed as described in Chapter ID. That is, the 

evaluators received a Iist of ten usability guidelines and were asked to evaiuate the tool 

according to them. Each evaluator perfonned the evaiuation independently from the 

others and proceeded as follows: 

a) Evduator-2 (the author) performed the evaluation alone and before the other two 

evaluators. He would serve as the observer of evaluator-3 and as the expehenter of 

the heunstic evaluation. This is, he was in charge of cwrdinating the technique and 

surnmarizing the results obtained from it. Therefore. it was important that he 

performed the evaluation before the other evaluators so that he wouldn't suffer any 

bias introduced by the results of the others. Also, evaluator-2 had to be careful when 

serving as the observer of evaluator-3 to not in tduce  any bias to this later one. 

b) Evaluator- 1 perforrned the evaluation alone and sent his results to the expenmenter. 

C )  Evaluator-3 performed a two-hour evaiuation session in which he dictated his results 

to an observer (evaluator-2). The observer recorded the problerns and helped with 

questions that evaluator-3 had about the twI. 

The results from the three evaluators were merged and susnmarized in a report. We 

noticed that evaluator-2 (the experimenter) had acquired many insights by observing the 

results of the other two evaluators. Therefore, thanks to the precaution of perfonning his 

evaluation before the others, his results were not biased and it was possible to compare 

them with the other two evaluators. Finally, some sessions were donc so that developers . 

and the experimenter could review the results together. 



4.1.2 Usability Insights obtained with the Heuristic Evaluation 

The heuristic evaluation supplied a lot of information about the usability of the tool. Most 

of the results were 'possible' usability problems that SES could experience with the tool 

but there were also other insights like suggestions for improvements given by the 

evaluators. A total of one hundred and fourteen usability problems were identified and 

they can be consulted in Appendix 2. Seventy-oneproblems (6246) were about 

difficulties in learning the tool. sixty-five (57%) were about efficiency of use. and 

twenty-two (19%) were about both (notice that a problem can be about learning and 

efficiency of use at the same time). Three examples of these problems are: 

- Problem: The tool had two windows that showed a hierarchy of items. Also, the tool 

had a menu called "Hierarchy" that only referred ta the hierarchy of one of the 

windows. This could be confuring for SES that don't know yet the relationship 

(Lea rning problern). 

- Problem: Some searching features worked so that rhey searched down staning fiom 

the point where they had been cailed. However, they didn't aifow searching the rest of 

the information that had been lefr above. (Eflciency of use problern). 

- Problem: A dialog window presents some radio buttons not according to the 

standards. This ïype of radia buttons should not be used for representing exclusive-or 

(EBciency and learning of use problem). 

According to the usability guidelines, the problems were distributed as follows: 



1 Usa bili ty Guideline 1 No Problems 1 
1. Simple and n a d  didogue 
2. Speak users' ianguage 
3. Minirnize users' mernory load 

49 
20 
10 

4. Consistency 
5. Good feedback 

15 
11 

6. Clearly rnarked exits 
7. Shortcu ts or acce lerators 

( 10. Good help and documentation 1 1 1 

1 
2 

8. Good error messages 
9. Good error prevention 

TABLE 4.1 Problems found in the Heuristic Evaluation according to tàe 

i 

O 
5 

usability guidelines 

As we will describe later, we generated a second categorization of the problems. 

According to that classification the problems were distributed as follows: 

, 1. Non optimal functionality 22  
2. Possible confusion 14 
3. Possible rnisinterpretation I l  
4. Unnecessary functionality 5 

6. Lack of consistemcy 15 
7. Graphical design 9 
8. Feedback 11 

L 

1 12. Lack of labeling 1 2 1 

9. Lack of robustness 
10. Wrong behavior 

TABLE 4.2 Problems found in the Heuristic Evaluation according to the 

second classification 

6 
2 

According to the usability guidelines (Table 4.1) the biggest category of problems 

consisted of violations to the simple and natural dialogue principle. Its problems 

accounted for 42% of the problems found and most of them were related with 

(a) non-optimal functionalify (30%). (b) possible users' confuson or misunderstanding 

1 1. Bad labeling 6 i 



with the tool (18%). and (c) bad graphical design in the user interface (16%) (Table 4.2). 

Some problems in this category were: 

- ProbIem: Certain windows always disphyed scroll bars even when they were not 

necessary. It would be better to implement scroll bars as needed. (Non-optimal 

functionality). 

- Problem: Two icons in the tool bar suggested they pefonn opposite actions on a 

selected object. Hmever, this was only tme w k n  applied to certain objects (Possible 

users' confirsion). 

- Problem: The spacing und alignment of features within some dialog wirïdows made 

things look cluttered even rhough rhere were not space comtraints (Graphical design 

problern). 

The second biggest category of problems consisted of vio1ations to the 

speak users' lunguage guideline, which accounted for 17% of the problems found. These 

problems were mainly related to possible user confusions or misunderstandings wjth the 

tool. A problem in this category was: 

- Problem: The infonnution at the top of one window appears editable but is not. SES 

fhat know similur iuidgets fiom other systems could think the information is editable 

(Speak users' lunguuge problem). 

The third biggest category of problems consisted of violations to the consistency 

gujdeline, which accounted for 13% of the problerns found. There were many 

inconsistencies throughout the interface but major sources of inconsistencies were in 

(a) the design of the features and its behavior, (b) the treatment of feedback, and (c) the 

graphical design of the user interface. Three problems in this category were: 



Problem: The left and right arrow keys did not always behave the same in the 

different w inàows and dialog w indows (Inconsistent behavior). 

Problem: Some dialogues and messages were using a different font thon the rest of 

the system (Inconsistent graphical design). 

Problem: Some feutures gave feedback while processing infonnotion but others 

didn 't (In consistent feedback). 

Together, the problems about the simple and natural dialogue and consistency guidelines 

accounted for 55% of dl  the problems found. By analyzing the problems, we saw that 

many of them were a consequence of the lack of systematic usability activities during the 

development of the tool. For example: 

Many problems about simple and natural dialogue were deficiencies in the 

organization of the functionality of the tool. Many would have probably not existed if 

that arrangement had been designed by following tasks within na1 scenarios that SES 

perform. Also, many were of the type of problems normaily detected on a first 

evaluation. An example of these problems is: 

- Problem: The feature for loading database files opened a pop-up window that 

showed al1 the files in the default directory, including files that were not valid 

databases. SES could select wrong files and thut could cause unexpected problem 

(tack of evaluation problem). 

Many consistency and graphical design problems would not have existed if the tool 

had been implemented by following a standard style definition. An example of these 

problems is: 

- Prob!ent: Some dialog windows presented the scroll bar on the lefi and others on 

the right (Lack of stanàard style problem). 



It is important to Say that the problems found were probably not al1 the existing problems 

in the tool. As we will mention in the next section, lack of domain knowledge and 

missing tool information hindered developers from identifying certain types of problems. 

Many of those problems would have belonged to the categories of (a) simple ond natural 

dialogue, (b) good feedback, (c) good error prevention, and ( d )  clearly mrked &S. 

Likewise, the tool didnt have online nor written help yet, therefore almost no issues 

regarding usability of the tool in combination with its help were obtained. 

4.1.3 Issues during the Heuristic Evaluation 

The heuristic evaluation was in general easy to plan and perform although there were 

certain things particularly more difficult or different than expected. We encountered the 

following issues when using this technique: 

1. AIthough it had been relatively easy to find three evaluaton with some knowledge 

about usability, we noticed that finding evaluators with good knowledge in usability and 

experience in heuristic evaluation was not easy in general. Finding a fourth evaiuator 

would have been very difficult, for instance. We saw that people with experience in 

usability were not very easy to find at that moment. 

2. The evaluators ended up relying more on their own intuition and expenence with user 

interfaces than in the abstract usability guidelines when capturing problems. We noticed 

that little experience evaluating a system according ta abstract principles was the main 

cause of this. 

3. Insufficient information about the tml hindered some evaluators from identifying - 

problems. As we mentioned earlier, evaluator-2 had little knowledge about the tool and 

evaluator-3 didnt know about the tool and its domain either. Al1 this made them seek for 



whatever tool information available in order to be able to make certain judgements. For 

example: 

They looked for a complete list of tool requirements and specifications. They wanted 

to know how the functionality had been designed to address the SES tasks. However, 

this information didn't exist completely and that meant they couldn't always judge 

whether things in the functionality had or not usability deficiencies. 

They IookeC for information about the design of the user interface. They wanted to 

know why the functionality had been organized the way it was. Unfortunately, this 

information didn't exist either and that meant they couldn't always judge whether 

things about such organization were good or bad designs. This happened, for 

instance, with some groupings of features, labels. keyboard shortcuts and graphical 

design issues. 

We belief that, with this information, evaluators would have made better judgements 

about which were critical problems and would have probably identified a larger number 

of problems. 

4. There were problems found by several evaluators and others just by one evaluator. 

Also, each evaluator captured a different number of problems. By analyzing the resulu, 

we noticed that different evaluators tended to find different categories of problems: 

Evaluator- 1 found 28% of the total number of problems captured in the technique. He 

found many problems regarding Bugs' and the utility of the tool, but tended to find 

fewer problems about user interface design than the other two evaluators. For 

example, he found many things about (a) the lack of certain tool functionality, (b) the 

correctness of the resu1ts given by the tool, and (c) the comectness and completeness . 

of the feedback given by the tool. He was able to judge whether a feature was indeed 

necessary or not for exploring software systems and whether it was working 

correctly. On the other hand, his extensive experience with the tool made him unable 



to notice certain types of problems, such as inconsistencies, graphical design, 

feedback, etc. For example, he didnt find many things about (a) difficulties 

experienced by SES leming the tool (like problems for finding certain feanires, for 

instance), or (b) inconsistencies and lack of standards in the user interface. 

We noticed that k ing  a developer and having extensive knowledge in the tool 

domain made him capture those types of problems. His insights revealed deficiencies 

about tool learnability and efficiency of use. 

Evaluator-3 found 72% of the total number of problems captured in the technique. He 

found, on the other hand, many problems about user interface design but Iess about 

the utility and conectness of the tool. For example, he was very good at noticing 

problems about (a) consistency and standards, @) graphical design, (c) labels, 

(d) difficulties for leaming the tool, and (e) difficulties understanding enor messages. 

We noticed that having little knowledge about the tool and its domain made him 

capnire those types of problems. His insights revealed deficiencies about tool 

learnability. 

Evaluator-2 found 39% of the total number of problems capnired in the technique. He 

was more balanced than the other two evaluators in finding deficiencies related with 

both: (a) the utility of the tool and (b) general user interface design. Although, 

overall, his results were more similar to evaluator-1; that is, he tended to find more 

problems with the utility and correct behavior of the tool and less about user interface 

design. We think this probably happened due to his background in Computer Science 

and experience explonng software systems (the tool domain). His insights revealed 

deficiencies about tool learnability and efficiency of use. 

5. Merging and summarizing the problems required much time and energy. As stated in 

the plan, the problems would be communicated to developers so that they worked on 

solutions while the thinking aloud usability testing technique was prepared. But, solving 



the problems eficiently required that developers understood the problems very well. As 

suggested in the literature [Jeffnes 19941. the problems had to be presented in the report 

in a way that facilitated their understanding by developes. However, the problems as 

given by the evaluators presented many difficulties so that these could be easily included 

in the report: 

Many didnt provide information about its location in the tool. 

Many were not stated in their most general way. Instead, they only referred to 

panicuiar instances of the problem withjn the tool. 

Many didnt have explanations about why they could be in fact problems to the 

SES. 

Many didnt have suggestions for improvements. 

Many didnt provide an estimation of i ts severity. 

Many had not been related to the usability guidelines. 

At the end. many problems had to be located in the tool, verified for its existence, 

rephrased or rewritten before including them in the report. The time and effort for this 

task was much bigger than expected. 

We noticed that little experience with the technique and with communicating usability 

problems to developers had been the main reasons why the evaluators had not reported 

the problems better. 

6. Having evaluators with different levels of experience in (a) the tool domain and 

(b) using the tool, provided a broader and larger spectrum of problems. Regarding the 

first type, we noticed that the tool domain was so specific and complex that only 

evaluators 1 and 2 who had background in Computer Science and knowledge explonng 

software systems were abie to see deficiencies in the functionality regarding how it . 

helped conveniently at exploring software systems. On the other hand, linle knowledge in 

the tool domain made evaluator-3 capture other types of problems not detected by the 

other two, such as screen design problerns. With regard to the second type, we noticed 



that having a developer of the tool as evaluator-1 had been very helpful. He had extensive 

knowledge using the tool and that made him capture many insights about its correct 

behavior. On the other hand, evaluators-2 and 3 didnt know how to use the tool and that 

made them identify many problems with leaming the tool. 

As rnentioned in Chapter II, some authors descrÏbe that best results are obtained by using 

double-experts as evaluators (e.g. evaluators with expertise in usability and the domain of 

the system). However, we obtained a broader spectrum of problems by having different 

types of evduators as describeci above. Thaî is, we had one single-expert and two 

double-experts. We also added the category of expertise using the system and we had one 

expert and two novices on using the tool. 

We do not know if this combination cm always be better in heuristic evaluations, 

particularly in evaluations of systems where the problem domain is very cornplex. But 

this is a topic for further research where more experimentation could be performed. 

7. The number of problems was much bigger than expected and the project was 

overwhelmed with the results. Many of them represented difficult or costly things to 

repair and sorne were not possible to fix. The fact that the tool was already implemented 

imposed even more difficulties to fixing the problems. Al1 these were causes of not 

having evduated the tool before and lack of knowIedge of what usability deficiencies 

meant. 

8. Priontizing and organizing the problems became cntical to developen. According to 

the plan, developers should fix as many problems as possible while the thinking aloud 

usability testing was prepared. The large number of problems and lirnited time to fix 

them made it critical for developers to prioritize and organize the solutions. For that, 

developers immediately looked at the severity ratings provided in the report. . 

Nevertheless, they ended up relying more on other factors such 'as time and resources 

available to prioritize the problems. 



TO organize the problems, developers tried to use the usability guidelines but these were 

very abstract for them and consequently not very useful. Based on that, we decided to 

create a second classification of the problems that they could undentand and help them 

better at organizing the problems. This classification divided the problems in ternis of the 

tool functionality and diff~culties that SES could have with it (Table 4.3). 

1. N-tv 
2. Possible confusion 
3. Possible misinterpretation 
4. Unnecessarv functionali~ 
5. Lack of fbnctionaiitv 
6. Lack of consistencv 
7. Graphical design 
8. Feedback 
9. Lack of robustness 
10. W m n ~  behavior 
1 1 .  Bad labelinn 
12. Lack of labeline 

TABLE 4.3 Second classification of the problems 

9. Developers had diffkulties identifying good solutions to the problems. We noticed it 

was difficult for them to undentand the problems in their most general way. They 

required much time to see solutions that did not lead to other obvious usability problems. 

Also, they had dificulties comparing the effectiveness of several proposed solutions. We 

noticed that insufficient usability knowledge and experience solving usability problerns 

was the main cause of this. 

On the other side, insufficient tool information also affected developers ability to identify 

good solutions to the problems. Some developers were not in the KBRE project yet when 

certain decisions about the design of the tool had been made. Consequently, insufficient 

tool information meant that these developers didn't know details about the organization 

of the functionality as well as the design rationale of the user interface. Hence, developers 

experienced difficultics judging the curnnt design and finding solutions consistent with 

the rationaie used. We noticed this issue made people in the project start thinking about 

generating some tool documentation. 



10. The problems were not always fixed properly and with optimal solutions. Many 

times, they were fixed for the particular instances mentioned in the report. Also, cenain 

solutions would very likely iead to other usability problems. We noticed that non-optimal 

understanding of the problems and its consequences, having the tool dready 

implemented, limited time and non-optimal pnoritization of the problems were the main 

causes of this. 

11. The sessions between experimenter and developers were extremely helpful. We 

confirmed that it had k e n  essential to have the report properly written. However, we saw 

that the report alone would have been far from enough to communicate al1 the 

information to developers and facilitate the generation of good solutions. Instead, the 

sessions help at: 

Reviewing the problems in its most general way. 

Reviewing implications of sub-optimal soIutions. 

Evaluating different proposed solutions. 

Prioritizing the problems. 

Deciding about problems that should wait to be fixed. There were some 

problems for which it was not clear if they seriously affected SES and 

therefore their solution should wait until they were confirmed in the thinking 

aloud usability testing. 

We want to mention that the experimenter played a key role in these sessions. He had to 

actively help developers in al1 the above issues. 

12. Certain problems provided by this technique were not always very convincing to 

developers. Even though developers accepted most of the problems as deficiencies in the . 

tool, some developers were not veryconvinced that certain problems should be fixed. We 

noticed that the lack of klief from developers came mostly fiom insufficient 



understanding of how those problems could produce an effet on the SES. particularly 

those that could produce a slow but strong impact on thern. 

13. After fixing several problems, developers started having some difficulties maintaining 

control over the source code of the tool. As one developer expressed: "this code is 

sturting to suger from the spaghetti syndrome, we are losing order and structure in it". 

We  noticed this was a consequence that the tool was already implemented. 

14. Knowledge in the tool domain had been essential for the experimenter. He had to help 

evaluator-3 with several issues about the domain. Also, he had to fully understand the 

problems, appropriately explain those in the report, communicate them to developers, and 

provide advice during the generation of solutions. We noticed that the tool domain was so 

specific and complex that insufficient knowledge in it would have seriously hindered the 

experimenter in these activities. 

15. The heuristic evaluation was a good first step for introducing usability and user 

centered design into the KBRE project. It made developers become aware of what 

usability rneant and the Ievel of usability of the tool. It dso  meant that the project 

matured regarding user centered design. By the end of this technique, the project had 

passed from the skepticism stage to the curiosity stage, as described in Chapter II. 

4.2 User and Task Analysis 

4.2.1 Procedure Ovemew 

The next part of the study consisted of performing a user and task analysis as mentioned 

in Chapter III. That is, a series of interviews and observations were perfomed with 

(a) people who had conducted the initial studies about SES work practices, (b) developers 

of the tool and (c) people at the Company. 



The first step in the andysis consisted of some i n t e ~ e w s  with the people that had 

conducted the initial studies about SES work practices and developers of the tool. We 

asked them about the KBRE project, the problem it addressed, the results from those 

studies, and the tool. 

The next step consisted of field observations and interviews with some SES and other 

people in the Company involved in the KBRE project. We wanted to gather more 

information about the project and the tooi as well as obtaining a Iist of possible 

participants for the thinking doud usability testing technique. 

Once a list of possible participants had been obtained, the next step was to interview each 

one of them in order to select those who were the best according to the objectives. We 

had to identify a right group of novice and expert participants. It is important to mention 

that the experiment was not explained to them at this point. 

Other SES not in the list of possible participants were interviewed next. We asked them to 

give some examples of typical scenarios and tasks in the exploration of the Company 

systems dunng maintenance activities. Such examples wouid be used in the generation of 

the tasks. 1t was important that the possible participants didn t know about the tasks that 

they wouId be asked to perform and that's why we asked other SES for these examples. 

After the previous interviews, the manager of some SES was also interviewed. He had 

been in involved with the KBRE project and was familiar with the tool. We asked him to 

venfy al1 the information collected in the previous steps and contribute with missing 

information. We dso asked him for some examples of typical scenarios and tasks in the 

exploration of the Company systems during maintenance activities. 

At this moment, the study and its policies were explained to the possible participants and 

they were asked to participate in the expriment. 



Once having obtained a group of participants, the rest of the analysis focused on 

generating the tasks. As described in Chapter Iil, the procedure for obtaining the tasks 

was performed. However. as it will be discussed below, certain difkulties arose with it 

as planned and it had to be modified. 

4.23 Insights obtained with the User and Task Analysis 

The user and task analysis provided extremely useful information. It helped to find a right 

group of participants and a good set of tasks according to the objectives. It also provided 

many insights about (a) the target population of users of the tool. @) their needs and 

tasks, as well as (c) how SES had used tool during the past 1.5 years and how useful it 

had been for them. Al1 sources of information were good and provided usefbl 

information. Frequently, different types of information were obtained at the same time. 

Overall, the selection of the participants was completed before the tash had been fully 

determined. 

One of the first things found was that the target population of users of the tool had been 

de fined as: 'those SES perfonning maintenance activities thut followed the Just in Time 

Comprehension approach'. Also, that the tool had been designed mostly based on 

information from one particular group of SES. However, the group of SES who had k e n  

given the tool included (a) the SES in this previous group as well as (b) other SES in other 

groups that also performed maintenance activities and followed the J m  in Time 

Comprehension approach. 

It was found next that only four SES had used the tool dunng maintenance activities so 

fru, and those had been using the tool very differently. Some had employed the tool 

everyday and others just on specific days. Some had employed the tool for many of their 

tasks and others only for a few specific tasks. Also, three of them had k e n  more recendy 

hired at the Company. These commented on having used the tool in order to leam the 



Company systems. On the other hand, many SES had not used the t w l  yet and a few had 

not even heard about it. 

A11 this made us see that the group of SES who had used the tool during maintenance 

activities was much smaller than developen imagined. Developers thought that the tool 

was more widely known and used by the SES. It was clear that SES had not been 

monitored much after the initial snidies. 

At this moment, we identified a group of SES who had used and had not used the tool 

during maintenance activities. These were good candidates to be the expert and novice 

participants for the testing respectively. 

Next, we noticed that SES in distinct Company groups had differences that could affect 

their interaction with the tool. SES in different groups (a) had different goals in mind 

when exploring the Company systems and (b) tended to have a very different knowledge 

about the Company systems. These differences meant that two SES in different groups 

could: 

a) Approach the same goal with different tasks. 

b) Perform the same tasks but in a different order. 

These, in tum, had an influence in: 

a) When they explored a Company system. 

b) How they explored a Company system. That is, what the starting and final points 

of the exploration were, which paths of exploration they followed, how deep 

within the Company system the exploration was, etc. 

These differences, together with theract that the tool had been mostly designed based on 

one particular group, made us conjecture whether the tool was equally usehl or not to dl 

SES within the defined target population. In fact. as it will be discussed later. we 



confirmed this hypothesis later during the thinking aloud usability testing. The following 

is an observed exarnple of al1 these issues: 

SES in the design group peqomed tasks where the starting point of exploration was a 

Pascal procedure. Though, SES in the support group said they rarely started explorations 

by looking ut a Pascal procedure. On the other hand, SES in the support group started 

explorations by looking at descriptions of reported problems. However, the tool provided 

many features for starting explorations by looking at a PascaI procedure und fau for 

staning exploraiions by looking at reported problems. C o n s e q d y ,  the tool was 

probably more usefil to SES in the design group than those in the support group. More 

information fiom SES in the design group had been used to drive the design of the tool 

than from SES in the support group. 

Likewise, we noticed that SES within the sarne Company group had also differences that 

could affect their interaction with the tool. SES in the sarne group could have a 

completely different knowledge of the same Company system, and that could have the 

effect that for the same goal certain SE had to explore the Company system but another 

one not. 

At this moment, the candidates were invited to participate in the test. Eight participants 

were obtained for the thinking aloud usability testing. Initially, as it will be explained 

below, four were identified as novices and four as expert participants (categories III and 

IV in Figure 3.1 respectively), but later, we discovered that one of the experts belonged in 

fact to the novice category (he had very recently started using the tool). Seven were in a 

sarne Company group and one of the experts (the one we discovered Iater was a novice) 

was from a different group. Some of them had participated in the initial studies about SES 

work practices. It is important to mention that the group of experts consisted of the only 

three SES who had used the tool dunng maintenance activities. 

Finally, the tasks for the expriment were generated. As stated before, SES were asked for 

examples of typical scenarios and tasks in the exploration of the Company systems 



during maintenance activities. Here, we noticed that SES always provided examples that 

were extremely complex and focused on very high level goals. Many times, they had not 

been able to accurately describe what sub-tasks or steps would be necessary to perfom 

for solving the examples, neither what explorations of the Company system had to be 

done. This made us see that SES not always consciously realized many of these issues 

during maintenance activities. 

The set of tasks obtained contained twenty-eight tasks cornplying with d l  the d e s  

established; however, as it will be discussed below, these had to be modified two times 

later, one after the pilot smdy and another one after the sessions with the first two 

participants. 

4.2.3 Issues dunng the User and Task Analysis 

The user and task analysis was easy to plan but not very easy to perform. W e  encountered 

the following issues dunng this technique: 

1. Efficiently employing theory and principles at the moment of conducting the 

technique was not very easy to do. Theory and pnnciples about planning and conducting 

the technique were simple and straightfonuard to understand. But remembering dl and 

using them efficiently while conducting the technique was not easy. We noticed that the 

nature and amount of information gathered created a "messiness" atmosphere in which it 

was difficult to recognize the best pnnciples and the way to use them. This made us see 

that obtaining best results definitely required expenence and matunty with the technique. 

2. The tasks were particulariy hard to generate. Summarizing, the original procedure 

planned for determining the tasks was as shown in Table 4.4 below. 



1. Ask SES for some examples of typical scenarios and tasks in the exploration of the 

Company systems during maintenance activities 

2. Take the collection of patterns found in the study of SES work practices 

3. While (there are scenarios) 

3.1 Take next scenario 

3.2 While (there are tasks in that scenario) 

Take next task 

See what pattern@) would be foUowed when performing that task 

See what features of the tool would be used to perfonn that pattern(s) 

If (features used so far covers functionality that wants to be tested) 

then go to 4 

3.3 If (features used so far covers functionality that wants to be tested) Then go to 4 

4. End 

TABLE 4.4 Initial procedure for determining the tasks 

Also, the tasks had to comply with the following rules: 

Involve exploration of a real Company system. 

Be linked to a real scenario of a maintenance activity. 

Be possible to perform in less than two hours. 

Its solution should cover the patterns as much as possible. 

Its solution should cover as much functionality of the tool as possible. 

Its solution should involve critical features not altered by the heuristic 

evaluation. 

However, we encountered the following difficulties: 

a) The examples of real scenarios and tasks given by the SES were not useful for 

deterrnining the tasks. As mentioned above, those exarnples were extremely 



complex and fwused on very high level goals. Also, SES had not been able to Say 

what sub-tasks or steps would be necessary to perform for solving the examples, 

therefore: 

It was impossible for us to know if the participants would use the tool for 

solving those examples. 

It was almost impossible to see what patterns participants would foHow 

when solving the examples. 

It was very dificult know what and how the tool f e u e s  rnight be used. 

Finally, many of the examples were not possible to complete in less than 

two hours. 

In summary, it was impossible to know when and how participants would use the 

tool with those examples. In Our case, knowing this was essential because we 

wanted to observe how participants used the functionality and we wanted to have 

some idea of the features that they would use. Consequendy, rnost of the 

examples given by SES were not helpful, as it had been thoughr. Based on this, we 

modified the procedure as shown in Table 4.5 below. 

Both procedures differed in that the original could be seen as going top-down 

while the modified as bottom-up. That is, the original started considering high 

level scenarios a ~ d  tasks, and went down trying to identify the required features in 

the tool for solving the tasks. The modified, instead, started identifying real 

sequences of features that SES perform and went up trying to link those sequences 

with real high level scenarios and tasks. 



1. Get an expenenced SE in the tool and its domain 

2. Take the collection of patterns found in the study of SES work practices 

3. While (there are pattems) 

3.1 Take next pattern 

3.2 With the help of the SE, generate a task about something from the Company 

system that implements the pattern by using some features of the tool 

3.3 With the help of the SE, see if that task can be part of any existing scenario 

generated here 

If (it can be part) Then 

Include the task in chat scenario 

With the help of the SE, establish a possible order arnong al1 the tasks 

in that scenario 

Else, with the help of the SE, generate a possible scenario where that task 

could be part of 

3.3 if (features used so far covers functionality that wants to be tested) then go to 4 

4. End 

TABLE 4.5 Modified procedure for determinhg the tasks 

We found that the modified procedure was easy to follow and produced a set of 

tasks complying with al1 the rules. Also, as we saw later, the tasks generated by it 

worked very well during the tests. Nevertheless, it is important to mention that the 

pattems were key for using the modified procedure. They represented red 

low-level tasks that SES perform and therefore served to determine real sequences 

of using too1 features. 

b) A second difficulty we encountered was that finding sections of the Company 

system that the tasks explored was hard. Based on our previous observations of 

SES, the participants could be extremely familiar with particular parts of the 

Company system. So, we had to create tasks that involved explonng sections of 

the system that were not exaemely known by al1 of them. Otherwise, it was 



possible that a certain participant didnt have to use the tool for solving a task 

simply because he knew the answer already. 

Finding those sections of code was very dificult. W e  selected sections of the code 

based on suggestions fkom other SES. but we could never be sure that such 

sections were completely unknown to al1 the participants. In fact, it happened 

during the sessions later that some participants knew the sections we chose. Ln 

order to prevent from possible problems and force the participants to use the tool 

we used the following tricks: 

For tasks where the participant had to determine if something existed, we 

phrased them so they asked the participant to count the number of things 

found. 

We phrased al1 the tasks asking the participant whenever possible to sec 

the answer(s) in the windows of the tool. 

C) A final observation when generating the tasks was that some of the missing tool 

information would have been useful. The specifications, for instance, could have 

helped to understand better how the tool features supported SES tasks, and 

therefore would have helped at identifying sequences of features for solving real 

SES tasks. 

3. Once generated, the tasks became very helpfûl for other purposes. Before the study, 

the KBRE project didn't have any examples of real scenarios and ta& of what the tool 

was used for during maintenance activities and that is why we had to generate some for 

the test. But, once the tasks had been generated, we noticed these becarne very helpful to 

developers. They started using them for testing solutions to the problems found in the 

heuristic evaluation as well as testing new design ideas of future tool features. 



4.3 Thinking Aloud Usability Testing 

4.3.1 Procedure Overview 

Once having obtained the participants and tasks, the next part consisted of applying the 

thinking aloud usability testing technique following the procedure described in Chapter 

III. That is, the participants were asked to verbalize their thoughts while performing the 

tasks. The sessions were videotaped for later analysis. The tasks were given to them one 

at a time. An observer watched the participants and helped them when necessary. The 

observer took notes about usability insights noticed during the sessions. These notes were 

used later duting the analysis of the videos. Once finishing the tasks, the participants 

were asked to fi11 a short questionnaire and debriefed for some minutes. The sessions 

were performed at the Company facilities using cornputer equipment similar to that with 

which the participants normally work. Novices received a 15-20 minutes ~ t 0 r h d  before 

the session given by a SE member of the group supporting the tool within the Company. 

A pilot study was performed before the sessions with the participants. Two developers of 

the tool participated in this test. They were asked to perfonn the tasks generated for the 

experiment. They had extensive knowledge of the tool and explonng software systems 

but no knowledge about the Company systerns. Their sessions followed the same 

methodology described above but they didnt complete the questionnaire. were not 

debriefed and didn't receive the tutorial. This test revealed the necessity to make some 

changes to the tasks and a second version of them was created. Some new tasks were 

included in order to exploit more tool functionality, and some tasks were rephrased due to 

observed difficuIties with their understandability. 

Next, the fint two participants performed their sessions. These were one novice and one 

expert participant. These sessions reyealed certain things not noticed with the pilot study 

that made it necessary to do certain changes to the tasks again. Thus, a third version of 

them was created. This was the final version of the tasks and can be consulted in 

Appendix 3. 



At this moment, the rest of participants performed their sessions. They were asked to do 

the third version of the tasks. It is important to mention that although the fint two 

sessions were done using the second version of the tasks, they were fruithi1 in capturing 

many usability insights about the tool and those were included in the final andysis. 

Once finishing the sessions with al1 the participants, the next step was to merge and 

summarize the information in a report. The annotations, videos and questionnaires 

provided usehl  information that was included in the report. 

Finally, like in the heuristic evaluation, some sessions were scheduled so that developers 

and experimenter reviewed the problems together. For some problems, short video clips 

about them were presented. The clips showed the participants experiencing the problems. 

As stated in the plan and told to participants. the videos and other information about thern 

were al1 kept confidentid. Only people involved in the usability study had access to that 

information. Also, only clips showing specific problems were watched during the 

sessions with developers. 

4.3.2 Usability Insights obtained with the Thinking Aloud Usability 

Testing 

Like with heuristic evaluation, much information about the usability of the tml  was 

found with thinking aloud usability testing. Most of that information was usability 

problems that participants experienced with the tool but there was also information about 

user satisfaction, possible improvements, and insights about the utility of the tool. Also, 

this technique provided information about how expert participants were capable of using 

the tool functionality. 



A total of seventy-two usability problems were identified and those can be consulted in 

Appendix 5. Thirtyeight of them (53%) had already been identified in the heunstic 

evaluation and were confirmed in this technique. Thirty-eight of the problems (53%) 

were about dificulties in leaming the tool, fifty-four (75%) were about efficiency of use. 

and twenty (28%) about both (notice that a problem c m  be about leaming and efficiency 

of use at the sarne time). 

Leaming problems were mostly about difficulties for (a) perceiving that the tasks could 

be achieved by using the tool, (b) finding al1 the necessary feanires to complete a task, 

confusions due to (c) misleading information provided by the tool and (d) behavior of the 

tool different than expected. Two examples of these problems are: 

- Problem: Much of the power of the tool resides in combining finctionality between 

hvo of the windows. However, it was very hard for participants to leam how to 

combine that functionaliry in order to solve a task (Dificuliy in noticing that goals 

can be achieved). 

- Problem: The Delete sub-List worked so that it deleted the objects below in the 

hierarchy of another object. However, participants tended to see a sub-list as a subset 

of consecutive objects and not as subser below the hierarchy (Behavior different than 

expected). 

On the other hand, efficiency of use problems were mostly related with obstacles and 

difficulties for achieving the tasks in optimal ways. Many times, the participants were 

able to achieve the tasks but they made many unnecessary or non-optimal steps. One 

example of these problems is: 

- Problem: The pop-up window of a searching feature ofien hid the matches found. 

Whenever that happened participants had to move t h t  window in order to sec the 

match (Eficiency of use problem). 



From the seventy-two problems, five (7%) were experienced by the eight participants, 

ten (14%) were experienced by more than six, and thirty-one (43%) were expenenced by 

Iess than three. Two exarnples of these problems are: 

- Problem: Zn one of the windows, dtyerent objects codd look exactly the same. 

W~enever that hnppened participants had to select each one of them in order to be 

able to see the digerences (Problem experienced by al1 participants). 

- Problem: n e  i-ight numbers (nzcmeric keypad) in the keyboard didn 't work in the tool 

(Problem experienced by only une participant). 

Novice participants experienced forty-five problems (628) and expert participants 

expenenced forty-eight problems (66%). Also 20% of the problems were only 

experienced by novices, 7% were only experienced by experts, and the rest (73%) were 

expenenced by both. Most of the problems experienced by novices (75% of them) were 

about learning the tool. Most of the problems experienced by experts (8 1% of them) were 

about efficiency of use. Some examples of these problems are: 

- Problem: Many important feutures were within middle mouse menus, but middle 

mouse menus were extremely hard to discover &y participants (Learning problem 

aflecting rnainly novice participants). 

- Problem: The Arttu-grep feature serves to flnd occurrences of one object within 

another. Ir powerjùlly implements one of the mosr common SE tasks, which was 

noticed during the study of SES work practices. However, the implententation was su 

non-intuitive and dificult to learn that none of the participants already knew how to 

use it a d  it hadn't been used yet (Learning problem affecting both participant 

g roups). 



- Problern: Nested proceduredfunctions in the source code were not clearly identrfied. 

nerefore participants hud to find them monually by observing the code (Eflciency of 

rise problem afiecting mainly experî participants). 

- Problem: The tool didn 'r have undo facilities and participants experienced situations 

where erroneous actions couldn'r be reversed (Eficiency of use problem afecting 

borh participant groups). 

According to the same classifications used in the heuristic evaluation, the problems were 

distributed as shown in Tables 4.6 and 4.7 below. Like in the heuristic evaluation, the 

biggest category of problems consisted of violations to the simple and natural dialogue 

guideline (Table 4.6). Its problems accounted for 61 % of the problems found and most of 

them (48%) were about non-optimal fiurctionality. The second biggest category of 

problems (22%) consisted of violations to the good feedback guideline. Some examples 

of these problems are: 

- Problem: Pop-up menus worked so that they stayed only if the mouse button 

remained pressed. NonnaZly, participants required time to look and explore the 

featrtres in those menus. Many times, participants were observing a menu and 

accidentally released the mouse button, which led them to lose the menu. Also, 

participants had diflcuities with (a) keeping the rnouse button pressed for a long 

tirne, and (b) keeping it pressed while moving the mouse in order to select something 

(Non-optimal fwrctiondity problem). 

- Problem: The tool did not always presented feedback when there were no res~ilts 

frorn an action. Many participants didn 'r easily notice when an action with an empty 

result had finished. Sometimes they scrolled the windows trying to idennfi any 

possible changes to the information. Some executed the action again several times to 

convince themrelves that the nc& hud hod an empty resulf. Parîicipants started 

developing the concept of not trusting the feedback given by the tool (Feedback 

pro blern). 



I Usabiitv Guideline 1 No Problems 1 
1 1.  Simple and natural dialogue 1 44 

2. Speak users* languape 
3. Minimize users* memory load 
4. Consistency 

- ~ 1 8. Good e ~ o r  messages O 1 

9 
O 
1 

- - 
S. Good feedback 
6. Clearly rnarked exits 
7. S hortcuts or accelerators 

16 
2 
O i 

TABLE 4.6 Problems found in the Thinking Aloud Usability Testing 

9. Good error prevention 

according to the usability pidelines 

O 

I Category 1 No Problems 

10. Good help and documentation O 
I 

- -  - 

1. Non optimal functionality 23 
2. Users' confusion 6 

- 3. users' &interpretation 8 
4. Unnecessary functionality 2 
5. Lack of functionality 7 
6. Lack of consistency 1 

L8. Feedback 16 1 
1 9. Lack of robustness 1 1 1 

1 12. Lack of labeling O 1 

- 

10. Wrong behavior 
1 1. Bad labeling 

TABLE 4.7 Problerns found in the Thinking Aloud Usability Testing 

1 
7 

according to the second classification 

An analysis of the problems revealed that many were consequences of the lack of 

s ystematic usability activi ties during the development of the tool. For exarnple: 

a) hlany problems were related with not efficiently considering the context in which 

SES worked in a particular moment. We noticed that depending on the context 

participants performed different sequences of steps to accomplish the same task. 

However, the tool provided ways to solve tasks that were not context sensitive, 



consequentiy, the tool sometimes helped participants eficiendy and othen times not. 

It is possible that more knowledge about how SES worked depending on the context 

could have enabled the creation of a context sensitive tool design. 

b) In the tool, some features worked differently depending on the objects selected. 

Hence. some problems were because the tool did not inform participants eftkiently 

about (a) the objects selected in a particular moment and (b) how certain features 

would work based on that selection. These problerns would have been detected 

before if the tooi had been tested with SES. 

c) Sorne problems were related with not providing support in al1 the steps involved in 

cornpleting full SES' tasks of sxplonng the Company systems. It is likely that the use 

of scenarios of complete SES goals for designing the tool would have avoided many 

of these problems. Furthemore, many of them had not been detected because, as we 

will discuss later, developers had been testing the tool with low-level SES tasks only. 

The questionnaire and debriefing were dso productive. They revealed aspects about user 

satisfaction, utility of the tool and how it had been used so far. The number of 

participants was not big enough to generate a retiable statistical analysis. But the results 

were used to complement the other information and obtain a more accurate picture of the 

status of the tool. The questionnaire and average of the answers were as shown in Table 

4.8 below. Among the most important insights were: 

Participants considered that the tool was easy to leam although learning took time 

(something we noticed SES didn't have too much of). 

Participants considered that the tool was useful at exploring the software systems, 

but only once certain practice with it had been acquired. 

Participants considered that the user interface of the tool was easy to use although 

it was not extremely efficient. 



Question 
1. Do you consider that learning the tool is: 

a) O = difficdt, 4 = easy 
b) O = confusing , 4  = clear 

Anmer 

3.0 
2.4 

C) O = takes long. 4 = very fast 2.6 

you neeà for exploring software systems like those you work with a t  the 
Company ? 

O = not good, 4 = very good 

2. How well do tool menus, options, e tc  npnsea t  real thiags or  actions that 

2.6 

3. How well does the tool h d p  you on t y p i d  sequences of actions for 
exploring software systems Like those you work with at the Company ? 

O = not good, 4 = very good 

TABLE 4.8 Answers given by participants in the questionnaire 

2 9  
- -- - - - - - - - 

4. How much are the tool features enough for your purposes of exploring 
software systems Iike those you work with a t  the Company ? 

O=O%, 4=100% 

5. D6 you consider that the tool intenice (menus, windows, buttons) is: 
a) O = difficult to use. 4 = easy to use 
b) O = awkward to use, 4 = convenient to use 
C) O = slow to use. 4 = quick to use 
d) O = inefficient to use, 4 = eficient to use 

6. How helpful is the tool for you on maintenance tasks of software systems 
like those you work with a t  the Company ? 

O = not helpful, 4 = very helpful 

In generai, the opinions were very homogeneous (standard deviation "stdev", around 0.5). 

Other interesting insights were: 

-- - 

2.9 

3.1 
2.8 
2.5 
2.8 

3.1 

a) Novice participants considered that leaming the tao1 was a bit dtncult (1.8) but 

experts considered it easy (3). This was probably because experts had already 

learned the tool and they were not expenencing many learning diffxculties anyrnore. 

b) The opinions of whether the tool was helpful at typical sequences of actions for 

exploring the system were very consistent in novices (3.3, stdev of 0.5) and very 

inconsistent in experts (stdev of 1.3). 



c) Opinions of novices and experts also differed about the efficiency of use of the user 

interface. Experts were consistent in their answers (2.5, stdev of 0.5) while novices 

did not agree on them (srdev of 1.1). 

An interesting insight arose from one of the expert participants who had learned the tool 

since it was created. He considered that the version used in the testing was not as helpful 

as some previous versions. He had Ieamed how to perform his tasks on the first versions 

of the tool, and differences in the version used in the test (the latest version) had forced 

him to relem how to accornplish the tasks on it. Also, not al1 the tasks possible to do in 

the previous versions could be done in this version. This made us see that changes in the 

features of the tool had not been properly analyzed and had affected the SES. Afso, this 

was another indication that SES had not been monitored. 

Al1 the tasks were completed in the ten sessions (including the piIot study). However, 

certain tasks were completed in very inefficient ways. That is, not in the best way 

possible to complete them with the available tool functionality. This indicated that 

novices were not able to discover the best resources of the functionality and experts did 

not know many of them yet. For example, some tasks required looking for ail the 

occurrences of a particular string in many files. The tool provided a feature for solving 

such task in one step. However, none of the participants used that feature and, instead, 

cornpleted the tasks by using another feature that found occurrences of a string one by 

one within one file only. So, not knowing about the more powerful feature made that 

participants completed the tasks using the less powerful feature many times. 

These observations dong with information obtained from the debriefs with the expert 

participants, made us see that none of the experts knew al1 the tool functionality yet and 

no one had used many of the most advanced features in it. Therefore, because these 

participants were al1 the SES who had used the tool dunng maintenance activities, that 

meant it was impossible for the e R E  project to assess the functionality of the tool at 

that moment. In other words, nobody in the group of SES who were given the tool had 

used al1 the power of the functionality during maintenance activities yet. 



The most common reasons why SES had not used al1 the functiondity were: 

a) They had not discovered many features. 

b) They had not understood the meaning of certain features by Iooking at its label. 

c) They had not understood the way certain features had to be used. Certain features 

required to be used in a peculiar way or order. So, each time that SES had tried 

those features they had been unlucky and had employed them in an incorrect way. 

An interesting observation was that many things intended for expenenced users of the 

tool, such as keyboard shortcuts, were rarely used (that's why there were not many 

problems with them). This was another indication that expert participants had not used al1 

the functionality yet. 

A11 these made us see how not having considered usability had caused poor learnability in 

the tool design, which in m m  had caused that SES never learned and used al1 the 

functionality during the past 1.5 years in which the tool had been available. Thus, making 

impossible for people in the KBRE project to see whether the experimental functionality 

of the tool could heIp SES to achieve their goals more efficiently or not. In other words, 

making jt impossible to assess the functionality. 

On the other hand, participants expressed a positive attitude towards the tool. Novice 

participants commented on advantages they noticed between having the tool and 

manually exploring the Company systems. Expert participants commented on having 

received some benefits from the tool, particularly those who had used the tool for 

learning the Company systems. However, based on Our observations about SES needs we 

believe that if expert participants had known al1 the benefits possible to get from the 

functionality, they would have probably had a much better opinion about the utility of the 

tool. None of them had been aware of al1 the possible benefits so far. 



We want to mention that at the end of each session, we instructed participants on how 

they could have achieved the tasks very efficiently. We saw that they easily learned the 

features involved in solving the tasks and made comments such as: "ifat Ieast sornebody 

had told me about that feature before, I would have been using the power of this tool 

since long rime ago ". This made us realize that besides good learnability, other means for 

helping SES at learning the system would have been very helpful for the KBRE project. 

In general, the application of this technique greatly helped participants at learning the 

tool. Solving the problems posed by the tasks and instnicting them on efficiently using 

the functionality for achieving those tasks made that they learned the core functionality of 

the tool and realized great benefits possible to get. 

During the study, we saw that participants encouraged other SES to start using the tool. 

This situation was very well received by the KBRE project, which had always been 

seeking to have SES using the tool. This made us see that good usability could have 

generated positive attitudes in SES learning the tool and those would have encouraged 

other SES to leam it and use it, which in turn would have helped in the assessrnent of the 

functionality. 

Finally, because nobody knew well al1 the tool functionality, it is likely that many 

usability deficiencies were not captured, particularly about efficiency of use. Finding 

more of this type of deficiencies required testing with SES who knew the functionality 

better. This made us see that having the sarne participants from this test in other future 

tests could reveal more insights about efficiency of use. 

4.3.3 Issues during the Thinking Aloud Usability Testing 

The thinking aloud usability testing was in general easy to plan and perform but like in 

the other techniques, there were certain things particularly more difficult or different than 

expected. W e  encountered the following issues during this technique: 



1. Planning and applying this technique took much longer and was more dificult than 

the heunstic evaluation. There were many more practical issues and details to deal with 

than in the heunstic evaluation. Many were in regards to using the video and audio 

equipment, performing and controlling the sessions, and analyzing the information. We 

noticed that insufficient experience with the technique was the main cause of this. 

2. The pilot study was essential and very productive. It revealed some problems with the 

tasks and many other practical issues about the application of the technique. such as the 

use of the video equipment, difficulties with testing at the normal Company facilities, etc. 

3. There were some interesting insights during the sessions with the first two 

participants. 

a) We found important differences between these participants and the developers that 

participated in the pilot study. We had thought that developers of the tool were 

similar enough to the participants and therefore appropriate for the pilot study. 

Developers were SES like the participants and dso had knowledge in explonng 

software systems (the cool domain), therefore they should behave similar to the 

participants. However: 

Participants had much more knowledge about the Company systems than 

developers and that made them see severai different ways for solving the tasks, 

including some in which the tool was not necessary. Developers, on the other 

hand, found the tool as the only way to solve the tasks. This made us confinn Our 

observations that in order to force participants to use the tool, the tasks had to be 

cautiously selected and phrased, otherwise, they could have solved the tasks 

without using the tool. We found that the tricks used for writing the tasks had 

worked well, but as we will discuss next, certain adjustments to them were done. 



Participants were harder to control and it was more difficult to make them focus 

on the tasks than developers. They asked many more questions dunng the 

sessions than developers. When participants found the answer of a task, they 

tended to mm and look at the observer, express the answer to him and then wait 

for a gesture from him. Consequently, we realized that the tasks had to be phrased 

so that the participants could talk while performing them but not requinng (as 

mucli as possible) help from the observer. In other words, phrasing them in a way 

that the communication between observer and participants was kept at a 

minimum. Based on this we adjusted the tricks for writing the tasks as foHows: 

- For tasks where the participant had to determine if something existed, we 

phrased them asking the participant to write down the number of things 

found and sometimes its names (depending on how long the names were). 

This included writing 'hone" in case of not finding anything. 

- For tasks where the participant had to reach certain conclusion, we 

phrased them asking the participant to write down his conclusion 

(whatever that was). 

- We phrased al1 the tasks asking the participant whenever possible to see 

the answer(s) in the windows of the tool. 

These new ideas were used to modify the tasks and worked remarkably well in the 

rest of the experiment. 

These differences between participants and developers made us realize that testing 

with SES from the group who had been given the tool was essential. We found that 

knowiedge in the particular Company system being explored with the tool had an 

important effect on participank'behavior. Also, knowledge in explonng the 

Company systems for maintenance purposes was very important. Just having 

knowledge in explonng software systems in general (the tool domain) was not 



enough to consider a certain SE as similar enough to the SES who had k e n  given the 

tool. 

b) We found important differences between the participants in these first two 

sessions. The first participant had been identified as belonging to the expert category 

after the user and task analysis. He was a SES who had been given the tool but he did 

not beIong to the sarne Company group of the other participants. By looking at how 

he used the tool and the comments he made, we noticed that the tool was not very 

useful for him and prcbably neither to others in his group. This made us confirm the 

observations that differences among SES in different Company groups made the tool 

not to be equally useful for dl the groups. 

On the other hand, we noticed that he was not really an expert in the tool as he had 

expressed during the interviews. Therefore, we had to consider his results as frorn a 

novice participant. Hence, the study ended having five novice and three experts 

participants instead of four in each category. This made us  see that the real level of 

proficiency that he had with the tool had not been truly discovered in the user and 

task analysis but until we watched him using the tool. 

These two previous insights (a and b) made us see that the real target population of users 

of the tool was not 'those SES pedoming maintenance activities that followed the Just in 

Tirne Comprehension approach' as it had been onginally defined. But rather, those SES 

that performed exactly the type of maintenance activities of the particular group of SES 

from which the tool had been mostly based. 

4. Two hours was about the maximum time for good sessions. The average times of the 

sessions were 1:32 hrs for novices (not including the tutorial) and 1: 13 hrs for experts 

including the questionnaire and debriefing. We noticed that longer sessions would have 

been uncornfortable for the 



On the other hand, the tasks obtained with the modified procedure worked very well. Al1 

the tasks could be completed in less that two hours and, as we had seen, many tasks 

typical of what the tool was designed for could have taken much longer than that. 

5. Al1 sources of information used in the technique provided useful and different types 

of data. The annotations, questionnaire and debriefing served to capture usability 

problems with the tool but were particularly good for capturing comments from the 

participants about how much the tool had been used so far and how useful it had k e n  for 

them. It was possible to relate usability problerns with participants* opinions. These 

comments revealed aspects about: 

a) Participants' expertise with the tool. 

b) Participants* attitudes towards the tool. 

C) Participants' problems beyond the scope of the tool that had affected its use. 

d) Strengths and weaknesses of the tool according to real goals of participants. 

e) UtiIity of the tool according to participants' Company group. 

The videotapes, on the other side, were extremely helpful at confirming aspects captured 

on the annotations and revealing many usability problems not observed during the 

sessions. 

6. We noticed several issues regarding videotaping: 

a) Having the videotapes was extremely helpful. We noticed that usability sessions can 

be very difficult to conduct by only one person and especially if that person is not 

yet a usability expert. In Our case, videotaping released some pressure in capturing 

usability problems and gave us more resources for controlling the sessions. 

b) On the other hand, the analysis of the videos was tinng and very time-consuming. 

We had to spend about 3 to 5 times the duration of a video in order to analyze it. 

Videotapes of novices lasted an average of 1:14 hrs and videotapes of experts an 



average of 056  hrs, however, the total time spent andyzing the tapes for al1 the eight 

sessions was about forty hours. 

7. Like in the heuristic evaluation, the number of problems was big again and that 

increased the concern of people in the KBRE projeci about the usability of the tool and its 

consequences. 

8. Like in the heunstic evaluation, the sessions between experimenter and developers 

were extremely helpful. Again, we confirmed that having the report properly written had 

been essential. However, the report alone would have not been enough to cornrnunicate 

al1 the information to developers. Instead, the sessions served to: 

Watch video clips of the participants struggling with the tool. Wc found this was 

extremely effective. Developers easily understood the problems and developed 

commitment to solve them. 

Understand the problems and prioritize its solutions. 

Experiment with different procedures for presenting the problems and video clips 

to developers. The one we found most effective was: 

1 ) Ask developers to reod a problem. 

2) Establish a short discussion about it. 

3) Show the video clip(s) presenting the problem. 

Again, the experimenter played a key role in these sessions. He had to actively help 

deveIopers in many issues. 

9. Following the policies of the study about confidentidly created a feeling of 

professionalism and commitment in everybody around it, including developers, 

participants and other people in the company. We noticed that explaining the procedures 

and policies to everybody before the study, and then following them carefiilly had been 

essential. 



IO. The thinking aioud usability testing was an excellent step after the heuristic 

evaluation to continue introducing usability and user centered design into the KBRE 

project. It increased developers' awareness about the usability status of the tool as well as 

their knowledge in usability. Like in the heuristic evaluation, we saw that the KBRE 

project matured more in its attitude towards user centered design. By the end of this 

technique, it  had passed from the curiosity stage to the accepzance stage, as described in 

Chapter II. 

4.4 Other Insights and Issues independent of the Techniques 

Up to now we have presented the particular results obtained with and during the different 

techniques applied in the study. Next, we present other results independent of the 

techniques. 

1. In total, the tool presented a large number of deficiencies. One hundred and 

forty-eight different usability problems were found in the tool. Accordinp to the usability 

guidelines, the problems in both techniques were distributed as shown in Figure 4.1 

beIow. 

Most problems were related to (a) simple and narural dialogue, (b) speak 

users'iunguage, (c)  cunsistency, and (d) good feedback. Many of these were effects of 

having designed the tool with insufficient information about complete SES' tasks and 

working environment as well as user interface guidelines and standards. Many problems 

were the type of problems that normally appear on a first usability evaluation. We  found 

that many coufd have been easily avoided with the application of certain user centered 

design activities, such as having used complete scenarios and tasks to drive design, 

having evaluated tool with prototypes and having followed user interface standards and 

guidelines more systematicaily. 
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FIGURE 4.1 Problems according to the usability guidelines 

Ninety-three problems (62%) were about deficiencies in learning the tool, 

eighty-seven (59%) about efficiency of use, and thirty-two (218) about both (Figure 4.2). 

FIGURE 4.2 Types of problems found using both techniques 

These problems indicated that the tool design did not facilitate learning and using 

efficiently its hinctionality. In fact, as stated earlier, those problems had already affected 

SES. None of them was capable yet to efficiently exploit al1 the functionality. 



2. Not al1 the problems meant that something in the tool had to be fixed. The results 

indicated that good tool learnability and other means for helping SES to learn the tool 

were key elements for assessing the functionality. Many problerns existed simply because 

participants didn't know certain information, but once they knew it. the problems didn't 

exist anymore. We noticed that developers realized that some learning problems did not 

necessarily mean that something in the tool had to be fixed, instead. including some 

information in a tutorid or training course, or in a manual or on-line help couid possibly 

solve the problem. Hence. people in the KBRE project started thinking on other possible 

means for helping SES to learn the tool besides improving its learnability, such as training 

the SES with some courses or practical examples. 

3. Testing the tool without the intention of solving high level SES goals had led to not 

detecting certain deficiencies in the tool. We noticed that developers tested the tool with 

typical tasks that SES do for exploring the Company systems, however, when they 

performed such tasks they never had the intention of soIving some high Ievel goal that 

SES normally had. This phenornenon was dso observed with the SE who gave the 

tutorials to novices. In the sessions, we had observed that with different goals in mind, 

participants (e.g. SES) solved the same task using different sequences of features. 

Consequently, not having high level goals in rnind had made developers always complete 

a task using the same sequence of features, thus, not exploring other possible paths of 

using the features that SES could perform, and ultimately, not detecting problems with 

them. In fact, we noticed that the sequences of features used by developers to solve the 

tasks tended to encounter many fewer 'bugs' than others used by participants to solve the 

same tasks. This certainly showed that sequences used by developers had been already 

cleaned of errors. 

On the other hand, not having a high level goal in mind when solving the tasks during the 

demos had only shown a partial power of the functionality. That is. demos had only 

shown how the tool could be useful under particular circumstances. 



4. Insufficient communication between the KBRE project and SES had been a cause 

seriously affecting assessing the functionality. The tool had been given to a group of SES 

so that they used it during maintenance activities. On one side, poor usability in the tool 

had affected some of those SES from exptoiting the functionality efficiently. But, on the 

other side, a large nurnber of SES had not used the twl at dl. These last SES had 

obviously not k e n  affected by poor tool usability but had not used the tool for other 

reasons, such as ignorance that it existed or was available, low motivation or limited time 

for trying it, etc. On the other hand, the project had not monitored the SES much, and 

therefore, they never had known the status exactly. 

We noticed that a permanent channel of communication between the project and SES was 

key for having a group of SES using the tool. The project had not established such 

channel for several reasons, such as, ignorance about its importance, lack of people 

involved in it, insuficient time and resources, etc. We found that the usability study 

worked extremely well for providing that channel. 

5. Combining heuristic evaluation and thinking aloud usability testing worked excellent 

for obtaining information about the usability of the tool. One hundred and fourteen 

problems were found with the heuristic evaluation and seventy-two with the thinking 

aloud usability testing. Thirty-eight of the problems found with the heuristic evaluation 

(33%) were confirmed with the thinking doud usability testing (Figure 4.3). 

Both techniques complemented each other very well. Each one provided different types 

of problems. Also, by using both, we could confirm certain problems and obtain a more 

reliab1e severity of them. 
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FIGURE 4.3 Percentage of problems found by the techniques 

6 .  The study, as perforrned, worked very well for introducing usability and user centered 

design into the KBRE project. We noticed that applying two evaluation techniques took 

longer but produced a much better effect in the project. Both usability evaluation 

techniques worked well but in particular thinking aloud usability testing. 

Although late in the tool lifecycle, having introduced usability at that time was 

worthwhile. The study revealed problems and issues unfeasible to solve, but it helped the 

project seeing how to proceed for assessing the functionality. Before the study, the 

project was facing the problem that SES had not used the tool much and it was not known 

exactly why and what to do. 

By the end of the smdy the project had passed from the skepticism stage to the 

accepfance stage. as described in Chapter II. We noticed that people in the KBRE project 

became aware of the following issues: 

Assessing the functionality at that time was not possible yet. 

It would be necessary to have a group of SES efficiently using the functionality in 

order to assess it. Therefore, certain activities should be planned for helping SES 



to learn the functionaIity. They realized that usability studies could be one such 

activity. Also, it would be important to rnonitor SES more closely. 

Solving the problems in the tool would indeed improve its usability but that 

would be only a first step towards achieving good usability. They realized that 

(a) problems captured this time were probably not ail the existing ones and 

(b) solutions to the problems found should be tested with SES. They saw it would 

be necessary to have more iteration of evaiuation and redesign. 

Any new functionality should be prototyped and evaluated before being 

impkmented. 

The scenarios and tasks generated for the study should be kept and used for 

testing solutions to usability problerns, new design ideas and in any other future 

usability studies. 

It would be necessary to have people in the project heIping with usability. They 

reaiized they didn't have the skills nor the time for that. 



Conclusions 

The present chapter presents the main conclusions and kssons learned from our research 

done through the usability study of the tool. These conclusions are organized according to 

the issues we were interested in the research. We provide as well a senes of 

recommendations based on such conclusions and other insights from the research. 

5.1 Detailed Conclusions 

Following are the conclusions according to the three issues we were interested in the 

research (section 1.2). 

5.1.1 Objective One 

In regards to possible effects of not having considered usability when assessing the 

functionality of a system, we found the following things: 

1. Not considenng usability can affect for the assessrnent of the functionality. The 

usability smdy revealed that there was not a group of SES that couid use al1 the power of 

the functionality of the tool at that moment, and therefore, it was impossible for the 

KBRE project to assess such functionaiity. In other words, it was impossible to determine 

if the functionality was very good already for helping SES at maintainhg the Company 

systems more efficiently or if it should be improved. This group of SES didnt exist for 

several reasons. On one side. problems such as. ignorance that the tool existed. low 

motivation, limited time, etc., had caused that many SES did not use the tool at dl. But, 

on the other hand, not having considered usability had meant that the tool presented a 



large number of usability deficiencies, which in tum, had made that those SES who had 

used the tool were not capable of using d l  the power of the functionality. In other words. 

bad usability in the tool meant it was not possible to assess the functionality at that 

moment. 

2. Helping users Iearn the system is essentiai for assessing its functionality and good 

usability plays a key role, particularly good learnability. As we mentioned above, there 

was not a group of SES that could use al1 the power of the functionality at that moment. It 

was c1ear that just having ieft the tml available to SES dunng 1.5 years had not been 

enough so that such a group of SES emerged. Also, not having monitored how SES used 

the tool had meant that the KBRE project never realized causes affecthg the use of the 

tool. In sumrnary, it was clear that in order to have a group of SES capable of using al1 the 

power of the functionality it would have been necessary to help the SES at Iearning the 

functionality. For that, good tool leantabili~y would have been key. 

3. Usability testing can be an excellent activity for helping users l e m  the system. We 

saw that the usability study served as an excellent communication channel between 

developers and SES. On one side, it meant that more SES learned and used the tool better- 

Participants learned to exploit the power of the functionality by doing the tasks of the 

test, and they encouraged other SES to Iearn and use the tool as well. On the other side, 

the study helped the KBRE project at discovering causes affecting the use of the tool as 

well as how to proceed in ensunng that a group of SES could be capable of using al1 the 

power of the functionality. 

4. Ideally, usability should be considered from the beginning of a project, but 

considenng it late is worthwhile and much better than never considering it. Despite al1 

the problems and effects that not having considered usability had caused, having started 

usability activities at the time of this research produced immediate benefits. The KBRE 

project was facing the problem that k t  many SES had used the tool and it was unhown 

exactly why and what to do. As we mentioned before, the usability study exposed many 

of the causes of that problem and helped ai seing how to proceed next. After the study. 



developen had a much clearer idea of what kind of things ihey should pay attention to in 

order to irnprove the tool. It is important to mention that the advanced status of the tool 

within its lifecycle meant that not al1 the problems and things revealed by the snidy could 

be solved or improved. 

5.1.2 Objective Two 

With regard to experimenting with the introduction of user centered design and usability 

into the latter stages of software projects in which developers are new to these concepts, 

we made the following observations: 

5. Usability must be gradually introduced by following a process. Throughout the study, 

we confirmed that working towards good tool usability definitely required cornmitment 

and participation of many people in the KBRE project, including developers, SES and 

managers of both. Also, it required certain level of developers' maturity with usability, its 

effects and how to address it. But we saw as well that people in the project required time 

and being exposed to different types of activities in order to acquire that matunty and 

commitment to usability. In summary, we confjrmed that it was necessary to use a 

gradua1 process including different types of activities &O introduce usability into the 

KBRE project. 

6. Initial activities must focus at creating usability awareness in the software project 

(rnaybe sacnficing obtaining the best possible usability results). As we mentioned above, 

working towards good tool usability required developers' maturity and commitment to 

usability. After the study, we saw that performing the best techniques to obtain the best 

usability insights was not as important before the study as developing such commitment 

and matunty. We found that making people in the project become aware of (a) what 

usability was, (b) the usability status of the tool, and (c) how it had affected the SES, 

generated the most powerfd effect for developing maturity and commitment to the 

usability of the tool. The best activities had been evaluating the twl ,  fixing tool usability 



problems and testing the tool with SES. However as well, insufficient maturity of the 

project at that time meant that these activities not always produced the best effects with 

regard to the usability of the tool. At that moment, developers were only becoming aware 

of what usability meant and how difficult achieving good tool usability was. 

7. Creation of scenarios and tasks of system usage is very helpful. W e  confirmed that 

examples of scenarios and tasks reflecting the tool's design intent produced many 

benefits. They served to perforrn the testing but also greatly supported developers in 

testing the solutions of the problems and testing designs of future features. 

8. System requirements and specifications as well as user interface information are very 

important. We saw that knowledge on (a) the tool domain. (b) how it addressed the 

problem, (c) the rationale of its design. and (d) how it had to be used, was essential for 

developers when trying to improve the tool. Not having means to completely acquire that 

knowledge seriously affected new developers that had recently corne into the KBRE 

project. We saw that system specifications and user interface information would have 

been particularly helpful. 

9. Experience introducing usability is an important requirement for the usability 

specialist. particularly when developers are new to usability. Insufficient knowledge 

about usability meant that developers of the tool had difficulties: 

Understanding usability problems in its most general way. 

Seeing implications of not efficient solutions. 

Evaluating effectiveness of different solutions. 

Prioritizing the problems. 

Deciding how to proceed on fixing the problems. 

Therefore. the person performing th; study had to support developers in al1 these issues. 

We found that this type of support was not always easy to provide; producing the best 

results definitely required experience dealing with the above issues. 



10. Developers have difficulties generating good solutions the fint time they solve 

usability problems. The above difficulties meant that developers not always devised g d  

solutions to the problems. Sometimes, the solutions would lead to other obvious usability 

problems. This situation dong with the state of development of the tool, limited time and 

insufficient resources meant that developers did not always implement good solutions. 

11. Once exposed to usability, software projects can quickly mature about acceptiog 

usability. During the study, the KBRE project pas& from the skeptical stage to the 

acceptance stage, as descnbed in Chapter II. In al1 the study, we never noticd anything 

that could have caused the project to reject or disagree with usability. Basically the only 

reason why usability had not been considered was insufficient knowledge. Every time 

people in the project learned something new, they were more convinced and committed 

to usability. 

5.1.3 Objective Three 

In regards to explonng particular challenges of studying the usability of program 

comprehension tools, we found the following things: 

12. Domain knowledge is an important requirement for the usability speciaiist. nie  tool 

domain was so particular and complex that knowledge in it was important for al1 the 

usability specialists involved in the study. On one hand, evaiuators in the heuristic 

evaluation required this knowledge to be able to make accurate judgments about the tool. 

In fact, insufficient domain knowledge posed difficulties for one evaluator. On the other 

hand, the experimenter in the study had to provide support to this previous evaluator on 

several issues about the domain. Aiso, he had to fully understand the problems, 

appropriately explain those in the report, communicate them to developers, and provide 

advice during the generation of solutions. Ail these required domain knowledge on the 

part of the experimenter. 



13. Testing with real users is essential. It is well known that that the more similar the 

participants in a usability study are to the users of the system the more accurate the 

results of the study will be. As we mentioned above, the tool domain was so particular 

and complex that the population of usen of the tool (SES) was very specific. In the study. 

we saw that people with very similar characteristics to the SES behaved very differently 

to those when approaching the problems that the tool was designed for. and therefore 

they used the tool very differently. We noticed that testing with real users of the tool 

(SES) was even important for the pilot study. 

14. Task determination becomes particularly difficult and complex. Like in the previous 

issue, the complexity of the tool domain meant that SES could approach the problems 

very differently and in very unpredictable ways. This implied that finding suitable tasks 

for the study that made them use the tool functionality in a more or less predictable way 

was very difficult. 

5.1.4 Other Conclusions 

We also found the following things: 

15. Xn regards to heuristic evaluation: 

Using evaluators with usability knowledge is important. This knowledge was 

important so that they knew what to do and look for in the evaluation. However, we 

noticed that people with this knowledge were not easy to find. 

Better results c m  be obtained by combining evaluators with different levels of 

domain knowledge and system expertise. We saw that each type of evaluator 

captured different types of problems and this provideci a broader spectrum of 



problems. We don? know if this combination is always better in general. But this is 

a topic for further research where more experimentation could k performed. 

16. In regards to thinking aloud usability testing: 

a) This technique is more difficult than heuristic evaluation. Applying this techniq~e 

required dealing with many more issues during its planning and application. 

b) It is an excellent way to innoduce usability inio a software project It worked 

excellentiy in creating awareness and commitment to usability in the KBRE 

project. 

17. Combining both techniques is an excellent approach. Applying both techniques twk 

us  longer but produced a much better effect on introducing the KBRE project to usability 

and user centered design. Using the two techniques exposed the project more to usability, 

which made it mature and become more committed to it. Also. both techniques 

complemented each other very well. Each one provided different types of problems. By 

using both, we could confirm certain problems and obtain a more reliable severity of 

thern. 

5.2 Recommendations 

This research led to some recommendations. The following set of recormnendations is for 

software projects developing a system in which its functiondity will be assessed. They 

were derived from the conclusions discussed in section 5.1.1 above. 

1. Pay attention to both the utility agd the usability of the system. Plan for resources and 

activities to look over both. Not paying attention to one could affect the assessrnent of 

the  functionality and consequently reduce chances for improving the system. 



2. Create a plan for ensuring that the group of users who is given the system correctly 

l e m  and use the system. Establish a permanent channel of communication between 

them and developers. Plan for activities to help them at leaming and using the system. 

Monitor how they employ the system (see conclusions in section 5.1.1 above). 

The following set of recommendations is offered for software projects that have started 

without usability activities but that want to initiate activities to look at and improve the 

usability of a system. They were denved from the conclusions discussed in section 5.1.2 

above. 

3. Establish a plan of action. If time and resources are limited, use a discount usability 

engineering approach. Imponant activities to include in the plan are: 

a) A user and task analysis. Clearly identify the target population of usen of the 

system. Identify charactenstics of those users that can affect how they use the 

system. Identify the tasks that the system is trying to help them with. IdentiQ 

possible groups of users within the target population and their characteristics. 

Document al1 identified information. 

b) Identify and maintain information about the system such as system requirements, 

specifications and design rationaie of the user interface. Emphasis should be on 

information that can help people at learning the system and its domain. 

c) Create a set of typical scenarios and tasks that reflect the system's design intent. 

Use identified information as help. 

d) Establish usability goals for the system. Consider pre-established objectives of the 

system and use identified information as help. 

e) Plan for iterations of evaluation and redesign. Iterate until reaching the usability 

goals. 



4. As much as possible maintain a usability "churnpion" in the project. 

5. Insüuct developers on usability before starting the project. Also. plan for activities to 

continually improve the usability knowledge of people in the projecr. 

6. If using heunstic evaluation: 

a) Try to get evaluators with as rnuch knowledge in the domain of the system as 

possible. 

b) Provide support to evaluators with information about the system such as. 

requirements. specifications and design rationale of the user interface. 

C) Plan for sufficient time and resources to summarize problems found by 

evaluators. 

d) Plan for some sessions with developers to review the problems. 

e) Integrate evaluators into a pool of usability specidists for future evaluations 

of this or other systems. 

7. If using thinking aloud usability testing: 

a) Use system information such as requirements, specifications and design 

rationale of the user interface as help for determining the tasks. 

b) Phrase the tasks in a way that the communication between observer and . 

participants is kept at a minimum. Participants must able to talk while 

perfonning the tasks but should not require (as much as possible) help from 

the observer. This could be accomplished by asking participants to count 



something, write down the answers, or observe something on the screens of 

the system. 

C) Plan for at least three times the duration of videos for their analysis. 

d) Plan for some sessions with developers in order to review the problems. 

e) Integrate participants into a pool of participants for future tests of this or other 

systems. 

5.3 Summary 

The research project presented here investigated several issues. First, it explored effects 

of not having considered usability when assessing the functionality of a particular 

program comprehension tool. This tool had been created to provide certain experimental 

functionality that its developers wanted to assess. For that, the tool had been given to a 

group of users for some time. Second. the research experimented with intmducing 

usability into the software project that was creating the tool at a late stage of the lifecycle. 

Finally, the research explored challenges posed to studying the usability of the program 

comprehension tool. 

A usability study was designed and performed to punue the research. Three techniques 

were applied in the study: (a) heuristic evaluation, (b) user and tark analysis and 

(c) thinking aloud usability testing. Heunstic evaluation served to look for usability 

deficiencies in the tool design. For this, a group of evaiuators judged the tool according to 

a list of usability guidelines and principles. Thinking aioud usability testing served both 

(a) to look for problems that users experienced when Iearning and using the tool. and also 

(b) to explore how users who hac! been given the tool were capable of using its 

hinctionality. Both were achieved by observing a group of usea performing some tasks 

typical of the tool's design intenL User and task analysis served to obtain a group of users 



and a set of tasks for the thinking aloud usability testing technique. It also served to 

gather information about how the users had employed the tool. The study followed a 

discount usability engineering approach. 

The study was in general easy to plan and perform although certain things were more 

difficult than expected. Most difficulties were related to practical problems in planning 

and applying the techniques. It was difficult to find within the usability literature advice 

or examples of certain practical issues. 

The study was very productive in finding information about al1 the objectives in the 

research within the particular software project. In summary, it revealed that none of the 

users who had been given the tool was capable yet of correctly using its functionality, and 

therefore, it was impossible to assess the tooI functionality at that moment. Not having 

considered usability had been one of the causes of this. Also, the study exposed many 

issues in relation to (a) having started considered usability at a late stage in the tool 

lifecycle and (b) the software project's reaction to k i n g  exposed to usability for the first 

time. Finally, the study exhibited certain particularities and diffkulties with planning and 

studying the usability of the program comprehension tool. In summary, the research 

project was satisfactory and accomplished aI1 its objectives. 
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APPENDM 1 
The Tool before the Project 









APPENDM 2 

Usability Problems found in the 
Heuristic Evaluation 

The following notation is used in the first row of the tables: 

1. The first field indicates the number of the problem and its location in the user interface 
according to the codes below. It also contains a letter "v" in case the pmblem was 
Verified during the thinking aloud usability testing. - 

OW: Overall in the Interface 
DW: about Dialog Windows opened by interface features 
HW: related to the History Window 
HiW: related to the Hierarchy Window 
SW: related to the Source Window 
TS: related with the Tool bar and Shortcuts 
PW: related with the Preferences dialog Window 
GG: related with the GlobaI Grep feature and its window 

2. The second field indicates the usability guideline violated by the problem. 

3. The third field indicates whether the problem was about Learning (letter "Ln), Enciency 
of use (letter "E"), or both. It also classifies the problems according to the following 
categories: 

i. Non optimal functionality 
ii. Possible confusion 

iii. Possible misinterpretation 
iv. Unnecessary functionality 
v. Lack of functionality 

vi. Lack of consistency 
vii. Graphical design 

viii. Feedback 
ix. Lack of robustness 
x. Wrong behavior 

xi. Bad labeling 
xii. Lack of labeling 

4. The fourth field indicates an approximate Usability Severity (US) of the problem 
according to the codes below. The seventy values were established when revitwing the 
problems in the sessions with developers. 

1 = Cosmetic problem, fixing it should be given low priot-ity. 
2 = Minor problem, important to fix but can be given low priority. 
3 = Major problem important to fix and should be given high priority. 
w = Wait to fix it until it is verified in the thinking aloud usability testing. 



remember the way they work. 
Features with the problem: 

History->Add new state . . . 
History->Delete selected state 
History->Update seIected state 
History->Modify exploration state 
Hierarchy->New Iist with selection 
Hierarchy->Delete selected enmes 
Hierarchy->Delete sublist 
Hierarchy->Find in this list . . . 
Hierarchy->Go to line . . . 

US: Problem classüication: 1. 

US: 

Violated principle: 

Pro blem c~assification: 2. 

~iotated principle: 
natural dialogue 

01  

Viotated pnnciple: 

Probtem: There are two options labeled 'Hisrory' and 'Hierarchy' in the main menu. Likewise, two 
windows are labeled 'History' and 'Hierarchy'. This couId suggest thar features within the options in the 
main menu correspond to things or actions in those windows. However, only some features are intended 
like that. Novice users might get confused by having features affecting giobally in the tool and others 
affecting Iocally within those windows. 
Features with the problem: 

History->Delete setected srate 
History->Hide history window 
Hierarchy->Load database . . . 
Hierarchy->List files matctiing pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->Global grep 
Hierarchy->New list with selection 

L. Possible confusion Speak uses '  lanpuage -confusing labelinp- 

01. v 

in the 'Source' option in the main menu affect the 'Source' window. However. such 
window doesnt present a label many times therefore making harder that users discover the relationship. 

Problem classification: 
L. Lack of labeling 

2-w 

Problem: As mentioned in the previous problem, certain features within the options 'Hisrory' and 
'Hierarchy' affect things in those windows only, however some of them have labels that could be 
interpreted affecting not only that window but other things in the tool as well. Therefore, users will have to 

L, Possible misinterpretation Minimize users' memory Ioad 

US: 
3 

2-w 



window only, however some o f  them ha;e labels that could be interpreted affecting not only that window 
but other things in the tool as well. Therefore. users will have to remember the way they work, 
Features with the problem: 

Source-Anformation about selected item 
Source->Open in a file editor 
Source-Search for text . . . 

Source->Go to line . . . 
Source->Highlitpht text 

US: Problem dassiiication: 4. 

1 7. 1 Violated ~rinciple: 1 Problem classification: 1 US: 1 

Violated principle: 

US: 
2 

01 1 Simple and natukl dialogue 1 E, Non optimal functionality 1 1  
Problem: The Hisror),, Hierarchy and Source windows present scroll bars even when these are not 

0 1  

-graphie design-. Consistency 
Problem: In the Hisrory window the label is left aligned and in the Hierurchy window is center aligned. 
This is a lack of consistency in the graphical design of the user interface. Good graphical design is known 
to help users at Iearning and using the interface faster and more efficiently. Also, consistency helps users to 
uansfer howledge from one part to another (e.g. the user can know how to use something new but 
similar). 

Pro blem classification: 
L, Graphieai design 

5. 
0 1  

US: 
2 

I necessary. Also, some scroll bars might be rarely used (e.g. the horizontal scroll bar in the History sub- 
window). It would be better to present scroll bars only when it is necessary. 

Problem: As mentioncd in the previous problem, the features within the Source menu affect the 'Source' 
L, Possible misinterpretation Minimize users' memory load 

Violated principle: 
Simple and natunl dialogue 

-pphica l  design- 
Problem: The design of the Hisrory. Hierarchy and Source windows doesn't suggest a clear division 
among windows. For exarnple, the bar a t  the top looks different in height. This is part of the graphicd 
desion of the user interface. 

Problem classification: 
L, Graphical design 

6. 
01 

2-w 

Violated principle: 
Simple and natural dialogue 

1 9. 1 Violated principle: ( Pro blem classilication: 1 US: 1 
01. v 1 Speak usek' lankuape 1 L, Possible confusion 1 2  
Problem: The message at the bottom-right of the interface seems to inform about the Source window only, 

US: 

however. it presents information global in the tool. Also, this message doesn't have any label indicating its 
meaning. Users will have to deduce it themselves. 

Problem classification: 8. Violated principle: 
01  
Problem: The history States in the History window have the same icon that some objects in the Hierarcliy 
window. However, they are not related at dl. This could suggest a relation between both and confuse users. 
Location observed: 

History window, history event 
Hicrarchy window. .mep result 

_ L. Possible misinterpretation Simple and naturai dialogue 3 



US: 

13. 1 Violated ~rinciule: 1 Problem classification: 1 US: 

Problem classification: 10. 

US: 

01. v 1 Clearly rnkked èxits 1 E, Lack of functionality 1 3  
Problem: There are not 'undo' facilities for any actions in the tool. Users will want to go back frorn 

Violated principle: 

Pro blem dassification: 11. 

US: 

erroneous actions. This can degrade user leamini and performance. On the other hand, there are certain 
actions in the system chat can be reversed by doing other actions or trich, however, users might not notice 
that. 
Some locations observed: 

- Undo the execution of a query 
- Undo any kind of deletion 

01 

Violûted pnnciple: 

Problem classir~cation: 12. 

Problern: The message at the bottom-left of the interface seems to bélong to the Hierarchy window. 
However, sometimes presents information about that window and others about the whole system. 
Situations observed: 

When loadinp a database * 

L, Possible confusion Simple and natural dialogue. Consistency 

01 

Violated principle: 

1 Clearly rnarked exits 1 1 
Problem: The time for stopping queries is sometimes very long. Users will feel trapped by the tool. They 
rnight click on the stop button several times trying to stop the query. Waiting long will affect their 
concentration and performance. 

2 

Problem: When loading a database, the message at the bottom-left of the interface displays a file with its 
prtth. There isn't a Iabel indicating its meaning. Also, the same file name is displayed at the bottom-nght at 
the samc moment. Users will have to deduce the meming themselves. 
O bserved: 

When loading a database L 

L. Lack of labeling Speak users' language 

01 

2 

Problem: Using Oprions->Hide hisror). window changes the main menu options. Changing options in a 
menu can degrade user learning and performance. Some users rnemorize system features by their location 
in the interface. It is usually better to gray out options not available in a certain moment than disappearing 
them from ri menu. 
Location observes: 

Options->Hide history window 
History->Hide history window 
History window pop-up menu->Hide history window 

L. E. Possible confusion Simple and natural dialogue 

US: 
3 

11. 
01, v 

3 

Violated principle: 
Feedback -response cime-, 

US: 
3 

15. 
01, v 

Pro blem classification: 
E, Feedback 

Problem: The response time of the stop button is sometimes very Iong (the time it cakes to indicate that the 
button is working). Like in the previous problern. users will feel trapped by the 1001. They might click on 
the button several times uying to make it work. Waiting long will affect their concentration and 
performance. 

Violated principle: 
Feedback -response tirne-, 
Clearly rnarked exits 

Probkm classiLiution: 
E, Feedback 



where this was observed: 
i ) Sometimes an action was started but there was no indication that it had been started. This wa! 

particularly notorious on actions that took long or when ir was desired to know if the system go 
the proper input from the user. An observed situation with this problem was: 

l - When queries were stopped, the stop button didnt react immediately. 

1 

l 
ii ) Sometimes the tool was processing something but there was no indication of t h a t  This w a  

panicuIarly notorious on actions that took long. An observed situation with this problem wax 

- When the evaluator deleted Iong lists of items in the Hierarchy window. 

iii ) Sometimes the tooI was processing sornething but there was way of knowing how long it woulc 
cake to finish. This was particularly notorious on actions that took long. An observed situatior: 
with this problem was: 

- When processing queries that took long. In this case, the system displayed a mouse 
clock. However. that only indicated that the system was doing the action but didn'i 
indicate how longer it would cake. 

iv)  Sometimes the cool did not indicate that an action had finished. Sometimes there was na 
indication at all, and others the feedback was not explicit enough to be noticeci- Some observed 
situations with this problem were: 

a) When a query or action produced an empty result. 
b) When actions finished very fast and left the interface exactly as it was before. This happened 

when using: - Hierarchy window, File pop-up menu->Routines in me 
- Hierarchy window, Routine pop-up menu->Routines 1 call 

C) When the evaluator deleted items in the Hierarchy window. 
d) Executing Histo y- > Update selecred srare 
e) Executing Hierarchy->Find in rhis lisr ... 
f) Executing Source->Inforniion on selecred irem 
g )  Executing Source->Highlitghr rexi 

v ) Sometimes the information presented in the interface did not correspond to the reality (misleading 
feedback). This can make users assume things that are not me. Some observed situations with 
this problem were: 

a) When sorne dialog windows were open, if the mouse was moved out of the window it 
changed to a mouse clock, however, there was no operation k i n g  performed at that moment. 
This happened when using: 

- Hierarchy->List files matching pattern 
- Hierarchy->List routines matching pattern 
- Hierarchy->List identifiers matching pattern 

b) After doing certain actions in the Hierarchy window, the message at the bottom-lefi was not 
corrected. 

C) Deleting objects in the Hierarchy window left the label of the corresponding history state 
unaffected. 

d) Selecting objects in the Hierarchy window didnt refiesh the Source window properly. 
e) Using Rouiines i call and Ruurines I call TREE displayed repeated information in the 

Hierarchy window. 
f) Routines in the Hierarchy window were displayed alphabeticdly. 

P 

US: 
3 

16. 
01. v 
Problern: The feedback in the tool is not clear or properly supplied. The following are different situations 

5 

t 

i 

I 
I 

b 

t 

1 

l 

- 

Violated priaciple: Problem cl;issifkation: 
Feedback L. E, Feedback 



Location observed: 
Options->History active 

US: 

1 19. 1 Violated principle: 1 Problem classification: 1 US: 1 

Problem cldcat ion:  17. 

0 1  ( Simple and natGal dialogue 1 E. Lack of robustness 1 1  
Problem: If the main window of the interface is shrunk, the interior windows (History, Hierarchy and 

Violated principle: 

US: 

Sowce) are not adjusted proportionally. Sometimes, if such window is enlarged back again, some of the 
intenor windows remain s h n k ,  not proportional and not functional. Users will have to adjust the interior 
windows manually. 
Situations observed: 

0 1  

Problem cldcation: 18. 

1 SpecialIy observable with extreme shrinking 1 

Problem: The feature Options->Hisros, active doesnt work properly. Tt blocks the Hisror). window so that 
sdecting history States doesnt refiesh the other windows. However, some operations in the Hierarchy 
window that affect the history still work. Users will have problems learning and understanding this 
behavior. Also. this option might be better located within preferences nther than in the Options menu. 

L, E. Possible confusion Simple and natural dialogue. Consistency 

Violated principle: 

3 

0 1  

1 Location observed: 1 

Probtem: In the main menu, when the menu of an option is open, moving the rnouse to another option 
highlights the other option but the same menu rernains displayed and it is not changed to chat of the new 
option. For example, open the Hisrory menu and then move the mouse to Hierarchy without clicking. The 
Hierarchy option is highlighted but the dispiayed menu is still the History menu. 
Location observed: 

L, Lack of consistency Consistency -standards- 

1 Specially observable with extreme resizing 1 

1 

US: 20. 

~ocat ion observed: 
File->New history files 
File->Open history files 
File->Save current exploration . 

01 
Violated principle: Problem classification: 

US: 

1 Location observed: ' 1 

Problem: There are no limits when resizing the interior windows (History, Hierarchy and Source). An 
intenor window can be resized until it makes another window disappear. thus leaving the other one not 
functional. Users will have to adjust the interior windows manually. 

Simple and natural dialogue 

Problem classification: 21. 

22. 
01, v 

1 File->New history files 1 

E, Lack of robustness 2 

Violated principle: 
0 1  

Problem: A name of a history file is always asked when creating a new exploration. This is not a problem 
itself, however it's is not a common procedure in other systems and cornbined with the problems below 
then it becomes an inefficient behavior of the system. 

Violated principle: 
Simple and natural dialogue, 
Consistency -standards- 

Problem: The tool accepts saving s history file with a name containing special UNIX characters like * or ?. 
After saving files Iike that. it is even possible to look at them through the windows for creating and opening 
history files. 

E, Wrong behavior Simple and natural dialogue. Bug 2 

Problem classiîicab'on: 
E, Non optimal functionality 

US: 
3 



23. 1 Violrited principle: 1 Pmblcm classification: 1 US: 

- 

L 

01, v 

1 ~ o n s i s t e n c ~  -standards- 1 1 
Problern: When leaving the tool, creating or opening another history file. the system always prompts to 

I Save the current exploration. The user has always to attend this action even if the exploration hasn't 
1 chanped and rhere is nothing to Save. It would be better if the tool kept track of any changes made to the 

history and just prompt in that case. 
Location observed: 

File->New history files 
File->Open history files 
FiIe->Save current exploration 

Problem: When saving the current exploration, the narne of a file is always asked. Thcre is no famre  for 
saving the exploration without asking a name. Most other systems implement a feature for that. Also, as 
indicated in the previous problem, the name of a history file has dready k e n  asked when creating the 
exploration. This problem is also present when the user wants to leave the system, creatc or open another 
history file, the tool always prompts for a name. The user wiil waste time attending this action each time 
the exploration is saved. In addition, the label for saving the exploration is File->Save current exploration, 
which doesn't suggest that a file name wiil be prompted. It would be better File->Save currenr explorarion 
as ... 
Location observed: 

File->Save current exploration 

Simple and natuhl dialogue, 
Consistency -standards- 

US: 
2 

Problem classilica tion: 21. 

E, Unnecessary functionality 

i QI. v Simple and natunl dialogue, E, Unnecessary functionality 
Violated principle: 

2 

US: 
2 

Problem: The tool always prompts for confirmation when the user leaves the system. This is a waste of 
time for users that are already prepared to exit. It is better if the tool prompted the user just if there is 
mything that has to be saved. 
Location observed: 

Pro blem classiticcation: 
E, Unnecessary functionality 

25. 
01, v 

US: 
2 

Violated principle: 
Simple and natural dialogue, 
Consistency -standards- 

Problem: Some features are repeated twice in different menus. This can confuse users because they won? 
know at first if those features at different locations are indeed the same feature. Also, it makes bigger the 
menus and therefore the user has more information to l e m  and remember. Finally, this is not very common 
in other systems. 
Location observed: 

File->Load database . . . 
Hierarchy->Load database . . . 
Options->Hide history windows 
History->Hide history window 

Problem classification: 
L. Possible confusion 

26. 
QI 

Violated principle: 
Simple and natural dialogue - l e s  is more- 



1 27. 1 Violated principle: Problem c i d c a t i o n :  1 US: 1 
0 1  1 Minimize usen memory load 1 L, Possible confusion 1 3  
Problern: There are different features in different menus with exactly the same label. Users will have to 

1 notice that they are different feanires that work differently. 1 
Location observed: 

Hierarchy->Go to line ... 
Source->Go to Iine ... 

crtpitalized and others don't. This is a Iack of consistency in the graphical design of the user interface. Good 
graphical design is known to help users at learning and using the interface faster and more efficiently. Also. 
consistency helps users to transfer knowledge from one part to another (e-g. the user can know how to use 
something new but similar). 
Sorne locations observed: 

File->had database ... , and the didog box that is opened 
Hierarchy- > Global grep . and dialog box that is opened 

US: 
3 

Problem classification: 
L, E, Non optimal functionality, 

28. 
01. v 

US: 

Minimize users' memory load 

Violated principle: 
Simple and natural dialogue, 

Problem classification: 29. 

Feedback 

Violated principle: 

US: 

Problern: All features in the interface look active al1 the tirne. There is no gray out of features that do not 
work at some moment. If a feature is active but doesn't work, it can affect on users' performance. Users 
wifl have tu l e m  by experience, what features work and what don't in different situations. 

01 

Problem clad~cation: 30. 

Problem: The labels and names of menus, buttons and windows, sometimes have the words s t d n g  
L, iack of consistency Consistency 

Violated principle: 

1 

01 
Problem: The labels of some feanires are different from the titles of the dialog windows they open. Some 
users, especially when learning a system, compare window tities with labels of the features to see if the 
urindows opened corne from those features. 
Sorne locations obsewed: 

File->New history files 
File->Open history files 
File->Save current exploration 
File->Qui t 
Op~ions->Preferences 
History->ModiQ exploration state name 
Hierarchy->List files matching pattem 
Hierarchy->List routines matching pattem 
Hiemchy->List identifiers rnatching pattem 
Hierarchy->Find in this list ... 
Hierarchy->Go to line . . . -it says "GotoN- 
Source-Search for text . . . 
Source->Go to line . . . -it says "Goton- 

L. Lack of consistency Consistency 2 



- - 
the same features in the menus. Sorne users, especially when leming the system. compare those labels to 
establish relationships among buttons and features. 
Location observed: 

Tool bar->Grep inio the entire system 
Hierarchy->Global grep 
Tool bar->Routines 1 cal1 (TREE) 
Routine middle-mouse button pop-up menu-> Routines 1 call TREE 
Tool bar->Routines that call me (TREE) 
Routine middle-mouse button pop-up menu-> Routines that call me TREE 

US: 

with the window titles-do not always suggestusen the purpose of the window. It's important to help users 
not just on what to do within a didog window but also with what the window is for. For example, in 
Hierarchy->Find in ibis fisr ... the window title is Find windoiv and the message inside is Enrer regular 
expression. A better message rnight be something iike Enter t a r  rofind in the explorarion hierarchy. 
Location obsersed: 

Hierarchy->Find in this list . .. 

Problem classification: 31. Violated principle: 

US: 

0 1  

Problern clsrssification: 32. 

] ~ o n s i s t e n c ~  standards- 1 1 
Problem: Xt's nccessq to hold d o m  the mouse button so that pop-up menus stay on the screen. This is or 
not a problem depending on other reasons, however it always requires more effort to the user. Also, this is 
not the standard practice in other systems. 
Location O bserved: 

Pop-up menus in Hierarchy. History and Source windows 

Problem: The labels of the help flags of some buttons from the tool bar do not correspond to the labels of 
L, Lack of consistency Consistency 

Violatecl principlc: 

US: 

35. 1 Violated principle: 1 Problem classification: 1 US: 

2 

0 1  

Problem classification: 33. 

US: 
2-w 

01 1 consistency - ( L, E, Lack of consistency 12 
Problem: The default colors in the interface are used inconsistently. The same color is used in different 

Problem: Some dialog windows have messages within h m .  However, those messages alone or combined 
L. Bad labeling Speak users' language 

Viofated principle: 

Problem classification: 
E, Non optimal functionality 

33. 
01. v 

places for different meanings. 
Some locations observed: 

- Blue is used in History window and sometimes in Source window as well 

1 

0 1  

Violated principle: 
Simple and natural dialogue, 

Problem: ï h e  following features have labels in plural, however they work on one object or thing only. The 
first two features below open diaiog boxes with window titles in singular. 
Location observed: 

File->New history files 
File->Open history fiIes 
Options->Hide history windows 

L. Bad labeling Speak users' ianguage, Consistency 1 



1 ~hoAcuts -improper use- I I 
Problem: The buffer for searching actions is the same for several features and is not cleaned fiom previous 
serirches, For example. tooking for a file and then opening the dialog window again to look for variable will 
present the input previously given when looking for the file. It might be better if just similar types of 
serirches shared the same previous buffer. Afso, previous inputs are not presented highlighted when dialog 
windows are opened, therefore, the usen has to clean [hem manually character by chmcter. 
Some locations observed: 

Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->Find in this list . .. 
Source->Search for text . . . 
Hierarchy->Go to line ... 

US: 
2 

Consistency -standards- 
Problem: Some searching features work so that they search just from a certain point-down. they dont 
allow searching the rest of the information Ieft above. Also, they don1 dlow seruching bottom-up. In order 
to search a whole document. users have to go at the start of the document and then perform the search. 
Also. the dialog windows that these features open have a button IabeIed Find. but it might be better to label 
it as Find rtext as in other systems.. 
Some locations observed: 

Hierarchy->End in this list . . . 
Source->Search for text . . . 

Problem ciassification: 
E, Lack of functiondity 

36. 
01, v 

US: 
1 

Violated principle: 
Simple and natural dialogue. 

Pro blem classification: 
E, Non optimal functionality 

37. 
Of, v 

Location obsemed: 
History->Delete selected state 
History->Update selected state 
Hierarchy->New list with selection 
Hierarchy->Delete selected entries 

Violated principle: 
Simple and naturai dialogue, 

US: 38. Violated principle: 

Source->Information about select4 item 

Problem c l d ~ c a t i o n :  

US: 39. Violated principle: 

01 Error prevention 

Problem classification: 
01. v Simple and naturd dialogue 

Problem: The folIowing dialog windows keep input from previous occasions and it would become a 
problem if the user accidentally pressed the default action with such input present (e-g. this would start 
closing the current history file). 
Location obsen-ed: 

File->Load database . . . 
File->New history files 
File->Open history files 
Hierarchy->Load database . . . 

E, Non optimal functionality 1 

Problern: It is possible to have several objects selected in the interface at the same time. Some features 
have labels referring ro selecred objects. however such labels do not clcarly suggest what selected object(s) 
the feriture refers to. Thus, it won't be easy for users to know what objects will be affected. 

L. Possible confusion 3-w 



US: 
3 

Problem: There is a potential unnatural scenario with the databases and history files. It's not clear what 
will happen if having a database loaded. the user decides to open a history file that was not created using 
the same dambase. The tool should manage these possible erroneous situations and not expose the user to 

Problem dadication: 
L, E, h c k  of robustness 

40. 
01 

US: 

Violated principle: 
Simple and natural dialogue, 
Error prevention 

Problem classification: 31. 

US: 
1 

Violated principie: 

Problem: The left and right m o w  keys do not behave the sarne in the different windows and dialog 
windows. 
Location observed: 

History, Hierarchy and Source windows 

Problem ciassification: 
E. Lack of consistency 

42. 
0 1  

US: 

0 1  

Violated principle: 
Consistency 

Problem classification: 43. 

US: 
3 

Problem: Loading a new database creates a new history file, however this is not clearly informed. A user 
might not reaiize that and he will have to Ieam by experience. 

L. Non optimal functionality Simple and natural dialogue 

Violated principle: 

Problem: The Hierarchy and History windows can contain very big and long hierarchies. Users will have 
to scroll a lot in order to navigate them. It is known that users are not good for mmaging big hierarchies 
presented as long lists. It would be better to have expansion and contraction facilities for those hierarchies. 
Location observed: 

History and Hienrchy windows 

Problem classitrcation: 
E, Non optimal functionality 

34. 
01, v 

US: 
3 

2-w 

01 

Violated principle: 
Minimize users' memory load 

Problem: In the Hierarchy and Source windows, there is a feature for jumping to a certain line specifying 
its number. However, the tool doesn't provide a way to know the number of a particular line, therefore 
making difficult for a user to know later what number he must enter in order to jump to uiat line. Also, even 
if the user enters a number io jump to certain Iine, he has to trust that the resulting line with the focus is the 
line corresponding to the numker he entered. 
Location obsewed: 

Hierarchy and Source menu 

Problem classification: 
E, Lack of functionality 

45. 
01, v 

Problem: There are two windows in the interface that show a hierarchy of items (Hierarchy and History). 
However, the features in the Hierarchy menu only affect the hierarchy in the Hierarchy window. This could 
confuse users because they wont easily notice what hierarchy the features refer to. Changing the labels 
could help. for example, the Hierarchy menu and window could Say Hierarchy of sofnvare objecrs, and the 
History window Hierarchical history of explora.arions. A 

L, Possible misinterpretation Speak users' language 

Violated principle: 
Simple and natural dialogue, 
Minimize users memory load 

3-w 



01. v ( Speak us&' languape 1 L, E, Possible confusion 1 3-w 
Problem: Using "*" in some searching features dont give any result, however the tool does not infonn 
about that. This behavior is due to the definition of regulv expressions and how the system is built. Other 
systems dont work in this way. Users with other background in other sys tem will probably experience 
problems with that behavior. It's important to consider if the usen of the tool are aware of regular 
expressions as well as if they use hem in their work. Otherwise. users not familiar with hem will probably 
have problems. 
Location observed: 

Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifies matchinp pattern 

1 46. 1 Violated principle: 1 Problem c l d c a t i o n :  1 US: 

1 ~ o n s i s t e n c ~  -standards- 1 1 
Problem: There are no edition facilities in the tool such as for copying and pasting. Thus. users have to 
rely on the operating system facilities for this. However. such operating system facilities might not be 
always known or easy to use. Many systems provide editing features so users might probably look for them 
in the tool. 

US: 47. 

US: 
1-w 

18. 
01, v 

01. v 
Violated principle: 

1 

Problem classüiation: 

Violated priaciple: 
Simple and natural dialogue. 

Problem: Users tend to forget how to construct regular expressions. so it would be possible that the tool 
gave a couple of examples in a pop-up dialog box to refresh peoples' memory (especially with previously 
used regular expressions). 
Location observed: 

Minirnize users' memory load 

Problem classification: 
E. Lack of functionaiity 

US: 
2-w 

49. 
01, v 

US: 
3 

50. 
01, v 

Problem: Users might be interested in other aspects of the objects displayed by the tool than the just the 
ones currentiy supponed, for example types. 

Problem: Currently it is possible to make explorations of things that do not exist. However, the tool can 
know about some of these non-existing things and therefore it could provide dues  so that users didn't waste 
time. For exarnple. the tool could slightly change the color of the icons. Thus, a routine that had no callers 
could look different from one that had. 

E. Lack of functionality 

Violated pnnciple: 
Simple and natural dialogue 

Violated principle: 
Simple and natural dialogue 

2 

Problem c l~* l i cat ion:  
E, Lack of functionaiity 

Pro blem chdication: 
L, E. Non optimal functionality 



51. 1 Violated ~r inc i~ le :  ( Problem dusiiication: 1 US: - 
0 1  1 Consistency / L, Lack of consistency I l  
Problern: Some dialogues and messages use a different font than the rest of the system. This is not a 
serious problem but contributes to the good o v e d l  graphical design of the interface. 
~ociitio" observed: 

File->Quit 
History->Modify exploration state name 
Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->Find in this list ... 
Hierarchy->Go to Iine ... 
Source->Search for text ... 

1 52. 1 Violated ~r inc i~ le :  1 Problem classification: 1 US: 
0 1  1 Help and ~ocum~ntation 1 L, Lack of tünctionali ty 1 2  
Problem: Currently the only onlinc help available is a small tutorial of the tool. However, bat  tutorial is 1 does not describe the version of the 1001 that users have. 

II. ABOUT DWLOG WINDOWS OPENED BY INTERFACE FUTURES 

53. 1 Violated principle: 1 Problem classincation: 1 US: 
DW 1 consisteGy -standards- 1 L, Lack of consistency 12 
Problem: Some features open dialog windows but their labels don't have ". ..". This is the standard way in 
other systems to indicate that anoher dialog window will be open. 
Location observed: 

File->New history files 
File->Open history files 
File-Save current exploration 
History->Modify exploration state name 
Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List idenufien matching pattern 
Hierarchy->Global grep 

Location observed: 
History->Add new state ... 

US: 51. 
DW 

Violated principle: Problem classification: 

Problem: Some features have "..." at the end but don't open a dialog window. 
Consistency -standards- L. Lack of consistency 2 



Location observed: 
File->Load database . . . 
File->New history files 
File->Open history files 
File->Save current exploration 
File->Quit 
Options->Preferences 
History->Modify exploration state name 
Hierarchy->Load database . . . 
Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->GIo bal grep 
Hierarchy->Find in this list . .. 
Hierarchy->Go to line . . . 
Source-Search for rext . . . 
Source->Go to Iine . . . 

US: 
1 

-,saphic design-. Consistency 
Problem: The spacing and alignment of features within some dialog windows is not good and consistent. 
Many things look cluttered even though there are not space consuaints. Good gaphicd design is known to 
help users in leûrning and using the interface more efficiently. 
Location observed: 

File->Load database ... 
File->New history files 
FileaOpen history files 
File->Save current exploration 
File->Quit 
Options->Preferences . . . 

Problem classification: 
L, Graphical design 

55. 
D W  

US: 
1 

is no meaning on allo&ng this. 
Location observed: 

File->Load database . . . 
File->New history files 
File->Open history files 
File->Save current exploration 
File->Quit 
Options->Preferences 

Violated principle: 
Simple and naturai dialogue 

Consistency -standards- 
Problem: Some dialog windows c m  be resized without any limits. This is not the standard way in other 
systems and thcre is no rneaning on allowing this. 

Problem classif~ca tion: 
E, Lack of robustness 

56. 
DW 

~~erarch~->L.oad database . . . 

Violated principle: 
Simple and natural dialogue. 

US: 
2 

Problem: Some dialog windows c m  be minimized. This is not the standard way in other systems and there 

Problem classification: 
E, Lac k of robustncss 

57. 
DW 

Viofated principle: 
Simple and naturai dialogue, 
Consistency -standards- 



Location observed: 
File->Load database . . . 
File->New history files 
File->Open history files 
File->Save curent exploration 

US: Problcm clrissification: 58. 

1 Heip->About Tksee 

Violated princi ple: 

US: 

DW 

Problern classification: 59. 

US: 
3 

Problem: Some windows have the scroll bar on the left side. This is not the standard way in other systems. 
L. E. Lack of consistency Corisistency -standards- 

Violated principle: 
DW 

Problem classification: 
L, E, Non optimal functionality 

60. 
DW, 

1 

Simple and natural dialogue E, Non optimal fbnctiondity 2 

Violated principle: 
Simple and natural dialogue, 

v 

US: 
3 

Problem: The default size in some edit boxes is too smail for the information that needs to be entered. That 
might force users to resize the window when entenng the information. 
Location observed: 

File->Lod database . -, 
File->New history files 
File->Open history fiIes 
File->Save current exploration 

Consistency -standards- 

Problem clasdication: 
L, Possible confusion 

1 61. 
1 DW, 

Problem: Some dialog windows are not well implemented. Some block the main window of the tool but 
can disappear behind i t  Others dont disappear behind but don? allow working correctly on the main 
window while open. 
Location observed: 

File->Load database . . . 
File->New history files 
File->Open history files 
File-Save current exploration 
Options->Preferences 
History->Modify exploration state name 
Hierarchy->Load database . . . 
Hierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarc hy->Global grep 
Hierarchy->Find in this list . . . 
Hierarchy->Go to line . . . 
Source->Search for text . . . 
Source->Go to line . . . 

Violated prînciple: 
Speak uses'  language. 

I v Consistency -standards- 
Problem: Some dialog windows present a path-name edit box with a dot as default. This is not the standard 
way to express the current path in other systems. Users might have problems understanding its meaning. 

1 Location observed: 
1 

File->New history files 
File->Open history files 
File-Save current exploration 



v ] Consistency -standards- 1 1 
Problem: Directory paths and file names have to be entered manually in some dialog windows. There are 
not directory browsing facilities like in other systems. Also, there is no indication of the current path. Users 
will have to enter the whole path and names of files manually. They will ais0 have to remember the current 
path location. 
Location obsewed: 

File->Load database 
File->New history files 
File->Open history files 
File->Save current exploration 

US: 
3 

deletes the selected entry. 
Location observed: 

File->Load database . . . 
File->New history files 
File->Open history files 
File->Save current exploration 
File->Quit 
Options->Preferences 
History->Modify exploration state name 
Hierarchy->Load database . . . 
Hierarchy->List files matching panern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->Global grep 
Hierarchy->Find in this list ... 
Hierarchy->Go CO Iine . . . 
Source-Search for text . .. 
Source->Go to line . .. 
Help->About Tksee -Tab inserts "W- 

PmbIcm classification: 
E, Lack of functionality 

62. 
DW, 

Violated principle: 
Minirnize users memory load, 

US: 

Location observed: 

Problem classification: 63. VioIated principle: 

US: 

DW 

Probkm classification: 64. 

Problem: The Tab key does not change the focus consistentiy throughout the tool options. The Tub key 
works but Sh#-rab doesnt work. This is the standard way in other systems. Also, Shifi-rab sometimes 

E, Lack of consistency Consistency -standards-, Bug 

Violated principle: 

US: 

2 

E, Wronp behavior 3 DW 

Problem classification: 65. 

Problem: Using the Tub key within the dialog windows moves the black rectangle representing the current 
focus through different options. However, pressing enter sometimes executes the default action of the 
window even though it does not have the focus. 

Speak users' laneuage. Bug 

Violated principle: 
DW 
Problem: Some dialog windows have the default button surrounded by a square and other windows don't- 
This convention is not used consistently. 

L. Lac k of consistency Consistency 2 



v I I I 
Problem: Some dialog windows present a list of history or database files, and double clicking on them 
executes the default action of the window. However. this can become dangerous in certain situations such 
as when saving a history file. 
Location obs&ed: 

File->Save current exploration 

US: 
2 

Problem clasdication: 
E, Non optimal functionality 

66. 
D W, 

1 
l 1 dialo.me 1 I 

Problem: The Fife->had darabase ... dialog window shows al1 the files in the default directory. however 
not d l  files arc vdid databases rhat the tool c m  work with. The same is m e  for history files in the 
File->Open hisrory files dialog window. Users might select wrong files that cm produce unexpected tool 
behavior. 
Location observed: 

File->Load database . . . 
File->Open history files 

Violated pnnciple: 
Error prevention 

US: 
3 

I Source-Search for text . . . 

Problem classification: 
E, Non optimal functionality 

67. 
DW 

III. RELATED WITH THE HISTORY WJNDOW 

Violated priaciple: 
Error prevention. Simple and natunl 

US: Problem dassifieation: 6%. Violated principle: 
DW 

US: 

Problem: Most didog windows have a Cancel button. However. some have a Close button instead but 
there is not a strong reason why using a different label is better. 
Location observed: 

Hierarchy-Sind in this list . . . 

L, Lack of consistency Consistency 

Problem c l d a t i o n :  69. 

US: 

1 

Viola ted principle: 

Pro blem classification: 70. 

HW 

Violated principle: 

Problem: The concept of hierarchy in the History window could be interpreted wrong. For example, a 
child state could be inierpreted as if it performed operations considering only the objects fiom the parent 
state. That is, operating ovet certain subset of objects from the whole database. However, that is not the 
way it works. Operations in a child state consider objects from the whole database. A child state simply 
means thût it was created after (in time) its parent state but it is a complete state considering everything in 

L. Possible misinterpretation Speak users' lanpuage 

HW 

3-w 

Problem: A rnanually added state in the History window does not work as a real history state. It does not 
present objects from the database and any operations done in it wiH add new states in the history window. 
In other words. such state works just as a label to group history states. However, it presents the same icon 
as real history states, which doesn't suggest it is different. Users might not understand this behavior. Beiter 
labeling and different icons could help. 
Location observed: 

History->Add new state . . . 

L. E, Possible misinterpretation Speak users' languape 3-w 



IV. RELATED WITH THE WERARCHY WINDOW 

71. 
HW 

v I I I 
Problem: When using Hierarchy->Fa in rhis f u r  .,., the searched item is highlighted but the window is 
not aIways scrolled to display the selecuon. Thus, users will nced CO scroll and look for item in the 
Hierarchy window. This usually happens when just one item was found. 

Problem: The feature History-> Updare selecred state doesn't do anything. 
Location observed: 

History-Npdate selected smte 

Violated principle: 
Simple and natural dialogue 

Pmblem chssüîcation: ' US: 

Location observed: 

L. E. Unnecessary functionality 

US: 
2 

Hierarchy->Find in this list . . . 

3 

Problem c l d c a t i o n :  
E, Feedback 

72. 
HiW, 

73. 1 Violated principle: 
HiW, Feedback 

Violated principle: 
Feedback, Bug 

l Problem ciassification: 
E, Feedback 

v I I I 
Problem: When using Hierarchy->Go ro fine ..., the matching line is not highlighted. Users will need IO 

discover that the fmt line in the window at the top is the line matched. 
Location observed: 

1 Hierarchy->Go to line . . . 

- - -- 1 75. [ ~ i o k t e d  principle: [ Problem c l d c a t i o n :  1 US: 1 
HiW 1 Error prevention. Feedback -response tirne- ( E. Non optimal functiondity 1 2-w 
Problem: Clicking on an item in the Hierarchy window starts refreshing the Source window. However, 

US: 
3 

source files can b; very long and cake long to-be displayed. Also, clicking on something else while the 
refreshment is being done does not necessady stop it. It might be cornmon that users click on something 
they didn't want and therefore will have to wait until the refreshrnent finishes or stop it  with the stop button. 

Problem: In the main window, the message at the bottom-left most times refers to the Hierarchy window. 
In that case. it does not indicate the status of the Hierarchy window but rather results from previous actions. 
It might not be clear to the users what those messages refer to. Also, information about previous actions 
might be useless to the users. When performing new actions users might not remember what the previous 
actions were. 

Pro blem classification: 
L, E, Feedback 

71. 
HiW, 
v 

- - .  

Violated principle: 
Feedback 

Violated principle: 
Feedback -misleading feedback-, 
Simple and naturd diaiogue 

I Problem classification: 
E, Feedback 

v I I I 
Problem: Sometimes selecting a group of variables and pressing delere takes long time to finish, however, 
the tool does not provide feedback indicaûng that the operation is k i n g  achieved. Thus, users might think 
that the opxationis not being achieved and might try todo it again. 
Location observed: 

J Hierarchy->DeIete selected entries 



v 1 Simple and natural dialogue, 1 1 
[ ~ e e d b î c k  -response tirne- 1 1 

Problem: The number of matches in a query can be very large and the query can take long to finish. It 
rnight be good to allow the user zidjust the maximum number of results to display. 

- 
US: 
2 

Violated principle: 
Minimize users memory load, 

Location observed: 

- 

7 

i 

I 

Ptobkrn dusification: 
E. Lack of functionality 

Hierarchy window 

~ierarchi->GO to Iine ... 

US: 

Location observed: 
Hierarchy->Delete selected entries 

Problem classification: 78. 

~ i e r a r c h i - > ~ e l e t e  sublist 1 

Violated Principle: 
HiW 

US: 

Speak users' language. Consistency L, Possible misinterpretation 2-w 

Probkm classification: 79. 

v 1 I I 
Problem: The feature Hierarchy->Delete sublist can be misinterpreted. For examplc, it C O U I ~  be 
interpreted as if rhe currently selected item will be deleted, which in fact it won't. It might be better to label 
it Defere sub-hierarchy below selected. 
Location observed: 

Problem: Certain queries in the Hierarchy menu c m  be interpreied as if they searched just within the 
currcnt list of objects in the hierarchy window. However, some of them work in this way but others search 
in the whole database and create a new state in the History window. Users might get confused by this and 
won? easily learn the way it works. 
Location observed: 

Nierarchy->List files matching pattern 
Hierarchy->List routines matching pattern 
Hierarchy->List identifiers matching pattern 
Hierarchy->Gtobal s e p  
Hierarchy->New list with selection 
Hierarchy->Delete selected entrics 
Hierarchy->Celese sublist 
Hierarchy->Find in this list . . . 

Violated principle: 

1 Hierarchy->Delete sublist 1 

HiW 

US: 
1 

Problem: The labels of some deletion features could be interpreted as if they physically deleted the objects 
in the database. This is not uue but users will have to leam this by expience .  

L, Bad labelinp Minimire users' memory load 

Problem c l d c a t i o n :  
L, Bad Iabeling 

80. 
HiW, 

v I I I 
Problem: Some deletion features in the Hierarchy window remove objects in the hierarchy but leave the 
corresponding state in the History window unaffected. Therefore, the label of such history state does not 
correspond to the objects displayed in the Hierarchy window after having deleted. 
Location obscrved: 

Hierarchy->Delete selected entries 
Hierarchy->Delete sublist 

2 

Violated principle: 
Speak users' language 

US: 
3 

Problem classification: 
L, E, Feedback 

81. 
HiW, 

Violated principle: 
Feed back -misleading feedback- 



v i I i 
Problem: Many important features are located in middle rnouse button menus. It is known that such menus 
are hard to discover. Although they are sometimes used in oiher systems it is necessary to consider the 
trade-off involved. Also, the rniddle mouse button in a mouse with two buttons is implemented by clicking 
both buttons at the same time, which is hard to discover as well. Users won't easily discover these menus 
and therefore the features provided in ihem. 

- 

US: 
2 

82. Violated pnnciple: 
HiW. 1 Simple and natural dialogue 

v I I I 
Problem: The tool provides several different menus depending on (a) where the mouse is located, (b) what 
mouse button is clicked and (c) what objects are highlighted. It'll be hard for the users to remember which 
buttons have to be clicked in order to bring a desired menu- 
Location obsewed: 

Hierarchy menu 

Problem c l d c a t i o n :  
L, E, Non optimal functionality 

1 Middle mouse button menus j 

US: 
3 

P r o  blem c l d c a t i o n :  
L, E, Non optimal functionality 

83. 
HiW, 

not discover these menus will never discover the features, It would be bettcr to have other ways to access 
them. 
Location obsewed: 

File middle-mouse button pop-up menu->Included files 
File middle-mouse button pop-up menu->Files that include me 
File middle-mouse button pop-up menu->Defined variables 
File middle-mouse button pop-up menu->Reponed problems 
File middle-mouse button pop-up menu->Referred activities 
File middle-mouse button pop-up menu->Referred technical terms 
Routine middle-mouse button pop-up menu->File defining me 
Routine middle-mouse button pop-up menu->Referred variables 
Routine middle-mouse button pop-up menu->Reported problems 
Routine middle-mouse button pop-up menu->Referred activities 
Routine middle-mouse button pop-up menu-~Referred technical terms 
Variable middle-mouse button pop-up menu->Files using me 
Variable middle-mouse bunon pop-up menu->Routines using me 

Violated principle: 
Minimize users' rnemory load 

81. 
HIW 

v I I I 
Problem: Someiimes selecting an object in the Hierarchy window doesn't refiesh the Source window. 
Different behaviors were noticed when using different databases. 

Problem: Some featwes of the cool can only be accessed through middle-mouse button menus. Users that 

- - - 

Violated principle: 
Shortcuts 

1 86. 1 Violated ~ r i n c i ~ l e :  1 Problem classification: 1 US: 

US: 
3 

85. 
HiW, 

HiW ) ~ e e d  backm-rnisl&dinp feedback- 1 L. E, Feedback 1 3  
Problem: In the Hierarchy window. selecting a routine and using Routines I call and its equivdent TREE 

Problcm classiCication: 
E. Lack of functionality 

feature leads to having thé child routines dispÏayed twice. The s&e js truc for Routines ihat call me and its 
equivalent TREE fcature. Users might get confused with repcatcd information in the Hierarchy window. 
They will have to discover that it is only repeated information. 

US: 
I 

Violattd principle: 
Feedback -misleadhg feedback- 

Problem classification: 
E, Feedback 



1 Error prevention 1 1 
Problem: The feature to see the routines contained in a file displays the routines alphabetically. However 

1 that's not the order they are within the file. Users could wrongly &sume that is the real order. 1 

US: 
3 

Location obsewed: 
File rniddle-mouse button. pop-up menu->Routines in me , 

Problcm classification: 
E, Feedback 

87. 
HiW 

Violatd principle: 
Feedback -misleading feedback- 

US: 

v I I 
Problem: The name of the auto-grep feature is not a known term and its meaning is not very clear. Also, 
the way it has to be operated is not very easy to understand. Changing the labeling might help. for example 
Grep for x in y instead ofAurogrep (where x and y are dynarnically specified). 
Location observed: 

File middle-mouse button pop-up menu->Aulogsep 
Routine middIe-mouse button pop-up menu->Autogrep 
Variable middle-mouse button pop-up menu->Autogrep 

Probiem classification: 88. 

US: 

1 91. 1 Violated principle: 1 Probtem classification: 1 US: 

Violated principle: 

Problem classification: 89. 

US: 
3 

SW / Speak users* languape 1 L. Possible rnisinterpretation I l  
Problem: The Iabel Open currentfile in a text editor does not ciearly suggest what the feature does and it 

HiW 

Violated principle: 

Pro blem d d ~ c a  tion: 
L, Possible confusion 

90. 
HiW, 

can be misinterpreted. For exampie, a novice user might think it would open the history file. 
Location observed: 

Source->Open file in editor 

Problern: In the middle mouse pop-up menus, the Grep feature could be misinterpreted. For example, it's 
not cIear what objects it will involve. It might be better to change the label for Grep in selecrion instead of 
Grep ... . 
Location observecl: 

File rniddle-mouse button pop-up menu->Grep ... 
Routine middle-mouse button pop-up menu->Grep ... 

L. Possible misinterpretation Speak users' language 

HiW 

Violated priaciple: 
Speak users' language 

3 

Problern: The Grep feature gives the possibility to change the grep command that is executed. It is not 
likely that users will frequently change that. A better alternative would be to move the option into ihe 
preferences dialog window. 
Location observed: 

File middfe-mouse button pop-up menu->Grep 
Routine middle-mouse button pop-up menu-Srep 

E. Non optimal functionality Simple and natural dialogue -1ess is more- 2 



use any features available in order to rdve their tasks. Every exua feature in the systcm is something more 
that users wiIl have to leam and remember. If a feature is there but doesn't work, it will make harder 
learning the tool. 
Location observed: 

Source->Highlitpht text 

92. 
SW 
Problem: The feature Source->Highlitghr rexr doesnt work anymore but it is still there. Users will try to 

~iolated~rinciple:  
Simple and natural dialogue 

VI. RELATED w m  THE TOOL BAR AND SHORTCUTS 

US: 
1 

Problern classiûcation: 
L, Unnecessary functionality 

Problem: In the Source window, the information at the top of the window looks Iike editable but is  noL 
The reslson for this box is that the information might be copied and pasted, however it's always better to 
use widgets for its intended purposes. Users who know how that widget works in other systems will try to 
use it in the way it works in other systems. 
Location observed: 

Problem classification: 
L, Possible misinterpretation 

93. 
SW 

US: 

US: 
2 

Violated principle: 
Speak users' language, 
Consistency -standards- 

Problem classification: 91. Violatcd pnnciple: 

US: 
1 

S W  

Problem: The tool is mouse dependent. It is not possible to navigate through the different interface 
elements with the keyboard. Some examples are: 
a) Certain important operations don't have a keyboard shortcut. For example, Global grep, opening a 

Source Code file, etc. 
b) The Tab key doesn't work consistently changing the focus in the interface. 
C) If is not possible to access the menus through the keyboard. 

Problem classification: 
E. Lack of functionality 

95. 
TS 

US: 
3 

96. 
TS 

Problem: The label Source in that window suggests that source code will be displayed in it. However, no 
source code is displayed in the case of selecting a variable in the Hierarchy window, therefore Source is not 
a very pood label for the window. 

L. Possible confusion Simple and natural dialogue 

Violated principle: 
Shortcuts. Simple and natural dialogue 

Problem: Some different features in different menus have the same keyboard shoncut. The sarne shortcut 
works different depending on the context established by the current focus of the mouse. Users will have to 
leam that and always remember the current context in order to use the shortcuts. This presents extra effort 
to users and is also prone to mistakes. 
Location obsewed: 

Hierarchy-wFind in this list . . . 
Source->Search for text . . . 
Hierarchy->Go to line ... -related with the previous problem- 
Source->Go to line ... -related with the previous problem- 

1 

Violated principle: 
Minimize users' memory load, 
Error prevention 

Probkrn classirication: 
L, E, Possible confusion 



1 98. 1 Violated ~rincide: 1 Pmblem dassüjcation: 1 US: 1 
TS 1 Simple an> n a t h  dialogue 1 L. E. Possible rnisinterpretation 1 3  
Probfem: In the middle group of buttons, the icons of the first and thud buttons (left-to-right) suggest they 

US: 
2 

perfonn opposite action;. ~bwever ,  this is not slways m e .  In the case of worlong with routines they 
perform opposite operations but not in the case of files- In this last case, the third button doesni even work- 
Also, the help flag in the first button always informs that it works on files. 
Location observed: 

Problem: It is not cleu why the selection of the buttons presented in the Tool bar is adequate and enough. 
Certain important features doni have a bunon and some actions chat are not very important or fiequent have 
a button (e-g. creating a new history file might not be very frequent but it has a button). 

Problem d d c a t i o n :  
E, Non optimal functionality 

97. 
TS 

1 Tool bar, rniddle group 1 

Violated prindple: 
Simple and natural dialogue 4ess is more-, 
Shoncuts 

r 

( 101. 1 Violated principl& 1 Problem classification: 1 US: 1 
TS 1 Error prevention 1 E. Non optimal functionaiity I l  
Problem: The exit button is very close to the stop query button. Uses  could accidentally press it  when 

US: 
1 

US: 
3 

100. 
TS 

1 trying to stop the processinp of a query and then star< exit& from the tool. 1 

Problern: Tiiere is a little arrow in the upper-lefi corner of the help flags. It is most times hidden back and 
mixed with the mouse. It is not useful at al1 and might distract users a bit. 

Problem classification: 
L, Graphical design 

99. 
TS 

Problem: The icons for List $les matching panent, List routines matching pattern. Lisr identijkrs 
matching parrem are not very descriptive of the operations they perform. Users might not easily see how 
they work. 

Violated principle: 
Simple and natural dialogue -1ess is more- 

Violated principle: 
Simple and natural dialogue 
- p p h i c  desipn- 

Problem c l d a t i o n :  
L, Graphical design 

US: 
1 

102. 
TS 

103. 
TS 

Problem: The icon for stopping queries is very fat from the place wherc the queries are started. Users will 
have to make long mouse movements whenever they use it. This is not a serious problem but will render 
usersv performance. 

Violated principle: 
Simple and naturai dialogue 
- p p h i c  design- 

Problem: Contracting the History window affects the shape of the tool bar. Also, it is possible to resize the 
history window from the top or from the bottom, however one way would bc cnough. 

Violated principle: 
Simple and natural dialogue -1ess is more- 

Problem dassükation: 
E, Non optimal functionaiity 

Problem classification: 
E. Lack of robustness 

US: 
1 



-- - 

US: 104. 

~ - 

( -praphic design- 
- 

I I 
Problem: This dialog window presents several graphic design problems. Some of them are: 

US: 
2 

a) Many labels are redundant, badly phrased or can be interpreted in different ways. 
b) The spacing, alignment and symmetry of features are not consistent and aesthetically good. 
C) There is unnecessary space between the options and the buttons at the bottom. 

TS 
Violated principle: 

Problern: The icon for opening a Source Code file in an editor is very similar to the ont  for creating a new 
history file. However. both operations are cornpletely different- It wont be easy for users to learn the 
difference. 

Problem c lMnat ion:  
L, Graphical design 

105. 
T S  

US: 
1 

US: 
3 

107. 
PW 

Problem a) is more critical because usen can have problerns understanding the features of the tool. 
Problems b) and c) are not very serious but contribute to the good overall graphical design of the interface. 
Good graphical design is known to hetp usen at learning and using the interface more efficiently. 

Problem clrissification: 

Violated principle: 
Speak users' language, Simple and natunl 
dialopue -graphie design- 

Problem: The help flag of the icon for opening a Source Code file doesnt suggest which type of file will 
be opened (e.g. whether source code or history file). 
Location observed: 

Tool bar->Open current file in an editor. Help flag 

Problem classification: 
L, Bad labelinp; 

106. 
TS 

Problem: The icons for new, open and save history are on the right, however the corresponding operations 
in the main menu are on the left. This is not the way other systems implernent it. Users with experience in 
other systems will probably look for these buttons at the left under its menu option. 

Consistency -standards- 

Violated principle: 
Speak users' language 

Violated principle: 
Simple and natural dialogue 

Problem: Many features are not grouped properly. For example, (a) some group boxes contain just one 

Problem classification: 
L, Graphical design, Bad labeling 

- . -  

option, (b) it is no clear that certain groupings are the best possible, (c) certain related features are not 
groiiped together, etc. These are not serious probIerns but contribute to the good overall graphical design of 
the interface. 

L. Lack of consistency 

US: 
1 

108. 
PW 

1 

Violated principle: 
Simple and n a t d  dialogue 

109. 
PW 

Problem cldncation: 
L, Graphical design 

Problem: Under the General Preferences option, the label E;lner~l Developmenr took doesnt c l c x l ~  
suggest what it is for. what toob it refers CO, etc. 

Violated principle: 
Speak users' lanpuape 

Problem c l d ~ c a t i o n :  
L, Bad labeling 

US: 
2 



US: 
1 

Problem: The type of drop-down Iist currently used for selecting options (e.g fonts, sizes, etc.) is not the 
best widget that could be used. It might be better to use another like the one used in Microsoft word, for 
example. This is not a senous problem but contributes to the good oved l  graphical design of the interface. 

Roblem d d c a t i o n :  
L. Non optimal functionality 

110. 
PW 

US: 111. 

' 112. Violated priociple: Problem d d c a t i o n :  

Violated principle: 
Simple and naturd dialogue 
-graphie design- 

US: 

I dialog window. For example: 

GG 
Violated principle: 

US: 
1 

113. 
GG 

114. 
GG, v 

a) The pattern chat will be looked for is the most important aspect in the search, however ils edit box 
is presented at the bottom of the window, which doesnt suggest is the most important, 

b) The meaning of the options is not very to understand from reading the labels. 
C) The three sentences in the group box in the middle do not clearIy suggest a partition of the 

different possibilities. 
d) The Glob-style term is not a well-known tenn for all the users. 
e) The labeling in the group box at the bottorn is redundant. 

Problem classification: 

Problem: This window doesnt use the group boxes properly. The first group box has too many group 
boxes nested together. The group box at the bottom contains just one item. This is not a senous problem but 
contributes to ihe good overall graphical design of the interface. 

Problem: The radio buttons in the Global-grep featwe are not used according to the standards. This t y p c  of 
buttons is normally not used for representing exclusive or. This is not a serious problern but contributes to 
the good overall gnphicd design of the interface. 

Consistency -standards- 

GG 

Violated principle: 
Simple and natural dialogue 
-praphic design- 

Problem: The way that the GIobal grep feature works is not very easy to understand from the design of its 

Violated principle: 
Simple and naturai dialogue 

Problem: The dialog window displayed when executing this feature is opened very slowly and grows 
incrementally. This is not a serious problem but will distract the users. 

L, Non optimal functionality Simple and natural dialogue, Bug 

Problem classification: 
L. E, GnphicaI design 

L, E. Lack of consistency 

1 

Problem d;issification: 
L, E. Possible confusion 

1 

US: 
3 



Tasks used in the 
Thinking Aloud Usability Testing 

(final version) 

1. Suppose you are investigating about the signal tones that are given to peripheral devices. 
Right now you want to know more about the message that is sent to the Network Controller 
when the appk'y-fone-sig~l procedure is cailed, therefore: 

S tart Tksee. 

Load the database comsponding CO the SX-2000 system (sx.mr*n.qlO.opq.mfl. 

You want to keep the exploration that you are about to perform, therefore create a 
new history file and use your name as its name. 

Find the definition of the apply-tom-signal procedure. 

For each parameter, find its name and type. Also find out how that type is defined 
(e-g. byte, integer, record, pointer, etc.). Write down al1 that information. 

Looking at the implemn tation of apply-tom-signa 1 w k  for any information about 
the purpose of the tom-signal parameter. Write down whether you found anything or 
not, and give a due  where it is in case you foucd something. 

II. Now, in the SUMMARY information of that procedure it says that the tone-signal 
parameter specifies the tone signal thatll be given to the peripheral device. However 
imagine you want to find out if a tone signal given as argument to the procedure is the tone 
signal actually sent to the Network controller or if another tone signal might be sent 
instead, In order to investigate that: 

7. Search within the apply-tone-signal procedure to see if there is any place(s) where 
the tom-signal parameter is king reassigned. Wnte down how rnany places you 
found. 

8. Also, find d l  the functions/procedures called within the appij-tom-signal 
procedure. Write down how many routines you found. 

9. See if, in these calls, the value of the tom-signal parameter could be modified. Wnte 
whether or not the paqmeter could be modified. Give the narne of each 
procedure/fùnction that you found could modified it . 

10. Save your recent exploration (using the history file you created). 



m. From the previous steps, you found that within the apply-tonc-signal procedum the 
tonc_signal parameter could only be modified in the cal1 to musicicto-be-applied. Now 
suppose you want to investigate more about how this could happen: 

11. Remove any information displayed in the Hierarchy h d o w  that you consider 
unnecessary. 

12. Locate the implernentation of rnusic-to-kapp~M 

13. Look if there is any place@) where the tune-sigd paramter is k i n g  reassigned and 
write down al1 the possible reassigned values. 

14. Find the value(s) reassigned to the f o n ~ ~ s i g ~ f  parameter whenever the function 
music-to-be-appfied r e m s  with TRUE status. Write down the value(s). 

15. For that value, locate its definition and write down to what number it is quivalent. 

16. Go to the file where music-to-be-upplied is implemented and look for line 1915. 

17. What would be the effect in the SX-2000 system if you deleted that line ? (Hint: look 
at some of the previous if statements). Write down your answer. 

18. Looking at the implementation of musik-to-be-applied, find and read its 
SUMMARY information. 

N. From what you read in the SUMMARY you know that the function must'cCtoObeOapplied 
work when the user is put on hold. Now, imagine that you want to know if any problems 
have arisen when the music is set on hold. Therefore: 

19. Locate al1 possible problerns associated with rnusikictoObe-upplied and which are 
related to "music on hold". Write how many problems you found as well as the sms- 
number of the problems. 

10. Locate al1 possible problems associated with apply-tone-sigd and which are 
related to "music on hold". Write how many problems you found as well as the sms- 
number of the problems. 

2 1. Save your recent exploration (using the history file you created) and exit Tksee. 

V. Suppose you want to convert the apply-tone-signal procedure into a function. This would 
enable you to use its retum status. However before doing any change you want to know 
some of the impacts. Therefore: 

22. Start Tksee and open the history file of your previous exploration. 

23. Create a new list in the Hierarchy window containing the apply-tone-signal 
procedure. Here you wili continue with your exploration. 



VI. 

vu. 

vm. 

24. Locate the file(s) that would be rnodified if you converted the apply_lone-signa1 
procedure into a function. Write down the names of the file(s). 

25. Locate the file containing the implementation of upply-tom-sigrni and open it in the 
editor. 

26. Close the editor (dont make any changes to the file). 

You want to know more about some of the places where you could use a value retumed by 
apply-tom-signal, therefore: 

27. Find al1 the functions/procedures that cal1 apply-tom-sigd. Write down how many 
they are, 

You are just interested in the functions/procedures starting with "a", therefore: 

28. Remove any information displayed in the Hierarchy window that you consider 
unnecessary. 

29. Now, considering oniy the fÙnctions/procedures starting with "a", find ail the places 
where you could make use of a value returned by apply-tone-signal. Write down 
how many places you found. 

Suppose that in al1 places found in the previous step, you decided to use a variable to 
capture a value retumed by appiy-&ne-signal, therefore: 

30. Locate the files that would be modifiai by implementing this change. Write down the 
names of those files. 

3 1. Save your current ex~loration and exit Tksee. 



The Tool before the Thinking Aloud Usability Testing 
(including changes after the Heuristic Evaluation) 

After Change 1 Description 
1 

1 

Before 

2 

Change of label 
(solution to problem 33, 

Appendix 2) 

Change of label 
(solution to problem 33, 

Appendix 2) 

File- >New hisrory #les File- History File ... 

File- > Load history files File->Luad Hisrory File ... 





Change 

3 

Change 

4 

Description 

Feature removed 
(solution to problem 12, 

Appendix 2) 

Description 

Feat ure removed 
(solution to problem 26. 

Appendix 2) 

Before 

Hisrory -> 
Hide history window 

After 

None 

Before 

Hierarchy - > 
Load clara buse ... 

After 

None 



A fter 

None 

Before 

Sotrrce -> 
High fighr tex1 

Change 

5 

Description 

Feature removed 
(solution to problem 92. 

Appendix 2) 



-tory: 6 f U n  

--------,,,,-,----- 
0 List vars malching paiiern 'cali-record' 



Change 

6 

Description 

Feature added 
(solution to problem 49, 

Appendix 2) 

7 

After - 
Hierarchy wiitdo W. 

Befo re 

Feature added 
(solution to problem 49, 

Appendix 2) 

8 

Routine object, 
Middle mouse burron -> 

DeI;ned Variables 

Feature added 
(solution to problern 49, 

Appendix 2) 

Hierarchy window. 
Routine object, 
MiddIe mouse button -> 

DeJined Types 

Routine object, 
Middle mouse button -> 

Referred Types 

Change 

9 

After 
Hierarchy window. 
Variable objecr. 
Middle mouse button -> 

Ilem(s) Delining Me 

Description 1 Befo re 

Feature added 
(solution to problem 49. 

Appendix 2) 

None 



APPENDM 5 

Usability Problems found in the 
Thinking Aloud Usability Testing 

The following table shows the times during the sessions with the participants. 

The following notation is used in the first row of the tables: 

1. The first field indicates the problem number and its location within the interface according to 
the codes below. It  sometimes presents two capital letters that indicate the problem is related 
with other problems marked with the same letters (AA, for example). 

Participant Type 
J 

Novice 

OW: Overall in the Interface 
DW: about Didog Windows opened by interface features 
HW: related to the History Window 
HiW: related to the Hierarchy Window 
SW: related to the Source Window 
TS: related with the Tm1 bar and Shortcuts 
PW: related with the Preferences dialog Window 
GG: related with the Global Grep feature and its window 

Session time 

1 :55 

b 

Session 
No. 

1 

2. The second field indicates the type of participants that experienced the problem. 

Tasks time 

1:33 hr 

3. The third field indicates whether the problem was about Learning (letter "Lw), Eflciency of 
use (letter "E") or both. It also contains a short description of the problem. 

2 
3 
4 
5 
6 
7 
8 

057 hr 
1 :22 hr 
0:44 hr 
1 :32 hr 
0 5  1 hr 
1 :O2 hr 
0 5 6  hr 

1 : 12 hr + it min tutorid 1 Novice 
1 :48 hr + 17 min tutorid Novice 

Novices only 
Experts only 

Both 
TOTAL 

0 5 8  hr + 17 min tutorid 
1:48 hr + 17 min tutorid 

1 :O5 
1:15 
1 :20 

28 _ 
9 _ 

35 
72 

Novice 
Novice 
Expert 
Expert 
Expert I 

problems 
problems 
pmbfems 
problems 



PROBLEMS: 

OVE~ULL IN THE INTERFACE 

2. 1 Problem observed in: 1 Short description: 1 
01 1 l expert 1 L. The term & is not known by everybody 
Problem: Not al1 experts knew about opq, therefore not al1 understood well the niunes of the different 

Short description: 
E, Problems with nested routines 

1. 
0 1  

- - 

databases that could be Ioaded. I 

Problem: The tool didn't work very well with nested fÙnctionî/proced~~~~. 
- They were not displayed as imns in the Hieriuchy window. Therefore participants looking for one had to 

find the parent routine and scan into its code. 
- In the Source window, within the shadow area of a routine, there was no way to diflerentiate the code of 

a nested routine from the code of the parent routine. Therefore participants looking at the code of the 
parent routine were mislead by the code of the nested routine. They required some time to notice the 
nested routine. 

- One partici pan t commented: 'The roof doesn 't show information about nested routines, however there 
are many of them in the Company systern" 

Problcm observai in: 
2 experts 

EE 1 1 novice comrnented 1 
Problem: In their work users know about/iIes, procedurcs, funcaloms, wzdables and rypc, however: 
a) The tool uses the label routine to refer tofirmtions and procedures. 
b) The tool uses the label idenrifiers to refer to wriabIes and lypes. 
Because of this some participants didn't know exactly what those features were going to do. In general, 
participants tended to briefly scan the labels in the interfice and match them with their concepts. Just after 
several unsuccessful tries, participants more carefblly rcad and tricd to understand the labels. 

Short description: 
E, Problems with Go to line ... features 

3. 
0 1  
Problem: There were several observations with the Go to line ... feanires. First of all, the tool didn't 
indicate line numbers, therefore, it was very hard to find the number of a specific line. Normally, when a 
user wants to go to a certain line nurnber is because he knows that in such line there is something he is 
looking for. During the testing participants didn't use line nurnbers as a way to locate information. Experts 
hadn't even noticed the existence of Go to Iine ... features. In one task they were asked to go to a certain line 
number in the Source window. Most were able to do it because they found the feature during the session. 
However, it seemed that in general they had not used the feature: 
- Because the dificulty of seeing the number of a specific line and use it later to locate such line. 
- Because they are very used to use Iine nurnbers as a way to locate information. 

Problem observed in: 
2 novices, 3 experts 

Short description: 
L, Tool labels not according to users concepts 

4. 
O1 

Problcm obwrved in: 
several users, 



I 1 it is creatad 
Problem: Whenever participants created a history file, the tool asked to name it. However, this was 

5. 
O1 

unnecessary work: 
- The name of the file would be asked when saving anyway. 
- When prompted to give a narne, participants tended to use the name suggested by the tool. It was 

dear  that they didn't want to name the file at that moment. 

Problem observtâ in: Short description: 
1 novice E, Name of the cunent hbroryfile is not aIways seen or 

Probkm obscrved in: 
1 novice 

1 1 understood 
Problem: Participants were asked to create a history file and name it using theù names. Also, they were 

Short description: 
E, Usets are unnccessarily asked to narne a history file when 

asked to Save thë exploration on such history file several times during the session. One partkipant 
incorrectly entered the name of  the file in the Path narne field and saved the exploration. He never realized 
that the exploration had being saved with the defarlf name and not with his narne. Later, he was asked to 
start the tool again and load his history file. The defmlt history file was loaded automatically and he saw 
his exploration on the windows. Again, he never realized that the exploration was narned with the defiulr 
name and not with his name. Al1 the time a label indicating the name of the history file containing that 
exploration (e.g. defm11) had been displayed at the top of the History window. Therefore, he either didn't 
see the label or never understood it. 

8. 1 Problem obstrved in: I Short description: 
O1 2 novices L, The label h i r f o ~ ~  is dispiayed in several places in the tool 

7. 
O1 

1 1 and confiises users 
Problem: The options for the HLFiaryjHe reside within the File menu. However, there is another menu 
called History that misled particip&ti. Participants were asked to create a new hisroryjile and some 
decided to open the History menu and look in it for an option to create a hirtot-yfile. Specially when 
learning, participants noticed different places with the label History and they didn't understand the 
differences very easily. 

Problem: When users load a database they have the option of  confinuing with the same hisfory Ne. 
However, one participant following that option didn't understand if al1 previous information in the 
exploration would be kept or overwritten. In a similar way, if a user starts the tool for the first tirne, what 
would be the meaning of the "samve" history file ? 

Problem observed in: 
1 novice noticed that 

Short description: 
E, What's the meaning of loading a database and continue 
with the same history file ? 

9. 
O1 
Problem: One participant when saving his exploration entcred a name in the dialog window and prcssed 
the button for saving. Then. al1 the information in the tool was blanked for one second and came back 
again. Because it had been fast. it didn't confuse the participant a lot but he noticed this strange behavior. 

Problem obscrved in: 
1 expert 

Short description: 
E, Strangc behavior of  the tool when saving exploraîion 



IO. 1 Problem observed in: 1 Short description: 
O1 1 2 novices 1 E, Problems copying and pasting 
FF 1 1 
Problem: There were several problerns observed when participants tried to copy and paste. The facilities to 
do that were irnplemented by the operating system and not by the tool, therefore: 
a) Not al1 participants knew how to use them. 
b) Certain dialog windows didn't allow participants to copy fiom the tool and paste in their fields. For 

example: 
- A participant clicked on List ldentijers Matching Pattern. .. and couldn't copy fiom the Source 

window to the input field of the dialog window. - A participant highlighted something in Source window, clicked on List Identrpers Matching 
Pattern.. and üied to use the copy-parte keys of the keyboard. This didn't work 

11. 
O1 

. 

CC 1 1 window and Source window is not always obvious 
Problem: Much of the power of the tool resides in combining functionality between the Source and 

Problem: Some dialog windows partially and inefiïciently blocked the tool while they were opened. While 
the dialog window were opened participants could still select certain things in the main window, however 
no refreshment of information was done in the Source window as it is normally done when there was no 
diaiog window. Many participants tried to continue working while a dialog window was open, but they 
were confused when certain things worked and others didn't. It wasn't obvious for them that closing the 
dialog window would unblock the tool. In summary, some dialog windows that were supposed to block 
didn't block eveming,  and others supposed to allow working while open didn't filly allow it. 
Situations observed: 
- The participant left the Search For T a t  ... window open and clicked on a different routine in the 

Hierarchy window. The code of the selected routine was not refieshed in the Source window. Then, he 
closed the Search For Text ... window and the rekhment  was automatically done. - The participant left the Search For T a t  ... window open and clicked on a different routine in the 
Hierarchy window. The routine was selected but its code was not refreshed in the Source window. The 
participant didn't understand why. Then, with the focus in the routine that he selected he went to a 
different history state. Later, he came back to the previous history state and this time the Source 
window was refreshed with the code of the routine that had the focus when he leR He didn't notice the 
refieshrnent and he used Search For Text ... to fmd matches in that code. 

Problem observed in: 
3 novices, 3 experts 

Hierarchy windows. ~ o k e v e r ,  for some novices it wasn't obvichs how to combine that huictionality in 
order to solve a task. For example, it wasn't obvious for them that if something was highlighted in the 
Source window and Information About Sefected Item was used, then the information would appear in the 
Hierarchy window. Also, it was not obvious that they would have to click on the new object in the 
Hierarchy window so that the information was displayed in the Source window. This seemed to be obvious 
once they knew it but they rcquired tirne to understand it. 

S hart description: 
E, Some dialog windows inefficiently block the tool 

Short description: 
E, Does loadinp: a history file loads the correct daîabase ? 

12. 
O1 

Short description: 
L, How to combine the functionality of the Hierarchy 

13. 
O1 

Problern: This was not an problem but something a participant asked, when loading a history file is the 
corresponding database loaded as well ? 

Problem observed in: 
1 novice comrnented that 

Problem observed in: 
2 novices 



1 O1 1 1 novice 1 L, ~e la t ionsh i~  between main menus and windows not 
1 1 noticed 

Problem: Participants not always noticed a relationship betwecn main menus and windows. 
Situation observcd: 
- The participant selected a file in the Hierarchy window, he was trying to open it in the editor. He 

looked in the pop-up menu of the Hierarchy window and didn't find anything for that, then he went to 
the main menu and in the Source menu r d  Open File in mitor. .., then he clicked on it and worked. 
He thought the file had k e n  open because of having selected it in the Hierarchy window and not 
because its source code was in the Source window. 

1 14. 1 Problem obscrved in: 1 Short description: 

times, such as: 
a) When different things were selected in different windows at the same time. 
b) When several things were selected at the same time in the same window. 
Situation observcd: 
- In the Source window, two colors were used to show w ~ ~ f ~ a ~ d w  places or things: 

1) The gray color for the shadow area 
2) The blue color for selections done with the m o u e  

Therefore some participants tried to use Information Aborri Selected Item, but they were not sure 
whether the feaîure would display information about the shadow area or the selections with the mouse. 

15. 

Problem observcd in: I Short description: 1 l novice, I expert L, E, Problems with regular expressions 

1 0 1  2 novices L, Some features have the label selected and mislead users 
Problem: Some features had labels refemng to selected things. Participants were misled by that severai 

Problem observed in: 

16. 
0 1  

HH 1 1 
Problem : Participants experienced di fferent types of problerns in features raquiring regular expressions: 

Short description: 

- - - As mentioncd above, participants not alwais noticed when feabres were cxpccting regular 
expressions. Sometimes they used other types of patterns that produced different results as the ones 
they were expecting. Most times they didn't realize why the results were not as expected. Therefore, 
they simply made another search by looking for a different pattern or decided to use another feature 
instead. - Few participants were fùlly familiar with regular expressions. Even when they noticed that the feature 
was expecting a regular expression, they not always knew how to build a rcgular expression to look for 
what they wanted. Some made some tries with differcnt rcgular expressions, others decided to look for 
another pattern and others to use another feature instead. 

In conclusion, participants couldn't always fd ly  exploit those featurcs and they wasted energy and tirne. 

Problem: Many dialog windows had titles and messages below the tittle bar. These messages and titles 
were scanned and rarely read in detail. For example, when reading "Enter regulm expression? participants 
noticed they had to enter something but they rarely realized that the system expected a regular expression. 
At first, participants just scanned the messages and entered sornething. Just after several unsuccessful tries, 
participants more carefiilly read and tried to understand what the labels said. 

Problem observed in: 
5 novices, 3 experts 
(al1 users) 

Short description: 
L, Long in dialog windows not always read in detail and lead 
to ineficient performance 



O1 1 several users 1 L, E, Poor feedback whiie processinp; 
Problcm: In some situations when the processing took long, participants didn't know if the system was still 
processing or something had happened. The t&l didn't f ivide feedback or it had not k e n  noticcd by 
participants. In both cases, participants looked at the clock mouse and sometimes the messages at the 
bottom. They sometimes got desperate and started clicking in other places. 
Situations observd: - When a variable was selected in the Hierafchy window the information fiam showid sometimes took 

long to appear in the Source window. 

1 - ~ h e n  using the TREE fcahlres for routines that cal1 or are called. 

II 1 I 
Problem: The feedback given by certain features when actions had finished was not easy to notice. 
Participants clicked on those features waited for something to happen. The features finished and displayed 
gave some feedback, however participants didn't notice it and kept waiting for some time. 
Situation observed: - After a database was loaded 

19. 
O1 

1 18. 1 Pmblem obsrved in: 1 Short description: 

i 

Problcm observed in: I Short description: 
HiW 3 novices, 2 experts 
20. 1 

L, E, Poor feedback when there are no results 

Problem obstrved in: 
several users 

n 1 I 
Problem: Sometimes participants didn't notice when actions had finished with empty resub. When 
participants didn't notice any change in the interface they scrolled the windows to identifj. any changes in 
the information. Some executed the action again several times to convince themselves that there had not 
been any results. Participants developed the concept of not tnisting the feedback given by the tool. 

Short description: 
L, E, Bad feedback afler actions finish 

21. 
O1 

M 1 I 
Problem: Many parricipants had an operating system terminal opened when they were using the tool. They 
noticed ali debugging messages sent to the terminal. Many times the messages said things like not found, 
etc. Participants tended to think that these messages were created by the actions they were doing and 
therefore there were problems. However, basically none of these messages was concerned with the tool but 
affected participants' attention. 

22. 
O1 

Problem: The tool didn't autornatically run on the background. Many participants started the tool fiom an 
operating system terminal and most typed an "di " in order to free the terminal. One participant commented 
that it was probably better to implement that the tool automatically mn in the background. 

Problem observed in: 
several users, 
1 expert commented that 

Short description: 
E, The tool doesn't run in the background by default 

Problem observed in: 
1 novice, 3 experts 

Short description: 
E, Messages in the terminal distract and mislead users 



Problcm observed in: I Sbort description: 
0 1  I 3 novices, 1 expert E, T c m  enor messages confiase the users 
AA 1 1 
Problem: Sometimes Tcüïk generated cnor messages that were displayed on the screen. These messages 
affected participants' attention. Participants not always understood what the messages meant and confiid 
some participants. It would be better to instruct TcVik to scnd this messages to a h g  file and don't prtscnt 
them to the users. 

1 24. 1 Problern observed in: 1 Short description: 1 
0 1  1 3 novices. 2 experts 1 E, Tksee d&nnt have undo facilities 
Problem: Participants tried to undo actions they did, especially after erroneous actions. However, the tool 
did not provide such facilities. Common situatio& were: 

- Trying to undo delete actions on the Hierarchy window 
- Trying to undo certain queries 

1 an exploration 
Problem: When saving an exploration, the tool required participants to specifj. a name for the history file. 

Short description: 
E, Many windows are displayed when loading a database 

25. 
O1 

Problem observcd in: 
several users 

1 However, such file already had a name. It had been required when the file was created. I 

Problem: When loading a database, participants had to deal with many windows. There was a window for 
selecting the database, another one waming about creating or not a new history, and finally another for 
giving the narne of the history file. This problem was due to the tool design requiring to specifL the name of 
a history file at the moment it was created. 

Problem obscrvcd in: 
2 novices 

Short description: 
E, Users unnecessarily have to speciQ filename when saving 1 

Short description: 
E, Problems at exit 

27. 
O1 

28. 
0 1  
BB 

Problem: There were two different situations when patticipants exit fiom the tool: - When using the €rit feature participants were always prompted to Save the exploration. However, there 
were times when there was nothing to save. That meant participants wasted time and didn't like having 
to deal with the dialog window for saving. 

- Other participants exit by using the Quit feature fiom the X-windows manager. In this case they were 
not asked to save before exiting even when there were new things that the participant probably wanted 
to save. 

Probltm observeâ in: 
3 novices, 1 expert 

Problem: Discovering al1 the possible pop-up menus in the tool interface was very hard. Participants 
learning the tool didn't discover certain menus in some windows, particularly those provided by the middlc 
mouse button. Novices required long tirne before discovering these menus and experts had problems 
remernbering them. Not discovering those menus meant that participants didn't use the features in thcm and 
therefore many tasks were completed in very inefficient ways. It's important to mention that in al1 the 
sessions none of the participants discovered and used the most powerfiil features, even experts who had 
used the tool before achieved some tasks in very efficient ways (nobody efficiently used the Autogrep and 
Grep features, for example). 

Probltm obscrved in: 
3 novices, 1 expert 

A 

Short description: 
L, Discoverhg al1 the possible popup menus is very hard 
and not always done 



Problem observcd in: I Short description: 
3 novices, 1 expert E, Mouse buttons necd to remain pressed so that popup 

I 1 menus stay 
Problem: Participants required time for looking and explorhg the different features in the popup menus. 
Many times they accidentally released the mouse button whilc obscrving a menu, thus disappcaring the 
menu. Keeping the mouse button pressed for a long time was hard for participants. Also, keeping it pressed 
and moving the mouse in order to select something was very hard as wcll, 

30. 
0 1  

source files. Many participants easily noticed that the problems displayed by the tool were not al1 the 
problems in the source code and concluded that the feature provided incomplete results. They also 
wmmented that: 
- Not al1 the problems were always written in the source files. People sometimes didn't write some. - Not a11 the problems written followed the standards. For exarnple, some people didn't put "." between 

t V  p It and the problem number. Some people used "p" (lowercase) and othen "P" (uppercase) 
Therefore, whenever participants wanted to see the problems they ended up scanning the code manually in 
the Source window and not using the feature. However, they were never absolutely sure if they had found 
al1 the problerns. The same happened with activities. 

31. 
0 1  

Problem: The numbers at the right in the keyboard didn't work. Some participants tried to use them when 
looking for a line number. 

Probfem obsencd in: 
1 novice 

Short description: 
E. Right numbers in the keyboard don? work 

Pro blem : The features that displayed sms-problems showed only the problems properly written in the 

Problem obscned in: 
3 novices, 1 expert 

32. 
DW 

Short description: 
E, Mismatch between problems reported by feature and the 
ones written in the source code 

Problem: Some dialog windows disappeared behind the main window of the tool and led to problems. 
Some participants clicked on the tool out of the area of an open dialog window and that made the dialog 
window disappeared behind the main window. Thus, participants had to bring it up again. During the 
sessions it was never a big problem because part of the dialog window remained visible- Howevcr, in 
general the dialog windows could have completely disappeared causing other problems to the participants. 
Location observed: 
- This happened with the dialog window fiom the Search For Tmt ..- feature. In particular this window 

was very fiequently moved because it many times hid the matches found. Fortunately, users didn't tend 
to move the window completely out of the area of the main window of the tool and thus didn't 
disappear completely. 

Problcm observcd in: 
1 novice 

Short description: 
E, Dialog windows can disappear behind the tool 



1 D W 1 2 novices, 2 experts 1 E, SometirnG dialog windows take too long to disappau 
II 1 I 
Problem: Sometimes dialog windows t w k  very Iong to disappear once the participant had clicked on the 
button for the action. Some problems with that were: - Participants noticed that the window didn't disappear and they thought they hadn't clicked on the 

button, so they decided to click again. Sometimes this generated a TcVTk error message that confiisad 
the participants. They weren't sure if the action had been taken or not. 

Situation observcd: - The participant was q i n g  to load a history file, in the dialog window of the h d  History File ... he 
double-clicked in one of the history files in the list. Because the window stays there, he clicked on the 
loading button again and got a message saying: "do you want to save your currenf explorationl he 
didn't understand and was very confùsed. What happened was that when he double-clicked on the 
filename, the tool started opening the file, and when he clicked the button again, the tool ïnterpreted 
that he wanted to open another history file. therefore it promptcd the usa for saviag the previous one. 
The user never understood what happened. Once he saw his exploration on the screen he decided to 

problems with it: 
- Such field was the first thing presented from top-bottom in the window. Participants rapidly scanned 

the fieIds in that order and paid better attention to the first things they saw. Therefore when some 
wanted to enter the name of a file, they used the fist field the saw, thus using the Path name field 
instead of the File nome field. Just a few times they realized that they had entered the name in an 
incorrect field. Participants never tried to change to another directory location. 

- Participants were not used to have an extra field for entering just a path. 
- Participants always selected the files by clicking on them not by entering their names. 
A much better design would be if users could navigate through the directories by doubleclicking on a ".." 
displayed with the list of  files. 

34. 
DW 

Problem observed in: Short description: 
2 novices L, E, Path name field in dialog windows is useless 

Problem: Some dialog windows had an input field for entering a pathname location. There were several 

F F  1 1 
' Pmblem: Many dialog windows in the tool presented the moa recnit input in certain fields. Howevet such 

input was not highlighted, therefore: 
- Any time participants wanted to enter something new they had to c lan  the field manually. 
- Some participants didn't notice that the previous input was not highlighted and they simply pastcd 

something into the field. That pasted the string together with the old input. Participants got upset 
because they had to manually clean and enter the conect input. 

Sbort description: 
L, E, Clock mouse appears in unnecessary situations and 
misleads users 

35. 
DW 

rn 

Problem: When certain dialog windows were open, participants moved the rnouse out of the area of the 
window and it changed to a clock shape even though the tool was not processing anything. Some 
participants thought that the tool was doing something although in fact the tool was expecting input h m  
them. 
Locations observeci: 
- Global grep dialog window 

Probtem observed in: 
2 novices, 2 experts 

Short description: 
E, Input field is not presented highlighted 

36. 
DW 

Problemobservedin: 
3 novices, 3 experts 



III. RELATED WITH THE HISTORY WINDOW 

37. 
DW 
FF 
Problem: Participants frequently looked for previous pattern. However, the tool only presented the last 
pattern searched. Thus, participants had to always enter the input if it was not the most recent one. 
Sometimes they wanted to use the most recent pattern, but it would definitely have been very hclphil if the 
tool remembered others previous patterns as well. 

Problem obscrved in: 
several users 

A 

1 1 work 
Problem: In the History window the feature Delete Selected Sme didn't always work. One participant tried 

Sbort dcscripCion: 
E, lnput fields of searching features present just the last 
string searched 

Short description: 
L, E. Updote Selecred State feature is usefess 

38. 
HW 

1 to delete a history state A d  clicked on the feaure without success. 1 

Problem: In the History window, the feature Updure Selected Stare was not working anymore but it was 
still there and caused problems. For example: 
- One participant accidentally deteted everything in the Hierarchy window. He clicked on the 

corresponding history state to see if he could get back what he had. Because it didn't work, he clicked 
on Update Selected Sme to see if it solved the problem but nothing happened. This confiised the 
participant who didn't know that the feature was not working anymore. 

Problem observed in: 
lexpert 

Short description: 
L, E, Sometimes the Delete Selected Sme feature doesn't 

39. 
HW 

Problem observed in: 
1 expert 

Short description: 
L. E, Label in histoy states mislead users 

40. 
HW 
Problem: Sometimes participants went back to a previous history state afler a long period of  time (long 
time in terms of remembering in detail that particular state). They read the label of thai state and used it to 
decide if that history State could have the information they wanted. Once they clicked on it, users scanneâ 
the information in the displayed Hierarchy window and saw if that history state was in fact helpfiil. 
However, the tool had never updated the label of the history state according to deletions or changes done in 
the Hierarchy window. Thetefore, in certain situations participants were misled assuming that the 
information in that history state really contained what the label said. 
Situation observed: 
- An interesting case was when a participant deleted everything in the Hierarchy window. Everything he 

did afier that created a new history state, however the previous state remained empty and with its 
original label. He never understood what happened. 

Problem observed in: 
1 novice, 1 expert 

Short description: 
L, E, Things in the History window that look like history 
states but are not mislead users 

41. 
HW 

Problem: In the History window, some labels look like history states but they don't work like them. None 
of the participants knew or discovered that they were not real history states. This confused some 
participants. For example: 
- In most participants' explorations the first line presented was just a label, it was created when the 

exploration was started. One participant deteted chat line and noticed that there were no consequences 
at all. Therefore he thought that he had deleted a history state and never understood why nothing 
happened. 

Problern obscrved in: 
I novice, 1 expert 



IV. RELATED WITH THE H~ERARCHY WINDOW 

I 1 tool 
Problem: The pascal language in which the Company systems is written has certain built in pddves. 
The tool displayed some of these primitives in the Hierarchy window as if they were ordinary routines, 
however clicking on them displayed enor messages in the Source window. 
- Participants that didn't remember apridtive thought it was a real routine and didn't understand the 

error. - Participants that remembered thepdmmtive noticed that the tool was not handling it properly and thus 
developed the concept that the tool was not very reliable. 

Primitive obscrved: 
- Pascal primitive BIND 

L 

42. 
HiW 

Problem observed in: I Short description: 
5 novices. 2 experts L, Grep feature is very hard to discover and lm 

I 
Problem: The Grep feature was very hard to discovcr and leamed. The most important reasons were 
because it was inside of a middle mouse button menu and because participants thought it would work in a 
different way. Due to this, participants never exploited this feature and instead completed some tasks in 
very inefflcient ways using other features. 

Problcm obscrvcd in: 
3 experts 

Short description: 
L, The Aufogrep feature is extremely hard to discover and 
leani 

43. 
HiW 
CG 

Short description: 
E, Pascal built in primitives are not properly treated by the 

Problem: The Aurogrep feature was extremely hard to discover and leamed. There were several reasons: 
1 .  First, the feature was inside a middle rnouse button menu. Thus making it very diff~cult to 

discover. 
2. Third, its narne was a term unknown by the participants. 
3. Second, its operation was very cornplex. 

a) It had to be used involving two objects. 
b) Those objects had to be on a parent-child relationship. 
C) It had to be started having the child object selected and not the parent, 

Some interesting insights were: 
- Only one expert participant had seen the feature but he had never tried it. 
- One novice participant tried to use it. However, he managed to succeed in points 1, 2, 3a and 

3b (above), however he started the feature having the parent object selected instead of the child. Thus, 
the feature didn't work and he concluded that the feature was not for fmding occurrences of one object 
within another. 

Due to this, participants could never exploit the power of thai feature, which was one of the most powerful 
ones. This meant that they perforrned many steps for solving tasks about finding occurrences of one object 
within another. They either manually scanned to look for chose occurrences or used the Searchfor fexf 
feature. 

Pmblem observcd in: 
5 novices, 3 experts 
(allusers) 



45. 
, HiW 
HH 

h 

Problem: In the Hierarchy window, some participants tried to use the Grep feature in the same way it 
worked in other systems. For example, sorne tried to use a pipeline to filter results. However, the feature 
not always accepted what participants entered. 
Situations obscrvcd: - A participant trying to find ail assignments in a routine entered: ( t l r i n p  1 .-= 

Problem obscrved in: 
1 novice 

47. 
HiW 

Short description: 
L, Grep does not work as users expect 

Short description: 
L, Find In This La... doesn't scroll and therefore 
participants not alwavs see the results 

46. 
HiW 

1 48. Problem observed in: Short description: 

1 1 very good 
Problem: In the Hierarchy window, deteting many items normally took very long and the feedback was not 
very fast. Therefore, users required much time and effort to notice that the deletion had indeed worked but 
it had been sIow. 

ProbIem: In the Hierarchy window, sometimes the Find In This Likt ... feature didn't scroll to the point 
where the results haâ been leR Participants didn't see any changes on the interface and were uncertain if 
there had been any results. Some scrolled in order to look for them. 

' Problem observcd in: 
2 novices 

Problem: In the Hierarchy window, the Find Zn This List ... feature highlighted the results but it didn't 
refiesh the information in the Source window. This is the normal tool behavior for other features in the 
tool. This caused some problems to participants, for example: 
- The feature found one match and highlighted it in the Hierarchy window. However, the participant 

never noticed that information in the Source window remained the same than before executing the 
search. He thought that information was about the object highlighted in the Hierarchy window. 
Although in this case there were not serious problems with that this misled the participant. 

Problem observcd in: 
1 novices 

' HiW 

49. 
HiW 

Short description: 
E, Find ln This List ... selects results but laves unchanged 
the Source window 

Problem: In the Hierarchy window, the results fiom certain actions were appended at the end of the 
sub-list where the action had been started, however the window was not scrolled to the location of the 
results. Many times there were many objects in the window and the results were not immediately visible to 
the participants, therefore they had to scroll and look for the results. However, they not always dixovered 
the results, especially when there were many objects in the window. They got upset because of the extra 

' work and time to look for the results. 

4 novices. 1 expert 

Problcm observcd in: 
4 novices, 3 experts 

L, E, Results appended at the end of the sub-list and window 
is not scrolled 

Short description: 
L. E, Deleting many items takes long and the feedback is not 



50. 
HiW 

JJ 1 1 
Problem: In the Hierarchy window, the concept of sub-list was very hard to understand. Participants didn't 
see a sub-list as the group of objecîs below in a hierarchy level of another objcçt lnstead they saw a sub-list 
sirnpIy as a subset of consecutive objects. Thus, sometimes they used the Delefe sublkt feature when there 
were no objects below in the hierarchy level. They didn't get any results but never understood why. 

Problem: The difference between k i n g  highlighted and having the focus was not always noticed. In the 
Hierarchy window, one participant pressed the delete key on one item but it was not rcmoved. The item 
was highlighted but didn't have the focus. Thus, participant presscd the delete key several times and didn't 
understand why it was not k i n g  deleted. 

Problem observai in: 
1 novice, 1 expert 

Short description: 
L, Delete Sublisr f w r e  is misinterpreted 

51. 
HiW 

Short description: 
E, k i n g  highlighted is not the same as having the focus and 
that confises users 

Problem observed in: 
3 novices, 1 expert 

52. 
HiW 
JJ 

53. 
HiW 

Problem: One participant was trying to search for something inside the code of some routines. In the 
Hierarchy window, he selected a group of routines and used the feature Find In This LiSt ... He thought that 
such feature was going to look inside of the selected objects. However, that îùnctionality was implemcnted 
by the Grep feature and not by the feature he used. Like in the previous problem, participants tended to see 
a list as anything selected consecutively and as not the whole set of objects in the Hierarchy window. 

Problem obscncd in: 
1 novice 

Short description: 
L, FinàIn This Lisr ... feature was misinterpreted 

Problem: In the Hierarchy window, participants tended to see a relationship "contains-contained" when an 
object was child of another. This led them to draw incorrect conclusions. For example: 
- Some thought that if a child appeared once below the parent was because it was containcd just once 

within the parent. - Some thought that selecting a child would display the parent in the Source window with the child 
highlighted in it. 

This was an interesting result that gave some clues about how users interpreted the relationship child-parent 
in the Hierarchy window. In summary, the relation was many times seen as "contains-contained" instead of 
"before-after" in time. This problem mainly affected to participants leaming the tool. 
Some particular situations obstncd: 
- This happened with a routine and the routines that it cailed. If a routine t h  w m  called appeared once 

below the one that called it, participants thought it was because it was called only once. 
- This happened when starting with a routine defmition, participants clicked on File defining me. Some 

participants thought that if they selected the file defining the routine, the tool would display the file in 
the Source window at the point where the routine was defmed in i~ 

Problem observed in: 
2 novices 

Short description: 
L, The meaning of the relationship between child and parent 
in the Hierarchy window is dificult to understand 



54. 
HiW 

55. 
HiW 

Problem: Participants were never sure about the meaning of the message about items at the bottom-left: 
- Some guessed the correct meaning (the number of items multing fmm a query). - Others thought it was the total number of items in the Hierarchy window. 

Problem obsened in: 
3 novices, 3 experts 

56. 
HiW 

i - Some participants selected an object X and the tool showed object X within a shadow area in the 
Source window. He went to the Source window and scrolled beyond the shadow ares Then, he went 
back to the Hierarchy window and selected another object Y. Later, he selected object X again in the 
Hierarchy window, the Source window was presented in the point where he had scrolled and lefi it. 
However, participants tended to think that selecting object X in the Hierarchy window would always 
bring object X within the shadow m a  in the Source window. 

Sorne problems here were: 
- Participants got confiised because they didn't know why object X was not presented 
- When they selected object X again, many did not remember îhat they had scrolled 
In both cases, participants had to find object X in the Source window rnanually. Some scrolled and others 
used the Search-for text ... feature (falling into al1 the problems associated with both methods). 

Short description: 
L, E, Message about items at the bottom-left is not seen, 
remernbered or weH understood 

Problem: In the Hierarchy window, just before certain actions finished a message "done" appeared at the 
bottom. The message was presented before the results of the action. Sometimes the results appeared much 
after. Some participants noticed the message dune and thought that the result had k e n  empty, suddenly the 
results appeared. 
Situations observed: 
- When the TREE features were going to finish the message "dune" appeared, then suddenly a bunch of 

information appeared. 

Problem observed in: 
several users, 
1 novice commented that 

1 57. 
HiW 
KK 

58. 1 Problem obscrvtd in: 1 Short description: 

Short description: 
E, LabeI done displayed before results appear 

Problem: In the Hierarchy window, there were several problems when certain queries were finishing: 
- The messages at the bottom (e.g. number of items & done) were updated but the mouse still looked 

like a clock for sorne seconds. Participants were contiised a bit when they looked the messages and 
noticed the mouse still looked Iike a clock. 

1 

Probiem obsemed in: 
several users, 
1 novice comrnented îhat 

HiW 1 3 novices, I expert 1 E, ~ornetimff the Source window is not r e k h e d  
Problem: in the Hierarchy window, when participants clicked on sornething there were two strange 

Short description: 
L, E, Messages a! the bottom and mouse shaped is not 
updated at the same time and that misleads users 

Problem: In the Hierarchy window, the following was observed with certain objects: 

Probiem obscrved in: 
3 novices, 2 experts 

behaviors: - Participants clicked on an object but the Source window rernained blank. It happened many times after 
deleting objects in the Hierarchy window. Selecting another history state and going back to the first 
one made the Source window worked again. - Participants clicked on an object and nothing happened. Not even the mouse was changed to a dock 

Short description: 
L, Clicking on something in Hierarchy w indow doesn't 
atways present what users expect in the Source window 



59. 1 Problcm obscrved in: 1 Short description: 

Many times the tool displayed different objects looking the same, therefore: - Novices tended to think that it was the same object but repeated several times. Just after selecting 
each one of them several times, some participants realized they wcre in fact differcnt. - Experts knew they were different but had to spend time finding the one were looking for. 

HiW 
DD 

Some examples of this were with: 
The definition & implementation of a routine. One expert participant had the idea that the 
implementation was always below the definition, which was not always true. 
Different routines with the sarne name (for example, the message routine). 
Variables and types. 

In al1 cases participants had to select the objects and look at the information in the Source window. 
This problem suggested that: 

- The messages at the bottom-left in the Source window were not usually seen or understood. 
- The shadow area was not always enough to suggest differences between routine definirion and 

imp fementation. 

Problem: In the Hierarchy Window: 

5 novices, 3 experts 
(al1 users) 

Other times, the tool also displayed the same object repeated in the sarne sub-list at the sarne hierarchy 
level several times. This happened when the object was the result of different queries. The tool did not 
keep track of the existing objects in a particular moment in the hierarchy and displayed repeated 
information. 

L, E, Objects can look the same in Hierarchy window and 
that presents pmblerns to the users 

menus, for example: 
a) Some participants were used to a mouse with two buttons, thetefore: 

- They didn't know îhat the middle button was equivalent to pressing both buttons simultaneously. 
- They were not very good at pressing both buttons simultaneously and manipulate the mouse. 

b) Participants had difficulties remembering the features in these menus: 
- What button had to be pressed in other to bring the correct menu - What menu contained the desired feature 

Participants brought incorrect menus many times. They found features by trial and enor, thus resulting in 
very inefficient performance. 

60. 
HiW 
BB 

Problem observcd in: I Short dcscriptioa: 
most sessions E, Lawiching editor takes long and there is no feedback 1 

1 1 meanwhile 
Problem: Sometimes launching the editor took a long time and there was no feedback meantime. 

Problem: In the Hierarchy Window, participants had many problems with the middle mouse button pop-up 

Problem observed in: 
3 novices, 1 expert 

1 Participants lost the focus on the dialogue By the time it appucd m e  were almost starting it again. I 

Short description: 
L, E, Problems with the rniddle mouse button pop-up menus 



Short descripîion: 
El Comipted information from smr is displayed comipted in 
the tool 

62. 
S W 

KK 1 1 difficult 
Problem: In the Source window, participants had problems to locate the shadow area or routines, for 
example: 
a) Sometimes they lost the shadow area of a routine and the tool didn't provide any clue about where 

within the Source window it was (top, center, bottom). Consequently, participants had to scroll and 
manually look for the routine. Some decided to scan the code and others to use the Seorchfor tex! 
feature. Some participants suggested that the tool could: 
- Have some indication in the scroll bar so that it was possible to know where in the Source window 

a shadow area is. 
- Implement a feature for repositioning the Source window at the start of a s h d o w  area. 

6 )  Sorne participants had difficulties distinguishing the gray tone of the shadow areas fiom the rest o f  the 
window. 

Problem: The tool displays information from sms exactly as it is received. If it cornes compted then it is 
displayed compted as well. Participants didn't know if such information came cormpted h m  sms or it had 
been comipted in the tool. For example, information about a smr problem was displayed as an ASCII text 
without ends of  lines. 

Problem observed in: 
most sessions, 1 novice & 1 expert 
commented that 

Short description: 
E, Problems scrolling in the Source window 

63. 
S W 
KK 

63. 
SW 

Problem: In the Source window, scrolling required precise movements of the mouse and uiat was difflcult 
for participants, especially when the displayed information was very long. The most common problems 
were: 
- Positioning the mouse in !he arrows or in the scrolling-cursor. Many times participants accidentally 

positioned the m o u e  out of these items and clicked, thus scrolling the window not in the way they 
wanted. 

- Clickinç directly on the scroll bar moved the file in a range more than desired. 
- Clicking on the arrows scrolled too slowly and it was not v e v  efficient. 
- Sometimes the computer's reaction to scrolling was very fast and participants noticed just a big jump 

rather than several continuous and smooth jumps. 
Sorne of these problems led users to waste time and effort to position the window in the desired location. 
This problem happened many times when participants tried to locate shadow areas containing routines. 

Problem observed in: 
5 novices, 3 experts 
(al1 users) 

CC 1 1 are not obvious to notice 
Problem: In the Source window, the feature Information About Selected Item displayed its results in the 
Hierarchy window. Participants not always noticed that and therefore didn't flnd the results. This 
particularly happened when the results didn't appear because they had been appended at the bottom of  some 
objects in the Hierarchy window. 

Problem observed in: 
5 novices, 2 experts 

Short description: 
El Finding the shadow area in the Source window can be 

Short description: 
L, El Results fiom Information A bout Selected Item feature 

65. 
SW 

Problem observed in: 
several users 



Pmblem observed in: I Short description: 
2 novices, 2 experts L, E, Information About Sefected Item displays al1 objects 

1 with the same name as the one selected 
Problcm: In the Source window, highlighting an object and clicking on Infirmation About Selected Item 
dispiayed al1 objects with the same narne thatexisted in the database. ~ar t ic i~ants  had to click in al1 those 
objects in order to see which was the one they had highlighted in the Source window. In other words, the 
feature was not context sensitive and meant that participants had to work more when there were several 
objects with the same name. For example, one participant highlighted a parameter type and ciicked on the 
feature, he got five matches with the same narne. One of those was the parameter type and the other four 
were routines that by coincidence had the same name. In this case, there was a difference in color among 
the objects (green and red) and that helped him to find which was the parameter type. This problem was 
more critical with other types of objects like routines, files, etc. where they were not displayed in different 
colors. 

Problem obsened in: I Short description: 
5 novices, 3 experts E, Lack of robustness of the Seorchfor text ... feature 

1 (al1 users) 1 
Problem: In the Source window, the Search for texr ... was one of the most used features. Participants 
heavily relied on this feature, however it presented many problerns: 

It didn't allow searching backwards. 
It just worked downwads fiom the point where the f w r e  was started. 
Sometimes under the same conditions, it didn't find anything on the first try but found matches on a 
second try. For example: - Novices were very confrrsed because the feature sometimes found matches and others did not. 
- Some expert participants knew that the feature sometimes found objects and others did not. But 

they got upset for having to scroll to the top of the file or shadow area in order to find al1 possible 
matches. For example, some participants went to a certain point in the Source window and 
selected something so that the search began fiom there. 

Sometimes participants were seeing the string they were going to search on the screen but when they 
used the feature, it said that there were no matches. This made the feature very unreliable and difficult 
to leam. Participants commented that in real tasks, they needed to find al1 existing occurrences of 
something and it was necessary to be very sure about that. 
Some participants looked for a keyboard shortcut in order to keep searching for the next occurrences. 
However, the tool didn't provide a shortcut for looking the next occurrence of the same string. 
The button for finding remained pressed during al1 the time of some searches and that confused some 
participants. 
The feature scanned for rcgular expressions and therefore it considered as a match anything containing 
the searched string. This was not always what participants wanted. 
When the last match was found and the dialog window was closed, the Source window was lefi 
scrolIed in the place of  the last match. However, sometimes that last match was not of interest to the 
participant, therefore he had to scroll up the window again. In the case of  displaying routines, the 
window was left many times outside of the shadowed area. 
The following situation observed with several participants: 
- The participant was positioned at beginning of a shadow area in the Source window. He used 

Search for text ... and that sent him to the fint match, which happened to be out of the shadow 
area, however the second match fell inside of the shadow area 

From these situation: 
Participants thought: How is that i / l  was just right ut the beginning of the shadow area, the 
f isr  match is out of if and the secondfaffs within ? 
When looking at the routine, participants were not always conscious that when a match was 
out of the shadow area, it didn't belong to the routine they were exploring. Some thought it 
was and made incorrect conclusions. 
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VI. RELATED WITH THE Tom BAR AND SHORTCUTS 

Short description: 
E, The dialog window of the h r c h  for Tex! ... feature hides 
matches found 

68. 
S W 

1 1 the middle mouse button menus 
Problem: Certain buttons in the Tool bar had thcir wmsponding features in the middle mouse button 

Problem: In the Source window, the dialog window of Seorch for Texî ... many times hid the matches 
found. This was one of the most frequent problems. Almost any time that the fature was used participants 
had to move the window to some other place. 

Problcm obscrvcd in: 
4 novices, 3 experts 

69. 
TS 

I menus. Some participants looked for those features in a menu (probably to confirm before Q i n g  hem) but 
they rarely found them. It took a long time before some novices discovered where they were. 

Problem obscrved in: Short description: 
several users L, The features of some buttons in the tool bar are hidden in 

a) Sometimes participants wanted to stop a query but didn't find how to do it. Nobody noticed the Stop 
button. Many novices ran into problems and wanted to stop a quexy. Experts tended to do things where 
the processing was fast, they were never observed wanting to stop a query. An observed situation was: 
- A participant was using the updown arrow keys to move the focus to the next object. However 

every time the focus passed over one object, the tool staxted processing its information. Therefore, 
the participant had to wait for the refieshment of information and then click the arrow again. He 
got upset because the tool was al1 the time "thinking and thinking and thinking". Sometimes he 

l 

l wanted to stop the processing but he didn't find how. 

b) Other times, the tool was processing and participants started clicking on some other things. However, 
clicking on certain objects (in the Hierarchy or History window) intempted the query. Participants 
never understood exactly how or why the query stopped. 

Short description: 
L. E. Problems related with stopping the processinp: 

70. 
TS 

Problem obscrved in: 1 Short description: 1 several users, 1 novice & I expert L, Some icons are hard to leam 

Problem: Participants experienced different problems reiated with stopping the processing of queries. 

Problcm observed in: 
4 novices 

EE 1 commented that 1 
Problem: In the Tool bar, there were some problems with the first three buttons. As mentioned before, 
usen know aboutflles. procedures. finctionr. vwiabfes and types. However: 
a) The first button was labeled with an ' j f '  which some participants confiised asjiunciions while it referred 

to files. 
b) The second button refened to routines, however participants didn't use the concept of routine in their 

work and therefore not always noticed it as refening toprocedrves andfiuictions. 
c) The third icon at the right had a "v" that suggested variable, however the help flag mentioned 

idenrifiers. Users didn't use the concept of idenrrjkr in their work therefore participants didn't know 
exactly what the feature was going to do. 

Only after several unsuccessfiil tries participants started reading the help flags more carefully. 



The message 'Query started in the backgrowid" was not always seen. 
The message at the bottom-left was not cleared from the previous history state and it misled some 
participants. 
Participants didn't know how long a Global grep was going to take and there was no continuous 
feedback about its progress. Some participants waited and waited and finally got tired. Some decided 
to go to some other places and forgot about the results of the query. 
Sometirnes participants decided to go to other History states and continue working. After a while they 
went back to the History state of the Global grep. However, when nothing was there yet they didn't 
know its progress and how longer it would take. 
Some participants didnVt notice when there had been no results and query had ended. 
The only feedback indicating that Global grep had finished were the results. Thetefore, participants 
working in other history states never knew when it finished. 
In one occasion the resuIts were left within the History state where the query was started and not in the 
state generated by the Global grep. At that moment, the participant was looking at that state and 
suddenly saw a bunch of information appearing. He never understood what that new information was 

72. 
GG 

as welI as why it suddenly appeared. 
One participant forgot once to enter something in the fint field of the dialog window of the Global 
grep. He started the query and the feature didn't cornplain neither said what would happen. 

Problcm: Running a Global grep query generated a new state in the History window and cleaned the 
Hierarchy window. Participants noticed that the Hierarchy window was cleaned but they didn't understand 
why. Also: 

Problem observed in: 
3 novices, 1 expert 

Short description: 
L. E, Problems with the Globalpep feature 




